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Introduction
Script Debugger is a replacement for Apple's Script Editor.
With it, you can create and edit scripts, but it has many
additional features that you will find invaluable if you are a
script developer.

Script Debugger provides you with a development environ-
ment for AppleScripts. Script Debugger has advanced editing
features including support for scripts larger than 32K and
Drag and Drop editing. It is fully Projector aware, and allows
you to make read-only projector files modifiable with the click
of a button. It also provides you with a complete debugging
environment. Script Debugger allows you to single-step
through your scripts and examine the contents of variables
while your script is executing.

Script Debugger is also scriptable, recordable, and attachable.
You can use AppleScript to customize Script Debugger by
adding scripts to its Extension menu and attaching scripts to
its other menu items. This allows you to customize and extend
Script Debugger for your work habits and needs. We're glad
you purchased Script Debugger. Enjoy.

Introduction 1
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About This Manual
This manual explains how to install and use the Script Debugger
software. Chapter 1 gets you started with Script Debugger. It tells you
what you need and walks you through the installation process.

Chapter 2 introduces you to Script Debugger's interface. You will
learn about the different windows, the function of the various pop-up
menus, and the basic Script Debugger features. Chapter 3 discusses
each of Script Debugger's features in detail. It shows you how to get the
most out of those features by walking you through creating and editing
a sample script.

Chapter 4 describes Script Debugger's debugging capabilities. It begins
by discussing some strategies for debugging scripts, and then steps you
through debugging some example scripts. Chapter 5 shows you how to
customize Script Debugger by configuring the preferences, adding
scripts to the Extensions menu, and by attaching scripts to the other
menu items. Chapter 6 describes some common problems that you
might encounter while working with Script Debugger and offers some
solutions.

You will also find several appendices at the end of the guide that
contain documentation for the extension scripts that ship with Script
Debugger. In addition, there is also discussion of Script Debugger's
scripting interface and the documentation for Late Night Software
Scripting Additions and Scheduler that are shipped with Script
Debugger. You will also find an appendix explaining how to find out
more about AppleScript and how to get help with your scripts.

This manual assumes that you are already familiar with the Macintosh
desktop as well as with basic Macintosh skills, such as using the mouse
and using the Chooser. This document also assumes you are somewhat
familiar with AppleScript.
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On-screen Help
Script Debugger includes on-screen information that you can consult
when you need help. Balloon Help is a feature of System 7 that explains
the function or significance of items you see on the Macintosh screen.
To turn on Balloon Help, pull down the Help menu from the Help icon
( m ) near the right end of the menu bar, and choose Show Balloons.
When you point to an item on the screen, a balloon with explanatory
text appears next to the item. To turn off Balloon Help, choose Hide
Balloons from the Help menu.

What You Need to Get Started
To use Script Debugger, you must have a Macintosh II or later with
Color QuickDraw. Your Macintosh must be running system software
version 7.0 or later with at least two megabytes of free memory If you
install all of the components from the Script Debugger disk, you will
need close to 3 megabytes of disk space. This includes AppleScript 1.1.
If you already have AppleScript or System 7.5 installed, you will not
need as much free space on your hard disk.

The Script Debugger package includes the following items:

•  one 1.4mb disk, titled Script Debugger Install
•  this manual, the Script Debugger User's Guide
•  the Script Debugger Quick Reference card

Script Debugger has been accelerated for Power Macintosh, however,
AppleScript 1.1 has not. You will see performance increases while
editing scripts in Script Debugger, but executing and stepping through
scripts will still be emulated on a Power Macintosh.
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Installing Script Debugger

- ID— Script Debugger Install I l g
2 items 1.3 MB in disk 11K avail:

4 _u_
Script Debugger InstallerRead Me First

..n.

Follow the steps in this section to install the Script Debugger software
on your computer.

1. Insert the Script Debugger Install diskette.
Before inserting the Script Debugger Install diskette, make sure it is
write protected by moving the write protect tab on the back of the
diskette to the upper position.

When you insert the Script Debugger Install diskette, the Script
Debugger Installer disk window appears (Figure 1-1).

Figure 1-1
The Script Debugger
installer disk
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2. Read the Read Me First file.
The Read Me First file contains late breaking information that may not
appear in this manual. The Read Me First file also contains errata
information and release information for minor releases of Script
Debugger.

3. Run the Installer.
Install the Script Debugger software by running the Script Debugger
Installer. To run the installer, double-click the Script Debugger
Installer application. You will be greeted by an instruction dialog box
(Figure 1-2).
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Figure 1-2
The Installer
startup
message

Figure 1-3
The Installer
window

rilmv.19 EY,)
Late Night
SOFTWARE / ' �

0

1_,

Version 1.0.0
Copyright 0  1993-1995
Mark Alldritt & Late Night Software Ltd.

Includes
AppleScript 1.1

Note: Turn off  any anti-virus software you may have in
your computer before installing the Script Debugger
software. You may turn it on again after the installation is
complete.

Continue

4. Click the Continue button to continue with the installation.
5. Select Easy or Custom installation.
When the installer is running, you are given the option of doing a
standard or a custom installation (Figure 1-3).

Script Debugger Standard Install

Click "Install" to install the Script
Debugger software, including the Late
Night Software Scripting fidditions 1.4,
Scheduler 1.2 and fippleScript 1.1.

Installation requires : 2828K

Custom Quit ( I n s t a l l

Clicking on the Install button installs AppleScript 1.1, Late Night
Software Scripting Additions, and Scheduler, in your System Folder.
It also installs a folder containing Script Debugger and the example
scripts that come with it.
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You may want to use the Custom installation option. If you are running
System 7.5, AppleScript 1.1 is already installed. Clicking on the Custom
button allows you to install any of the components in the Script
Debugger package.

6. Select the version of Script Debugger that you want to install.
After you select the type of installation and confirm that you want to
reboot your Macintosh after the installation is complete, the Installer
then prompts you to select the 680x0, PowerPC, or Universal version of
Script Debugger (Figure 1-4).

Figure 1-4
The Installer
prompts for the
version of Script
Debugger

You are running on a PowerPC machine. Some
applications to be installed can be run on both
PowerPC and 680140 machines.

Do you want  to install the larger Universal
applications or the smaller specific ones?

( 6 8 0 1 4 0  ) ( PowerPC
I U n i v e r s a l

Clicking the 680x0 button installs a version of Script Debugger that is
only compatible with 680x0 Macintoshes.

Clicking the PowerPC button installs a version of Script Debugger that
is only compatible with Power Macintoshes.

Clicking the Universal button installs a fat binary version of Script
Debugger. This version of the program is larger than the other two, but
is compatible with both 680x0 and PowerPC-based Macintoshes.

Registering Your Copy of Script Debugger
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In order to provide you with service, we need to know who you are.
Please take the time now to complete and mail the product registration
card. Just fill in your name, address, and computer model. We also
would appreciate your filling out the short questionnaire attached to
the registration card. Thank you in advance for your prompt response.
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Getting Started
This chapter introduces you to Script Debugger's interface and
features. It discusses all of Script Debugger's windows, shows
you their different features, and explains how to use them. The
chapter also describes the functions of the various pop-up
menus in Script Debugger and gives you some tips for getting
the most out of them.
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Figure 2-1
Script Debugger's
Script window
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The Script Debugger Interface
If you have used Apple's Script Editor, Script Debugger's Script window
will seem very familiar (Figure 2-1). It has a Script Description field
that you can show or hide by clicking on the triangle next to "Script
Description." You can change the font, style, size, and color of the text
that you enter in the Script Description field using the hierarchical
menus at the bottom of the Edit menu.

A Script Window
In addition to the Script Description label, you will also notice a Script
Debugger status button and a document pop-up menu. The options in
both of these items are also available in the Save As dialog, but the
button and pop-up menu items can save you time.

Script Debugger can save the expressions in the Data window and
breakpoint settings with your file. The Script Debugger status button is
valid for all file types, except text files. It controls whether or not
breakpoints, Data window expressions, and positions of the Data
window, are saved. If the button has an "x" through it, Script Debugger
does not save the debugging information.

Indicator showing Script
Debugger status

Indicator showing script
document type

Script description
editing area

Script editing area

The black arrow is the current line indicator. When you are stepping
through the script, it indicates which line Script Debugger will execute
next.
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NOTE: I f  you save a script in Compiled or Application format with debug-
ging information and then edit the file using the Script Editor, the break-
point information will be lost when you open the file again using Script
Debugger.
The pop-up menu on the right side of the Script window lets you
see at a glance whether the open script was saved in Text, Debugger,
Compiled, or Application format (Figure 2-2). The Script Type menu
also allows you to change the document type without performing a
Save As. You can also open the Save As dialog box by option-clicking on
the script type pop-up menu.

Figure 2-2
The script type
pop-up menu

JilgEW
Teut

V E I  Debugger Script
fei) Compiled Script

Rpplication

cl>

You edit your scripts in the area below the script description. If you
have set the automatic indentation in the Preferences dialog box, your
script is automatically indented as you type it in.

You can change the font, size, style, and color of your script using the
AppleScript Formatting options in the Preferences dialog box. You will
also notice that potential breakpoints appear in the left boundary of the
Script window. Clicking on a diamond activates the breakpoint.

In the lower left corner of the Script window is a Handlers pop-up
menu. If your script has any handlers in it, they are listed in this pop-
up menu (Figure 2-3). If you select one of the handlers from the pop-
up menu, the Script window jumps to that handler. If you Option-click
on the Handlers menu, it lists the global variables, properties, and
script objects in your script along with the handlers.

If you are working on a script application or droplet script, you will see
an additional set of script indicators above the Script Description field
(Figure 2-3).
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Script indicators
and the Handlers
pop-up menu
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In Figure 2-3, the icon with the two arrows forming a circle indicates
whether or not the script is a Stay-Open script. In this case, the cross
through the icon indicates that the script stops whenever the run
handler finishes. You can change this setting by clicking the Stay Open
indicator or selecting the Stay Open checkbox in the Save As dialog
box.

The next icon indicates whether or not the script's description is
shown in a splash-screen whenever the script runs. In this case, a cross
through the icon indicates that the description is not shown. You can
change this setting by clicking on the Splash Screen indicator or
selecting the Show Startup Screen checkbox in the Save As dialog box.

The Data Window
Every Script window has a Data window associated with it. The Data
window contains the variables that you enter from the script. As you
run or step through a script, the contents of the variables in this
window are updated.

To add a variable to the Data window, enter it in the editing area, and
then press the Return key or click the Enter Variable button to the right
of the editing window. You will notice that the variable you entered is
added to the list of variables in the bottom portion of the window. You
can display global variables and properties, but not local variables.
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A Script Data
window
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If you are defining a variable for the first time, Script Debugger places
the comment "The variable <variable name> is not yet defined." in the
values pane. If you have already run the script or have already stepped
through the first occurrence of the variable, the current value of the
variable is entered in the pane when you press the Return key (see
Figure 2-4).

You can control whether or not the information in the Data window is
saved with your script. To save the information, use either the Save
Debugging Information checkbox in the Save As dialog box or the
Debugging Information icon situated in the upper right hand corner of
the Script window.

You can resize the panes in the Data window by moving the pointer
over the dividing lines until it becomes a double-headed arrow (Figure
2-5). If you press and hold the mouse button, you can change the size
of a pane by dragging it. Generally, a pane only displays a single line of
text. While this is adequate for a variable name, you only see the first
line of the contents of the variable. If the script returns a list of values
for your variable, you may want to make the pane larger so you can see
more of the list.
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The Controls Window
The Controls window floats above your script and Data windows
(Figure 2-6). It provides you with a way to compile and control the
execution of your scripts as well as begin recording a script with a
single click.

Figure 2-6
The Controls
window
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You can hide the Controls window by selecting the Hide Controls
command from the Windows menu or by typing Command- — (Dash).

Even when the Controls window is hidden, you have access to all of its
commands through the Controls menu and keyboard shortcuts.

The Controls window is automatically hidden when windows other
than the Script and Data window, are activated. For instance, it is
hidden when you bring the Result, Event Log, or a dictionary window
to the front. It is hidden under these circumstances because the buttons
in the Controls window are not active.

The Result and Event Log Windows
The Result window shows the results of your script. For example, the
script

l i s t  f o l d e r  " M a c i n t o s h  H D : S y s t e m  F o l d e r : E x t e n s i o n s : S c r i p t i n g  A d d i t i o n s "
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produces a list of the contents of the Scripting Additions folder. It
would be returned as a list, and you would see the list in the Result
window (Figure 2-7).
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Figure 2-7
The Result
window
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Files &Folders", "Choose From List", "Choose Link", "Coerce
Record To Text", "Copy  File", "Current Date", "Current Date in
Seconds", "Current Dialect", "Date String f or" , "Depth" ,
"Dialects", "DisplayDialog", "Displaytext", "Does Font Esist",
"Does Monitor Support", "  EightyLister , "  Extract Numberfrom",
"Extract Picture", "Extract Resource", "Extract String List", "F i le

—

Commands", "Fi le10",  "  File Tracker Enabler", "  Find Application", —
-"Find In List", "Font  Inf ormati on f or" , "  Fonat Number" , "Front 4.

Application", "Gestalt", "Ge t  User", " Index Of " , " I s  Application 23

Event  Log I g f r r
t e l l  c u r r e n t  a p p l i c a t i o n

l i s t  f o l d e r —  "MacOS:System
FolderEdensions:Scripting Additions"
- - ->  ("Access Privileges f or" , "ACME
Script Widgets 2.0", " A d d  Picture", " A d d
Resource", " A d d  String List", "Address
of", "AGStart", " a p p  menu", "Append
aete", "AppleTalk Control", "Application
Info", "Application Menu", "Audio CD",
"Available Dialects", " B e e p " ,  "Choose
Address", "Choose Application", "Choose
File", "Choose Files &Folders", "Choose
From List", "Choose Link", "Coerce
Record To Text", "Copy  File", "Current
Date", "Current Dale in Seconds",
"Current Dialect", "Date String f or ,
"Depth", "Dialects", "DisplayDialog",
"Displaytext", "Does Font Exist", "Does
Monitor Support", "  EightyLister", "Extract
Number from", "Extract Picture", "Extract
Resource", "Extract String List", "F i l e
Common ds" , "  File10", "F i le  Tracker tr,:!,
Enabler , "F ind Application", "  Find In _fi

Figure 2-8
The Event Log
window

The Event Log window shows you the Apple events that Script
Debugger sends to itself, to scripting additions, and to scriptable
applications. If you executed the list folder script above, the Event Log
window would show you the application receiving the Apple events, the
script that is sent, and the results of the script (Figure 2-8).

Notice that the result of the script appears as a list following the arrow
(—>).
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A Dictionary Window
Every scriptable application and scripting addition has a dictionary
which contains all of the AppleScript terms that it understands. Script
Debugger's Open Dictionary command in the File menu allows you to
open the dictionaries of scriptable applications and scripting additions.

The Additions menu item under the Open Dictionary command opens
the dictionaries of your scripting additions. When you select the com-
mand, Script Debugger opens all of the additions installed in your
Scripting Additions folder and builds an Additions Dictionary window
(Figure 2-9).
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Figure 2-9
The Additions
Dictionary
window
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Script Debugger groups events in the additions together by suite.
For instance, all of the events in the Late Night Software Scripting
Additions are grouped together in the Late Night Software suite.

You can use the Find command to search for Apple events and classes
in the Dictionary window.
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To open an application's dictionary, follow these steps:

1. Choose Other from the Open Dictionary hierarchical menu under the File menu.
A dialog box opens where you can select an application. Notice that
only scriptable applications appear in the dialog box.

2. Select an application and click the Open button.
The Dictionary window opens (Figure 2-10).
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Figure 2-10
The Dictionary
window for the
Scriptable Finder

As in the Additions Dictionary, the scrolling list along the left side of
the window shows you the Apple events that the application under-
stands and the objects in the application. This information is grouped
by suites in the application. The Finder, for instance, understands
events from the Required and Standard suites as well as its own Finder
suite.

The right side of the window contains the specific information about
the event or events that you select on the left side of the window. When
you select an event, its description, forms, and syntax appear on the
right side of the window along with a description of the parameters.
You will also notice that you can select and copy the syntax examples
from the window. If you have Macintosh Drag and Drop installed, you
can drag the examples from the Dictionary window and drop them in a
Script window.
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The List pop-up menu on the top left side of the window lets you
change the display of the suites and events. Selecting Events from the
pop-up hides the suite information and sorts the events alphabetically
by event name. This is a quick way to locate an event when you cannot
remember which suite it is in. It also lets you check for more than one
event with the same name in your scripting additions since events will
appear in the list for each scripting addition they are in. Selecting
Classes from the List pop-up hides all of the suite and event infor-
mation and just displays the classes available.

0  F i n d e r  Dictionar
List: 1 : 1 = 1 / M  V  Hierarchy •  Elements Root Class:

acca r n a s o r  suitcase

Events Inheritance  c container
ee''' Classes 4 container window
14,.•
ins,eion point

Finder Suite
clean up
computer
eject
empty

desktop-object
disk
folder
font suitcase
sharable container
suitcase
trash-object

Figure 2-11
The Dictionary
pop-up menus
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The Hierarchy and Root Class pop-up menus control the display of the
objects in the hierarchical diagram at the top of the Dictionary window
(see Figure 2-11). You can display the diagram by clicking on the
triangle next to the Hierarchy label. You can resize the diagram pane by
clicking below the horizontal scroll bar and dragging. If you select an
object in the diagram, its description is displayed in the pane below it.

NOTE: Not all scriptable applications support object heirarchies. In these
cases, Script Debugger is not able to show a diagram.
When you select Elements from the Hierarchy menu, the diagram
shows the objects in the application according to their hierarchy. The
ellipses at the end of some class names in the diagram indicate that the
sub-tree has been truncated. This is done if the sub-tree is already
displayed in another area of the diagram. If you select inheritance from
the Hierarchy menu, the diagram shows the object selected in the Root
Class and the other objects in its inheritance hierarchy.
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Figure 2-12
The window
object and its
sub-classes
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document window
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dictionary window
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Not all applications use inheritance. If an application does not use
inheritance, the Root Class menu will be empty. If an application uses
inheritance, the Root Class menu will contain all of the objects in the
application which have sub-classes. Selecting an object from the menu
changes the hierarchical diagram to show the object you have selected
and all of the objects which inherit from it. For instance, in Script
Debugger, the window object has a number of sub-classes like the
Dictionary window (Figure 2-12).

You can option-click on an item in the diagram to display the
description of the item and make it the root class in the diagram.

Dictionary Shortcuts
If you open a program's dictionary regularly, you can add it to the
Open Dictionary menu by placing an alias in the Dictionary Items
folder. You can add the alias from Script Debugger by using the Add to
Open Dictionary Menu extension script under the Extensions menu.
For more information about this extension script, refer to Appendix A,
Extension Scripts.
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You may notice that Script Debugger appears in the Open Dictionary
dialog box. However, you can only open the Script Debugger's
dictionary if you have turned on the Enable Script Debugger
Dictionary checkbox in the Preferences dialog box. If you have not
checked the Enable Script Debugger Dictionary checkbox, and you try
to open the dictionary, you will get an error message saying that the
application is not scriptable (Figure 2-13).

Figure 2-13
The not scriptable
error message
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Couldn't complete the last command
because the application or
extension is not scriptable.

Result Code = 1007

OK

You may get this error message if an application or scripting addition
has a dictionary, but there are no commands in it.

You can also open an application's or scripting addition's dictionary by
dropping it on Script Debugger's icon. If an application does not have a
dictionary, you will see the error message in Figure 2-13.
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Ì3
Creating and Editing Scripts

This chapter explains how you can use Script Debugger to
create and edit scripts. It provides information about the
script formats that Script Debugger can open and save, as
well as instructions for editing and printing scripts. This
chapter also discusses compiling and recording scripts.
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Creating and Editing a Script
In this portion of the tutorial, we create a simple script to list the
contents of a folder using the Choose File and the List Folder scripting
additions that are provided with AppleScript. Afterwards, we modify
the script to include a test for the Scriptable Finder.

To create a new script document,

1. Choose New Default Script from the File menu.
A new, untitled Script window opens. You will also notice that a Data
window for the script opens below it.

2. Enter a script. For the purposes of this tutorial, enter the following script:
c h o o s e  f o l d e r  w i t h  p r o m p t  " S e l e c t  a  f o l d e r  t o  l i s t . . . "
c o p y  t h e  r e s u l t  t o  t h e F o l d e r
l i s t  f o l d e r  t h e F o l d e r

This script uses the Choose File scripting addition to open a dialog box
where you can select a folder for a listing of its contents. The "with
prompt" lets you add the text "Select a folder to list..." to the dialog box.
Once you select a folder in the dialog box, your selection is placed in
AppleScript's result variable. The second line of the script places the
contents of the result variable in the variable theFolder. The third line
of the script uses the List Folder scripting addition to get a listing of the
folder referred to by the theFolder variable.

3. Select run from the Control menu or click on the Run button on the Control window.
When the script begins to run, the cursor changes to two gears.

Script Debugger uses three cursors to indicate that it is busy with an
action: the gears, the beachball, and the watch. The gears indicate that a
script is executing. You should be able to switch to other applications,
select from the Controls menu, or click on the buttons in the Controls
window while the gears are turning. The spinning beachball indicates
that Script Debugger is executing an attachment or extension script.
You should be able to switch to other applications while the beachball is
spinning. The watch indicates that Script Debugger is busy. It appears
when Script Debugger is responding to an Apple event or performing a
lengthy operation like compiling or opening a Dictionary window.
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When you select Run, Script Debugger will first compile your script
and then run it. You will know that the script has compiled because the
format will change to reflect your formatting choices in the Preferences
dialog box. If you have made any typing mistakes, you may find them
at this point in the form of compile errors.

Once Script Debugger begins to run your script, a dialog box opens
and you are prompted to select a folder (Figure 3-1).

Figure 3-2
The Data
window with
the listing
results

Untitled-1 (Data)

the result

AppleScript's text em

("AppleScript Error Codes Lib", "Error /Return Codes Lib", "Gestalt Selectors
Lib " U s e f u l  Scripting Utilit ies")

0 — )

l_r

Figure 3-1
Choose Folder
dialog box

Select a folder to list...

Libraries

TL•
Choose "Libraries"

o  Hard Disk 234

Desktop

Cancel

4. Select a folder by navigating to it and then clicking on the Choose button at the
bottom of the dialog box.

A moment later the script finishes running, and you will notice a listing
of the folder contents in the result pane of your script's Data window
(Figure 3-2).
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ÈÚ –Æª&& Õ4+9¨Û—)¨+±-ÛÀ) øÆÆ±© ¨± &ª¥ª5¨ ¨± ¨4ª æª8+--+-8 ±9 ¨4ª &5Æ+)¨Ú

Cursor Movement
While you have the script open, you may want to use the command key
equivalents to move the cursor around in your script. You can use the
arrow keys to move the cursor a character or a line at a time. You can
also use the Option and Command modifier keys in conjunction with
the arrow keys to move a word and a line at a time.

1. Press Option-Up arrow to move the cursor to the beginning of the script.
2. Press Option-Right arrow a few times. You will notice that it moves the cursor to the

beginning of the next word.
3. Press Option-Left arrow a few times. You will notice that it moves the cursor to the

end of the preceding word.
4. Press Command-Right arrow to move the cursor to the end of the current line.
5. Press Command-Left arrow to move the cursor to the beginning of the current line.
6. Press Option-Down arrow to move the cursor to the end of the script.
You can also select words and lines in your script by holding down the
Shift key in combination with any of the cursor movement keys. For
instance, if your cursor is still at the end of the script, you can select the
entire script.

7. Press Shift-Option-Up arrow to select to the beginning of the script.
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Editing Scripts
In addition to the cursor movement keyboard shortcuts, Script
Debugger supports the standard Cut, Copy, and Paste commands with
a couple of noteworthy differences. If you still have the Script window
open for the script you were working on above, you can test these
commands.

1. Select several lines in the script and then select the Cut command from Edit menu.
2. Select the Undo command from the Edit menu to replace the lines that you just cut

from the script.
3. Select the Clear command from the Edit menu to remove all of the lines that you

have selected.
4. Select the Undo command from the Edit menu again to replace the lines you just

cleared.
5. Now open a new Script window by selecting Default Script from the New menu.
6. When the Script window opens, select the Paste Reference command from the Edit

menu.
This pastes a reference to the text that you copied from in the Script
window. You could close your original window and the pasted reference
would still refer to it.

7. Bring your tutorial Script window to the front and add parentheses to the last line of
your script so that it looks like this. Yes, it is nonsensical.

l i s t  ( f o l d e r  t h e F o l d e r ( ) )

8. Place your cursor between the two parentheses after theFolder and select the Balance
command from the Edit menu.

The command will select the two parentheses that the cursor is
between. Select the Balance command a second time and Script
Debugger highlights from the last parenthesis to the first one in the
line.
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Copying and Pasting Text
While your script uses scripting additions to get a listing of a folder,
you could take advantage of the Scriptable Finder. Unfortunately, it
might not be available in every situation, so you could add a test to
your script to check for the Scriptable Finder. The Libraries folder has a
Useful Scripting Utilities script that contains a handler to check for the
presence of the Scriptable Finder.

In this portion of the tutorial, we will copy the handler into the script
that we are working on and make some modifications.

1. Select Open Script from the File menu.
When the Open dialog box appears, navigate to the Libraries folder

and then open the Useful Scripting Utilities script (Figure 3-3). The
Libraries folder is inside of the Examples folder in your Script
Debugger folder.

Figure 3-3
Open Script
dialog box
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Libraries

RppleScript Error Codes Lib
1p Error/Return Codes Lib
q0 Gestalt Selectors Lib
tk, Useful Scripting Utilities

o  Hard Disk 234

( E j e c t

( Desktop

Cancel

Open 0

2. Click on the Handlers pop-up menu at the bottom of the Script window. Select the
CheckForScriptableFinder handler at the bottom of the menu.

Script Debugger scrolls the window to the bottom of the script and
places the cursor at the beginning of the handler.
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3. Select the two properties and the handler.
This is the portion of the script that you will be copying:

p r o p e r t y  g e s t a l t F i n d e r A t t r  :  " f n d r "
p r o p e r t y  g e s t a l t O L S C o m p l i a n t F i n d e r  :  3

o n  C h e c k F o r S c r i p t a b l e F i n d e r ( )

— T h i s  h a n d l e r  a l l o w s  y o u  t o  c h e c k  f o r  t h e  e x i s t e n c e  o f  t h e  S c r i p t a b l e  F i n d e r
— b e f o r e  y o u  b e g i n  u s i n g  i t .

t r y
r e t u r n  ( g e t  g e s t a l t  g e s t a l t F i n d e r A t t r  b i t  g e s t a l t O L S C o m p l i a n t F i n d e r )

o n  e r r o r  - 1 7 0 8
e r r o r  " G e s t a l t  S c r i p t i n g  A d d i t i o n  i s  n o t  i n s t a l l e d . "  &  r e t u r n  &  r e t u r n  &

" P l e a s e  r e f e r  t o  t h e  S c r i p t  D e b u g g e r  U s e r ' s  G u i d e  f o r  i n f o r m a t i o n  o n  "  &
" h o w  t o  i n s t a l l  S c r i p t  T o o l s "

e n d  t r y
e n d  C h e c k F o r S c r i p t a b l e F i n d e r

4. Select Copy from the Edit menu.
5. Bring your Script window to the front and place the cursor at the beginning of

the script.
6. Select Paste from the Edit menu to add the properties and handler at the top of

the script.
NOTE: I f  you have Macintosh Drag and Drop installed, you could accom-
plish this in fewer steps. You would select the properties and handler in the
Useful Scripting Utilities script. Then you would click on it a second time
and drag it to your Script window.
Now we need to modify the script to take advantage of the handler.

7. Add a call for the handler above the top line of the original script.
C h e c k F o r S c r i p t a b l e F i n d e r ( )

This will return whether or not the Finder is scriptable. If it is, the
handler will return true. If not, the handler will return false.
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8. Add an "if then" statement to the original script.
i f  t h e  r e s u l t  =  f a l s e  t h e n

c h o o s e  f o l d e r  w i t h  p r o m p t  " S e l e c t  a  f o l d e r  t o  l i s t . . . "
c o p y  t h e  r e s u l t  t o  t h e F o l d e r
l i s t  f o l d e r  t h e F o l d e r

e l s e

If the Scriptable Finder is not present and the handler returns false, this
part of the script uses the scripting addition to get a listing of the
folder.

9. Add another "if statement" and a "tell statement" for the Finder.
i f  t h e  r e s u l t  =  t r u e  t h e n

c h o o s e  f o l d e r  w i t h  p r o m p t  " S e l e c t  a  f o l d e r  t o  l i s t . . . "
c o p y  t h e  r e s u l t  t o  f i n d e r F o l d e r
t e l l  a p p l i c a t i o n  " F i n d e r "

l i s t  f o l d e r  f i n d e r F o l d e r
e n d  t e l l

e n d  i f
e n d  i f

This "if then" statement is used if the Scriptable Finder is present and
the handler returns true. This portion of the script uses the same
Choose File scripting addition to select the folder whose contents will
be listed, but the tell statement lets the Finder generate the listing
instead of the List Folder addition.
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Compiling Scripts
Before it can run a script, Script Debugger must compile it. This
involves checking the syntax of the script for any AppleScript errors
or any errors in the portions of the scripts that use applications or
scripting additions. A script must be re-compiled after you make any
changes to it.

Aside from checking the syntax, the main reason for compiling a script
is to make it run faster. Once a script is compiled, it does not have to be
checked before it is run.

1. You can compile the script that we have been working on. If you have already closed
it, enter or open a script that you want to compile.

2. Select Compile from the Controls menu or click on the Compile button on the Controls
window. Script Debugger displays a watch icon to let you know that it is working.

If Script Debugger encounters any errors while it is compiling the script,
it stops the compile and displays a dialog box with an error message in it.

3. When Script Debugger finishes compiling, the formatting of the script changes to let
you know that it is compiled.

For instance, if you have specified that Language Keywords should be
bold (or red, if you are using a color display), the language keywords in
your script will become bold.

4. Save your script when Script Debugger has finished compiling it.
Once you have checked the syntax of your script, you might want to
check the variables to see that your script is running properly. In the
case of our tutorial script, you will be able to see which if statement
the script uses to get the listing of the folder. In order to check the
variables, you will need to add them to the Data window.

1. Select Bring Data to Front from the Windows menu or press command-; to bring the
Data window to the front.

2. Place the cursor in the expression editing area and enter the variable used in the first
if statement: theFolder.

3. Press the Return key to add the variable to the expression panes.
You will notice that the value portion of the Data window says that
"The variable theFolder is not defined" and that the variable is selected.
Script Debugger shows this "error" and selects the variable so you can
correct it.
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4. Press the Return key to add the variable to the expression panes. Click below the
variable to deselect it.

5. Enter the variable used in the second if statement in the expression editing area:
finderFolder.

6. Click the Run button in the Control window or select Run from the Controls menu.
As before, you will be prompted to choose a folder as the script runs.
When the script finishes, you will be able to see that the variables in
the Script window have been updated (Figure 3-4). If you have the
Scriptable Finder installed, the finderFolder variable will contain the
path to the folder that you choose. Otherwise, theFolder variable will
contain the path. You might also notice that the result variable will
contain the listing of the folder. If you bring the Event Log window to
the front, you will be able to see each step as your script runs. We
will talk more about the Event Log and Data windows in Chapter 4,
Debugging and Stepping Through Scripts.

Figure 3-4
The Data window
after running the
script

Recording Scripts
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JJ1 tutorial script (Data)
{"Attachments Examples", "Libraries", "Script Debugger Examples", "Script Tools Examples"}

the result

AppleScript's text item
theFolder T h e  variable theFolder is not defined.
finderFolder a l i a s  "Hard. Disk 234 :Desktop Folder: Script Debugger. 1.0 Script. Debugger
gestaltFinder Attr " f n d r  "
gestaltOLSCompliantFinder

{"Attachments Examples", "Libraries", "Script Debugger Examples", "Script Tools
Examples"}

Script Debugger supports recording scripts. While not all applications
that are scriptable are recordable, a growing number of them are. In
general, recording a script is faster than writing it from scratch. You
will probably need to edit the recorded script, but you can let the
application do most of the work. You can also learn more about how to
write scripts for an application by recording a common action in it.

For this tutorial, you may want to move the Script window so you can
watch Script Debugger create the script. We will be recording a script
using Scheduler. Scheduler is a combination of an Extension and a
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Control Panel that allows you to launch programs and open documents
at specified times.

If you chose the Easy Install option when you installed Script
Debugger, the appropriate version of Scheduler was automatically
installed in your Control Panels folder. If you chose Custom Install and
did not install Scheduler, you will need to install it for this section of
the tutorial.

1. Open the Scheduler Setup from your Control Panels folder and then switch to Script
Debugger.

2. Open a new Script window and select Record from the Controls menu or click on the
Record icon in the Controls window. A flashing tape icon appears on the Apple menu.

3. Switch to Scheduler Setup.
4. Click on the Add button. This opens a standard Open dialog box where you can select

a document or application.
5. When the Open dialog box appears, select SimpleText or TeachText, or any other

application.
6. Select When a Folder Changes from the Launch menu.
7. Click on the Set Folder button and select the Control Panel folder.
8. Now switch back to Script Debugger and select Stop from the Controls menu or click

the Stop button on the Controls window. Script Debugger may complete the script
after you have stopped recording.

Your script may look something like this:

t e l l  a p p l i c a t i o n  " S c h e d u l e r  S e t u p "
a c t i v a t e
make  n e w  p e r i o d i c  o c c u r r e n c e  w i t h  p r o p e r t i e s  { s c h e d u l e d  f i l e : a l i a s  " H a r d  D i s k

2 3 4 : a p p s : S i m p l e T e x t " }
s e t  s e l e c t i o n  t o  o c c u r r e n c e  1
s e t  c l a s s  o f  o c c u r r e n c e  1  t o  f o l d e r  c h a n g e  o c c u r r e n c e
s e t  f o l d e r  o f  o c c u r r e n c e  1  t o  a l i a s  " H a r d  D i s k  2 3 4 : S y s t e m  F o l d e r : C o n t r o l

P a n e l s : "
e n d  t e l l

While this script is just an example, it does show a useful function of
Scheduler that you could use for running scripts.
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Searching For Text
Script Debugger lets you search for text in your scripts. If you still have
the script open that we were working with earlier, you can search for
text in it.

To begin a search for text in your script,

1. Select Find from the Search menu or type Command-F.
The Find dialog box appears (Figure 3-5).

2. Enter the text you are searching for in the Search For area of the dialog box.
If you want Script Debugger to ignore the case of the text that it is
searching for, enable the "Ignore Case" checkbox. Once you do this,
Script Debugger will treat "TheValue", "theValue", and "thevalue" as the
same search term.

3. Click the Find button or press Return to begin the search.
Script Debugger remembers the text in the Search For and Replace
With fields between searches. If you have entered text in either field,
but you click the Don't Find button, Script Debugger cancels the search
but remembers the text. If you enter text in either field, but you click
the Cancel button, Script Debugger forgets the text you entered.

You can find the next occurrence of the text by selecting Find Next
from the Search menu or you can press Command-G. You can find a
previous occurrence of the text by pressing Shift-Command-G.

Figure 3-5
The Find dialog box
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Script Debugger provides you with a shortcut for this process in the
Enter Selection command under the Search menu. You can select a text
string in your script and then select the Enter Selection command. The
text is inserted in the Search For field, and you can select Find Next
from the Search menu to find the next occurrence of the text.
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Replacing Text
Script Debugger lets you search for and replace text in your scripts. To
begin a search for text in your script,

1. Select Find from the Search menu or type Command-F.
The Find dialog box appears (Figure 3-6).

Figure 3-6
The Find dialog box
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2. Enter the text you are searching for in the Search For area of the dialog box.
If you want Script Debugger to ignore the case of the text that it is
searching for, enable the Ignore Case checkbox.

3. Enter the replacement text in the Replace With area of the dialog box.
4. Click the Find button or press Return to begin the search. Click the Cancel button to

cancel the search.
5. When the Script Debugger finds the text, select Replace from the Search menu or

press Command-H to replace the text that you found.
Script Debugger supports Undo and Redo for single replace operations.
However, Undo and Redo are not supported for Replace All operations.

You can replace the text and find the next occurrence by selecting
Replace and Find Again from the Search menu or by pressing
Command-T. You can replace the text and find a previous occurrence
by pressing Shift-Command-T. Replace All will replace all of the
occurrences of the search string after the current selection; any
occurrences of the string before the current selection are not replaced.
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Opening Scripts
In the previous tutorials, we have used the Open command, but we did
not look at all of the file formats that Script Debugger can open.

To open a script saved on disk, select the Open Script command from
the File menu. When you choose this command, you are prompted to
locate the file you want to open (Figure 3-7).

Figure 3-7
Script Debugger's
Open dialog box
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If you are running System 7.5 or have System Utilities 3.0 installed, you
will be able to see the different document icons in the Open dialog.

Alternatively, you can use the Finder to choose a file and open it. If the
file was saved using Script Debugger, you can simply open it using the
Finder by double-clicking the file or by selecting it and choosing Open
from the File menu. You can also drag script files onto the Script
Debugger icon.

NOTE: I f  you double-click on a Script Editor file in the Finder, it will
open the Script Editor. To open Script Editor files, you must use the
Open command in Script Debugger or drag the file icon onto the Script
Debugger icon.
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Script Debugger can open the following types of files:

Text Scripts
Script Debugger can open any text file. Any script that has not been
compiled is saved in text format. If you are working on a script that has
errors in it, you can save it in text format if you cannot save it in
compiled format.

Debugger Scripts
Debugger scripts are created only by Script Debugger. Scripts saved in
this format load more quickly than compiled scripts and don't need to
be re-compiled each time they are opened. You can open a debugger
script from the Finder and also with the Open command.

Compiled Scripts

• Compiled scripts are produced by Apple's Script Editor and other
script editing utilities. You can open a Script Debugger compiled script
from the Finder, with the Open command, or by dropping them on the
Script Debugger icon.

Script Applications

Droplets

When a script has been saved as an application, you can double-click
the script to run it. You can open script applications in Script Debugger
with the Open command or by dropping them on the Script Debugger
icon.

When a script has been saved as a droplet, you can drop files on it to
process them. You can open droplet files in Script Debugger with the
Open command or by dropping them on the Script Debugger icon.

Stationary Pads
Script Debugger supports Stationary Pad files. These are files which,
when opened, create a new untitled document containing pre-defined
settings and contents. Stationary files also store the default location of
Script Debugger's windows. To use a Stationary Pad file, open it as you
would a normal script file.
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Whenever you choose New Default Script from the File menu, Script
Debugger automatically opens the Stationary Pad named "Default
Script" located in the Script Debugger folder.

You can hold down the Option key while selecting Default Script from
the New menu to open the Default Script directly and retain the
stationary pad settings. When you do this, you will see a stationary pad
icon in the Script window (Figure 3-8).

Figure 3-8
The Default Script
window with the
stationary pad icon
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If you want to create a stationary file with your own default settings for
all new scripts, open a new file. Position the windows and enter the
contents and pre-defined settings that you want to use every time you
open a script. Select Save As... from the File menu. When the Save As...
dialog box appears, enter the name "Default Script" in the name field
and click on the Stationary Pad checkbox at the bottom of the dialog
box. If you want to create a separate template with your own settings,
you can name it anything you like. You can make your templates/
stationary pads handier by saving them in the Templates folder. Then
they will always be accessible from the New hierarchical menu under
the File menu.

TIP: I f  you want a stationary pad that does not save window positions, you
can create one using the following steps.

1. Move the Default Script stationary pad out of the Script Debugger folder.
2. Create a new script. Do not move or resize the Script or Data window.
3. Make whatever other changes you like to the script.
4. Save the stationary pad.
5. Move the Default Script back into the Script Debugger folder.
Whenever you open this stationary pad, Script Debugger automatically
places the window for you.
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Saving Scripts
To save a script that you have created, use the Save command in the File
menu. If you have not saved your script before, you will be asked to
name your script, choose the type of script document, and a location
on your hard disk where the script is to be saved (Figure 3-9).

Figure 3-9
Save As
dialog box

Figure 3-10
Save As
pop-up menu

Script Debugger 1.0

Rttachments
c i  Default Script

Dictionary I tems
LIU-lamples

Extension Scripts

Save Script as:
Untitled- 2

Kind:
❑  Stay Open
❑  Show Star tup Screen
Ei Save Debugging Information
❑  Stationary Pad

r i  Debugger Script

o  Hard Disk 234

Eject

Desktop

New M  )

( C a n c e l

(  S a v e

Replace the default "Untitled" name with the name you would like for
your script. Use the Kind pop-up menu to choose the type of script
document. The Kind pop-up menu has four choices (Figure 3-10).

Kind: D e b u g g e r  Scr ipt
Qj C o m p i l e d  Scr ip t
e >  Rppl ica t ion
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Text
The Text format stores your script in a format that other script editors
and word processors can read. Text scripts must be compiled before
they can be run, but they do not need to be compiled before they are
saved.

TIP: I f  your script has compilation errors and you are in a hurry to
save your work, you can save it as a text script or a debugger script.

Debugger Scripts
The Debugger Script format is the default kind. This type of file
records scripts in a format which is unique to Script Debugger.
Using this format, Script Debugger can store your script, the script
description, your breakpoints, and all the expressions, in the Data
window.

While this format cannot be used by other applications, such as Apple's
Script Editor, it does have distinct advantages. Script Debugger scripts
open and close faster. Unlike compiled scripts and script applications,
Debugger Scripts are not recompiled when they are saved.

Compiled Scripts
The Compiled script format stores your script and script description. If
you have chosen the Save Debugging Information option, it also saves
information about breakpoints you may have set or expressions which
have been entered in the Data window.

Compiled scripts (and script applications) are re-compiled when saved.
If the script has property definitions which prompt for things, or if
Apple Script needs to locate an application, you will have to respond to
these prompts before Script Debugger can complete the save operation.
Because of this, property definitions are reset when saving in this
format.

This file format is compatible with other applications, such as Apple's
Script Editor, which can read compiled AppleScript script files.
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Application
The Script Application format stores your script in the form of an
application. Scripts stored in this format can be executed as stand-
alone applications without the aid of Script Debugger or any other
script editing utility. If your script has an "on open" handler, it is saved
as a droplet.

Files saved as script applications are compatible with other script
editing utilities, such as Apple's Script Editor, which can open script
applications.

When saving a script as a script application, you can choose from the
following options:

Stay Open
A Stay Open script continues to execute after the run
handler finishes. This is useful if your script contains an idle
handler or accepts Apple events from other scripts or
applications.

Show Startup Screen
The Show Startup Screen option causes your script's
description to be displayed before it executes.
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Saving As Run-Only

Script Debugger 1.0 o  Hard Disk 234

Httachments
Ei Default Script
L I  Dictionary I tems

Enamples
Entension Scripts 707

( Eject )

( Desktop

( New M

Save Script as: ( Cancel

Untitled- 3 ( Save
Kind: H p p l i c a t i o n

You can save a script in Run-Only format. The only difference between
Run-Only format and the standard compiled and script application
formats is that the scripts cannot be examined.

To save a script in Run-Only format, select Run-Only from the File
menu. A Save As dialog box appears (Figure 3-11).

Figure 3-11
Run-Only Save As
dialog box
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❑  Stay Open
Show Startup Screen

Enter a name for the script in the "Save Script as" text box and select
the kind of script from the pop-up menu. You can save the script as a
compiled script or a script application as you can with the standard
Save As dialog box.

NOTE: When you save a script as Run-Only, you will never again be able
to edit the script . If you are saving a script in a Run-Only version to
distribute to users or clients, you should keep a backup copy of the script
in text or compiled form.
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Printing Scripts
You can print your scripts using Script Debugger's Print command.
When you print a script, a header is added to the top of each page
which contains the name of the script, the day, date, and time the script
was printed, and the page number.

To print a script,

1. Select Print Options from the File menu.
A Print Options dialog box appears (Figure 3-12).

Figure 3-12
The Page Setup
dialog box

Figure 3-13
The Print
dialog box

LaserWriter Page Setup 7.2

Paper: C) US Letter
0  US Legal
Reduce or
Enlarge'

0  R4 Letter
0  B5 Letter  0

100

Orientation

Tabloid

Printer Effects:
E  Font Substitution?
[E] TeHt Smoothing?
E  Graphics Smoothing?
❑  Faster Bitmap Printing?

2. Set the options in the Print Options dialog box and click OK.
3. Select Print from the File menu.
A Print dialog box opens (Figure 3-13).

LaserWriter "LaserWriter" 7.2

Copies:

........Paper Source .
C) RII C )  First F r o m :

Remaining i ' r o w

Pages: 0  RII Q  From:

Cassette

To:

Destination: ( D  Printer 0  PostScript® File

OK

( Cancel

(Options )

( Cancel )

Options
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Locating Handlers, Script Objects, Global Variables and Properties
The Handlers menu at the bottom of the script window allows you to
jump quickly to handlers in your script (Figure 3-14).

Figure 3-14
The Handlers
pop-up menu
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In addition to locating handlers, you can use the Handlers pop-up
menu to locate script objects, global variables and properties in your
scripts.

1. Hold down the Option key and click on the Handler pop-up menu at the bottom of
the Script window.

The pop-up menu now shows script objects, global variables, and
script properties, in addition to script handers (Figure 3-15).

Figure 3-15
Script properties
and objects
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on NthToken of SmartString
on newString of SmartStringll
on getTokens of SmartStringll
on NthToken of SmartStringll

property theString of SmartString
property parent of SmartStringll

r  from Weyhe Welreth s Alf

d i /  from disk when you co,

Iles "POurPist.Tolek.r. I :fol.

7ertStrihgS hei..5frirtg "PI

!tee/ which k 'h.sholetope
>Ps are:

2. Select a script object, property, or global variable and release the mouse button. The
Script window scrolls to the object you have selected and places the cursor before it.

3. Press Command-Up arrow if you have a script open with a handler in it. The cursor
jumps to the beginning of the previous handler.

4. Press Command-Down arrow if you have a script open with a handler in it. The cursor
jumps to the beginning of the next handler.
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Extensions Scripts
Because Script Debugger is scriptable and attachable, you can add
features or functionality to it using AppleScript. Twelve scripts which
extend Script Debugger are supplied with it. You can see these scripts
by selecting the Extensions menu (Figure 3-16). In particular, several of
the extension scripts make editing scripts easier: the Paste File Path,
Paste Folder Path, Hide All Descriptions, and Show All Descriptions
scripts.

Figure 3-16
The 12 Extension scripts
supplied with Script
Debugger
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Extensions
Add Properties to Data Window
Add To Open Dictionary Menu
Execute Idle Handler
Execute Open Handler (Files)...
Execute Open Handler (Folders)...
Execute Quit Handler
Hide Descriptions
Lock fill Expressions
Paste File Path...
Paste Folder Path...
Show Descriptions
Unlock RH Expressions

You can add your own scripts to the Extensions menu by placing your
compiled scripts in the Extension Scripts folder. If you place files of any
other type in the Extensions folder, Script Debugger ignores them.
To find out more about these Extension scripts, refer to Appendix A,
Extension Scripts. If you want to write your own Extension Scripts, refer
to Appendix B, Script Debugger Scripting Interface. It provides more
information about the Script Debugger objects and the events that you
can use to control them.
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Debugging and Stepping through Scripts

Script Debugger provides you with all the tools you need to
debug your AppleScripts. This chapter begins by giving you
some general strategies for debugging your scripts. It then
walks you through the process of debugging scripts using
Script Debugger's Data and Event Log windows. In addition to
scripts, the chapter also demonstrates debugging AppleScript
handlers and Script Debugger extensions.
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Throughout this tutorial, we will work with the Debugging Tutorial
script that you can find in the Tutorial folder inside the Examples
folder of the Script Debugger folder. For purposes of this tutorial, we
will step through a script in Script Debugger that copies portions of a
script to an empty Script window.

To set your Script Debugger to follow through this tutorial, you need to
do the following:

1. Launch the Script Debugger, open the Preferences dialog box and select the Enable
Script Debugger Dictionary checkbox. You will need to quit Script Debugger after
making the change.

If you have already enabled Script Debugger's dictionary, you can skip
this step.

2. Launch Script Debugger again.
3. Open the Debugging Tutorial script.
4. Leaving the Untitled-1 Script window open, open the Execute Quit Handler script that

you will find in the Extension Scripts folder inside the Script Debugger folder.
Depending on the size of your display, you may want to adjust the
windows so you can watch the two Script windows in Script Debugger
as you step through the script.

Debugging Strategies
Finding the errors or bugs in your AppleScripts can be time-consuming
and tedious. Since you cannot always tell the status of your script while
it is running, you must either embed debugging code or step through a
script.

Script Debugger provides you with a sophisticated development
environment for AppleScripts. You can set breakpoints and step
through scripts a line at a time. While the previous chapters have
introduced you to some of Script Debugger's features, this chapter will
show you how to take advantage of those features as you develop
scripts.
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Common Errors
Some programming errors do not require sophisticated tools to locate.
Probably the most common programming error that you can make in
any language is a simple typing error. Typing errors can be particularly
hard to debug since they can lead you away from the real error. For
instance, if the word "line" in the following line of the Debugging
Tutorial script

g e t  s t y l e  o f  w o r d  j  o f  l i n e  i  o f  t h e D o c

is misspelled as "lin"

g e t  s t y l e  o f  w o r d  j  o f  l i n  i  o f  t h e D o c

Script Debugger will highlight the word "lin" and signal a script error
that it is expecting the end of a line (Figure 4-1).

Figure 4-1
An error caused
by a typo

 S c r i p t  E r r o r

Expected end of line, etc. but found identifier.

1E=

Carefully checking the line that a script error is signaled on is the best
way to find a typo in your script. Whenever you encounter a script
error, you should not immediately suspect your AppleScript code. Scan
the line the error is in to make certain that you have not made the
simplest of programming mistakes.

Other easy mistakes to make are inserting the incorrect path to a file or
folder in your script and referring to windows or objects that are not
open or do not exist. In the Debugging Tutorial script, for instance, you
would get a script error if the window named "Untitled-I" was not
open. The script would run up to the point of copying the text to that
non-existent window, but would fail when it tried to write to that
window (Figure 4-2).
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Figure 4-2
Referencing a
paragraph that
does not exist

 S c r i p t  Error

Script Debugger got an e r r o r :  Can't set insert ion point
af ter  every t e x t  o f  document "unt i t led- 2 "  to " i f  f i r s t
document ex is ts  then

I R =

In this case, the reference to the window "untitled-2" should tip you off
that something is amiss.

Simple Strategies
When you do have an error in your script, you can apply some simple
strategies with Script Debugger to locate the problem. Begin by asking
yourself some of the same questions that Scott Knaster does in his
book, How to Write Macintosh Software.
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■ Where did the error occur?

■ What caused the error?

■ What was the last line of the script to execute before the error
occurred?

When you are trying to debug your script, try to isolate where the error
occurred. For example, did the error occur in a tell statement directed
to the Scriptable Text Editor or when the Finder was trying to write to a
file? Answering this question helps you focus on the handler or control
statement in the script that contains the error. You can use Script
Debugger's breakpoint feature to speed the debugging process. If you
need to run through the script to test the problem, you can click the
Run button and the script will run up to the breakpoint and stop. You
can then single-step through the problem portion of your script.

If you are debugging an open handler, setting a breakpoint allows you
to stop the execution of the handler and step through the script. This is
discussed in more detail later in this chapter.
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Once you have determined where the error occurred, you can begin
looking for the cause of the error. Did the Scriptable Text Editor look
for paragraphs in a window that did not have any? Was the Finder
trying to write to a file that another application already had open?
In the example we used above, you could determine that the Script
Debugger was looking in the wrong window by checking the name of
the window that your script references (Figure 4-3).

I> S c r i p t  Description... a  I D
v  s e t  I t o  1  r  1
0  e x i t  r e p e a t

e l s e
0  g e t  s t y l e  o f  m a r e  j_ o f  l i n e  i  o f  t h e D o c
0  s e t  t h e S t y l e  t o  t h e  r e s u l t  a s  f i s t
0  i f  t h e  c o n t e n t s  o f  i c e i r  2 o f  t h e S t y l e  i s  e q u a l  t o  {
0  i  c o p y  t e x t  o f  s e l e c t i o n  t o  t h e P a r a g r a p h
0  +  i c o p y  t h e P a r a g r a p h  &  ( A I S C 11 "  c h a r a c t e r -  1 3 )  -

t o  t h e  i n s e r t i o n  p a i n *  a f t e r  t e x t  o f  a r a c r a
O s e t  i  t o  i  +  1

e l s e

Script Error

Script Debugger got an e r r o r :  Can't set insert ion point
A s %  a f t e r  every t e x t  o f  document "unt i t led- 1 "  to

the res t

AppleSc

"document \  "Execute Quit Handler \ "

theStyle
thePara -70006

,

dove, condensed,

x

Figure 4-3
A highlighted
line in the script

You can can use the Data window with single-stepping or with the break-
point feature. For instance, you can select the variables that you want to
watch and then single-step through your script, watching how the
variables change. You could also set a breakpoint that stops script
execution just after a variable is updated. This allows you to execute
your script quickly, but still examine the variables to make certain that
they are being updated correctly.

You should also ask yourself which was the last line to execute. Script
Debugger can be very helpful since it shows you exactly which line
was executing when the error occurred and, in most cases, will flag a
variable or word within the line (Figure 4-3). Examine that line to
make certain that your references are correct and the terms are not
misspelled. You should be able to solve most of your problems by
re-reading the line carefully.

Debugging and Stepping through Scripts 4 7



ÏË ›$ø&¨ªÆ Ï

›±#¨Æ±¥¥'#( Õ+Æ',¨ ¤®ª+´¨'±#
…$,¥ª fl&&¥ªK0 Õ2Æ,&¨ ¤º,¨±Æ ø¥¥±©0 ß±´ ¨± ª®ª2´¨ª ¨$ª 02Æ,&¨0 ¨$ø¨ ß±´

2Æªø¨ªÙ ,¨ ±;¥ß ø¥¥±©0 ß±´ ¨± 0¨±& ¨$ª ª®ª2´¨,±; ±< ø 02Æ,&¨Ú «±´ 2ø;;±¨

0¨ª& ¨$Æ±´?$ ß±´Æ 02Æ,&¨ ø ¥,;ª ø¨ ø ¨,@ª ±Æ 0ª¨ æÆªøµ&±,;¨0 ,; ß±´Æ

02Æ,&¨Ú …,¨$ Õ2Æ,&¨ ‹ªæ´??ªÆÙ ß±´ 2ø; 2±;¨Æ±¥ ¨$ª ª®ª2´¨,±; ±< ø 02Æ,&¨

ø;º ©ø¨2$ ¨$ª ™øÆ,øæ¥ª0 ø;º ª®&Æª00,±;0 2$ø;?ª ø0 ß±´ 0¨ª& ¨$Æ±´?$ ¨$ª

02Æ,&¨Ú

…ª Æø; ø 02Æ,&¨ ,; ›$ø&¨ªÆ ÌÙ 0± ,; ¨$,0 2$ø&¨ªÆ ©ª ©,¥¥ 2±;2ª;¨Æø¨ª ±;

¨$ª ºªæ´??,;? <ªø¨´Æª0 ±< Õ2Æ,&¨ ‹ªæ´??ªÆÚ

–Æª,øÆ'#( ¨± Õ¨ª, Ã4Æ±´(4 ø Õ+Æ',¨
⁄±Æ ¨$ª ;ª®¨ <ª© 0ª2¨,±;0Ù ©ª ©,¥¥ æª ´0,;? ±;ª ±< ¨$ª ª®ø@&¥ª 02Æ,&¨0

¨$ø¨ 2ø@ª ©,¨$ Õ2Æ,&¨ ‹ªæ´??ªÆÚ

Controlling Script Execution
While Apple's Script Editor allows you to execute the scripts that you
create, it only allows you to stop the execution of a script. You cannot
step through your script a line at a time or set breakpoints in your
script. With Script Debugger, you can control the execution of a script
and watch the variables and expressions change as you step through the
script.

We ran a script in Chapter 3, so in this chapter we will concentrate on
the debugging features of Script Debugger.

Preparing to Step Through a Script
For the next few sections, we will be using one of the example scripts
that came with Script Debugger.
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1. Open the Debugging Tutorial script in the Tutorial Examples folder if you have not
already done so. This is the script:

t e l l  a p p l i c a t i o n  " S c r i p t  D e b u g g e r "
s e t  t h e D o c  t o  d o c u m e n t  " E x e c u t e  Q u i t  H a n d l e r "
s e t  x  t o  c o u n t  o f  l i n e s  o f  t h e D o c
s e t  i  t o  1
r e p e a t  w h i l e  i  <  x

s e l e c t  l i n e  i  o f  t h e D o c
i f  l e n g t h  o f  l i n e  i  o f  t h e D o c  i s  g r e a t e r  t h a n  0  t h e n

s e t  j  t o  1
g e t  w o r d  j  o f  l i n e  i  o f  t h e D o c
s e t  t h e W o r d  t o  t h e  r e s u l t
r e p e a t

i f  t h e W o r d  b e g i n s  w i t h  t h e n
s e t  i  t o  i  +  1
e x i t  r e p e a t

e l s e
g e t  s t y l e  o f  w o r d  j  o f  l i n e  i  o f  t h e D o c
s e t  t h e S t y l e  t o  t h e  r e s u l t  a s  l i s t
i f  t h e  c o n t e n t s  o f  i t e m  2  o f  t h e S t y l e  i s  e q u a l  t o  { b o l d }  t h e n

c o p y  t e x t  o f  s e l e c t i o n  o f  t h e D o c  t o  t h e P a r a g r a p h
c o p y  t h e P a r a g r a p h  &  ( A S C I I  c h a r a c t e r  1 3 )

t o  t h e  i n s e r t i o n  p o i n t  a f t e r  t e x t  o f  d o c u m e n t  " u n t i t l e d - 1 "
s e t  i  t o  i  +  1

e l s e
s e t  i  t o  i  +  1
e x i t  r e p e a t

e n d  i f
e x i t  r e p e a t

e n d  i f
e n d  r e p e a t

e l s e
s e t  i  t o  i  +  1

e n d  i f
e n d  r e p e a t

e n d  t e l l

2. If you have not already done so, create a new script and open the Execute Quit
Handler script that you will find in the Extensions folder inside the Script Debugger
folder.

The Debugging Tutorial script checks the style of each line in the
Execute Quit Handler looking for bold text in the line. When it finds
one, it copies the paragraph to the Untitled-1 document. Now that you
have the script open, let's step through it.
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Stepping Through a Script
When you step through a script, Script Debugger moves an indicator
along the left side of the Script window so you can track your progress
(Figure 4-4). Each time you select the Step command, Script Debugger
executes the next line in your script. If your script requires interaction
by selecting files or entering information, the dialog boxes will open for
the information as you step through the script. If your script runs
another program, as our example script does, the commands in your
script will be executed in the background unless you specifically
activate the program or an error brings it to the front.

= I j I  D e b u g g i n g  T u t o r i a l

I> S c r i p t  Description... W Ei:J
0  t e l l  a p p l i c - a s i o n  "  Script Debugger" 4
0  s e t  t  heDoc t o  rAger.rerent "Execute  Quit Handler" =
0  i  s e t  x  t o  c o m n 4  o f  l i n e s  o f  t  heDoc
0.10 s e t  i  t o  1
0  i  r e p e a t  c h i l e  i  <  x

0  s e l e c t  l i n e  i  o f  t h e D o c
.{.> i f  l e n g t h  o f  l i n e  i  o f  t  heDoc i s  g r e a t e r  t h a n 0 t h e n

s e t  j  t o  1
0  g e t  aft:Pt-a j  o f  l i n e  i  o f  t  heDoc -‘---
,.> s e t  t  heWord t o  t h e  r e s u l t '0'
Handlers ,  I A  IN i*

Figure 4-4
A Script window with
the step indicator in
the left margin
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As you step through this script, you might want to adjust your windows
so you can watch Script Debugger's windows. If you shrink your
windows, you will see that Script Debugger scrolls the window as you
step through the script. Even the script Execute Quit Handler window
scrolls in the background so that the selected line is always in view.

1. Click on the Step button in the floating palette or select the Step command.
Script Debugger takes a moment to compile the script and then the step
indicator appears next to the first line of the script.

2. Single-step through the script until you have seen the step indicator jump over the "if
then" statement, which tests for the comment characters.

The indicator returns to the "if then" statement that tests for the length
of the line.

3. Click the Stop button on the palette or select the Stop command to stop single- stepping
through the script. You will not be able to edit the script until you stop the single-step
execution.

Now that you see how stepping though a script works, let's set a break-
point into the script so that you can see how Script Debugger steps to
breakpoints.
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Setting Breakpoints
As you have probably noticed from the previous section, single-stepping
through a script can take time. Often you may suspect that your script
has a problem in one particular statement, subroutine, or handler, near
the end of the script. Instead of single-stepping through the whole script,
you can set a breakpoint just before the problem section. Then you can
run the script until it reaches the breakpoint.

Another possible use of breakpoints is that you want to examine a
variable to make certain that it is being updated properly. When you
run a script, the values of a variable are updated and when the script
stops, it will contain the very last value of the variable. To check a
variable as it changes, you can set a breakpoint before the line which
changes the variable. When you run the script, Script Debugger stops at
the breakpoint and you can step through the line to see how the variable
changes. You can then continue running the script. As with the previous
example, setting the breakpoint allows you to check for problems in your
scripts without single-stepping through the whole script.

If you look at the left side of your Script window, you will see a column
of hollow diamonds. These are all of the potential breakpoints in your
script. You can set a breakpoint by clicking on a diamond. Let's set a
breakpoint at the second "if" statement.

1. Click on the diamond next to the line "if theWord begins with '—' then."
You will notice that it is filled when you click on it; that's your visual clue
that the breakpoint is set.

2. Select Run or click the Run button on the palette. The pointer changes to the two gears
while your script is running.

When it reaches the breakpoint, the step indicator is placed next to the
breakpoint, and Script Debugger stops running the script.

3. Step until the "exit repeat" statement.
4. Now click on the Run button or select the Run command.
Script Debugger runs the script until it reaches the breakpoint again.

NOTE: Script Debugger stores breakpoint and Data window information in
Compile Script and Script Application documents. If you save one of these
documents with Script Debugger, edit it with Script Editor and then try
and open it with Script Debugger, your breakpoints will not be loaded since
it cannot be certain that the lines match up with the breakpoints.
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NOTE: As you step through this script, you will notice that the "i" variable
does not get updated. That is because loop variables in AppleScript are
local to the repeat loop. Declaring a global variable will not fix this
problem. Due to limitations of AppleScript, Script Debugger cannot
display the value of local variables.

Clearing Breakpoints
After you have stepped through a script using breakpoints, you may
want to remove them from the script. If your script is short and you
have only set a few, you can probably click on them individually to
disable them. If you have a longer script with breakpoints scattered
throughout, you may want to use the Clear All Breakpoints command.
Let's experiment with the example script to see how easy it is to clear
breakpoints.

1. Set several breakpoints in the script.
2. Click on a couple of them so that you can see how easy it is to disable them.
3. Select Clear All Breakpoints from the Debug menu to remove the remainder of the

breakpoints.
Unless you have disabled the Script Debugger icon in the Script
window, it retains all of the breakpoints when you select the Save
command. While you are developing a script, you will probably want to
keep the breakpoints, but you should remove them when you finish the
script.

Setting Temporary Breakpoints
Occasionally, you may want to set a temporary breakpoint that is
cleared as Script Debugger comes to it during the execution of the
script. Temporary breakpoints are useful for skipping over repeat loops
and handler calls when you run a script. You can create a temporary
breakpoint by holding down the option key while you click on the
breakpoint diamond. If you want to set a breakpoint without running
the script, press the Option and Shift keys while clicking on the hollow
diamond.
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If you are still in single-step mode, click the Stop button on the Control
window or type Command-. so that we can start fresh for this section.
You may also want to open the Event Log window if you do not already
have it open.

1. Press the Option key and click on the hollow diamond next to "set theStyle to the
result as list" line. A dot appears inside of the hollow diamond (Figure 4-5).

Figure 4-5
Setting a temporary
breakpoint in Script
Debugger
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Notice that Script Debugger compiles the script if it is not already
compiled and then begins to run it. Script Debugger will run the script
until it comes to the temporary breakpoint. Notice that the breakpoint
is cleared when Script Debugger comes to it.

In our tutorial script, this runs quickly through all of the lines
containing comments and comes to the section of the script that
examines the line to see if it contains any bold formatting. The
advantage of this is that we are able to jump to the portion of the
script that does the real work.

2. Move the Event Log window so that you can watch while the script is running.
NOTE: I f  the Event Log window is not open, it does not record the events
while a script runs.

3. Press the Option key and click on a diamond below the first temporary breakpoint to
set another.

Notice as the script runs that the events begin to run up from the first
breakpoint.

Now that you have been introduced to the Event Log window, let's see
how you can use it for debugging your scripts.
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Logging Apple Events
The Event Log window accumulates a running list of the Apple events
executed by your script and the results that they return. The Event Log
is cleared each time you run a script, and you can see it at any time by
selecting Bring Event Log to Front from the Windows menu or by
pressing Command-'.

The Event Log window has the advantage of being a history of a script's
execution. After you have run a script, you can look at the Event Log
window to see how each expression was evaluated. In addition to
keeping a history of a script's execution, it is a real-time indicator of its
progress. When you run a script in Script Debugger, the variables in the
Data window are not updated until the script finishes running or is
stopped. As a result, you only see the last changes to the variables. You
can see the variables updated in the Event Log window as the script
runs. To see how this works, let's run the Debugging Tutorial script that
we were looking at.

1. Bring the Event Log window to the front.
2. Click on the Run button or select the Run command.
As the script executes, notice that after each event sent to Script
Debugger, an arrow (—>) indicates what the event returns
(Figure 4-6). If you have specified different colors or fonts for the
language keywords, references, variables, or any of the other
AppleScript formatting items in the Preferences dialog box, you will
see that Script Debugger uses those in the Event Log window.
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Figure 4-6
The Event Log
window after
running a script

I:1E v e n t  Log I Q
t e l l  cx.irrent a p p l i c a t i o n

get  dOCIJPRelle "  Execute Quit Handler"
- - - >  document "Execute  Qu i t  Hand ler "

C01.197i e v e r y  l i n e  o f  docurren4 "Execute Quit
Handler"
- - - >  2 3

s e l e c t  l i n e  1 o f  dacwren4 "Execute Quit Handler"
l e n g t h  o f  l i n e  1 o f  dacwren4 "Execute Quit Handler"

> 0

ili'

- - - >  t r a d e
get  m o r d  1 o f  l i n e  1 o f  document "Execute Quit

Handler"

s e l e c t  l i n e  2 o f  doct.went "Execute Quit Handler"
l e n g t h  o f  l i n e  2 o f  e a c w r e n t  "Execute Quit Han dl er"

> 0

get  m o r e  1 o f  l i n e  2 o f  dansterent "Execute Quit
Handler

s e l e c t  l i n e  3 o f  eiOCf.MFORi "Execute Quit Handler"
l e n g t h  o f  l i n e  3 o f  eiO.Cf.MFORi "Execute Quit Handler"—

> 0
t rare

.,,
Pi

Script Debugger 1.0 o  Hard Disk 234

comment eHtension script
El debugging open handler
El Debugging Tutorial
L i  Non-Shipping I tems
L I  Script Debugger 1.0 7tT,

Eject

( Desktop

( New M

Save Event Log as: ( Cancel

Event Log Save

Figure 4-7
Saving the
Event Log

When the script has completed, you can save the contents of the Event
Log to a file. This makes it possible for you to compare the results of
running a script to the script itself. To save your Event Log, use the Save
As command.

3. Bring the Event Log window to the front.
4. Select the Save Event Log As command from the File menu. A standard Save As

dialog box appears (Figure 4-7).

5. Enter a name for the Event Log and click on the Save button. The log will be saved to
disk as a Script Debugger text file. You can open the Event Log with any text editor.

Event Log
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The Event Log gives you continuous feedback while a script is running,
but the Data window allows you to interactively examine expressions
and watch them as your script runs. While Script Debugger does not
save the contents of the Event Log window, it does save the contents of
the Data window with your script. This gives a snapshot of the state of
the variables and expressions as you stepped through your script.

At any point while you are stepping through your script, you
can add an expression from your script to the Data window. If the
expression in the script has not been evaluated when you add it, Script
Debugger reports an error—"The variable i has not been defined yet",
for instance. Once Script Debugger evaluates the expression, the
evaluation appears next to the expression in the Data window.

Adding Expressions to the Data Window
Let's add expressions to the Data window for the Debugging Tutorial
script.

1. Bring the Debugging Tutorial Data window to the front if you have not already
done so.

Figure 4-8
The Data window
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Expression
editing area

Expressions

If you cannot see the window, you can bring it to the front by selecting
Debugging Tutorial (Data) from the Windows menu.

2. To enter an expression from the script, click in the expression editing field
(Figure 4-8), enter the expression, and press the Return key or click on the
Checkmark in the Data window.

If you make a mistake while you are adding an expression, you can
remove the expression from the editing area by clicking on the X button
in the Data window.

Cancel expression
Enter expression

Expression values
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If you have not yet run the script, the expression value area will contain
"The variable theParagraph is not defined." If you have run the script
and you enter one of the expressions that has been evaluated, the
current value of that expression appears in the value area.

You can also drag a variable and drop it into the expression editing
area.

3. In the Script window, double-click on one of the variables that you have not entered
to select it.

Click on it again and drag it over to the expression editing area and
release the mouse button.

4. Now that the variable is in the expression area, press the return key to add it to the
list of expressions.

Add the rest of the variables to the Data window.

5. After you have entered several of the variables from the script, run the script so that
you will have values for all of the expressions in the Data window.

Drag and Drop Support for Values
In the same way that you can drag and drop a variable from the Script
window into the Data window, you can also drag the values from the
Data window to another application's window.

1. Open another Script window and select one of the values in the Debugging Tutorial
script's Data window.

2. Click on the value a second time and then drag it to the new Script window that you
opened.

Notice as you drag the value from the Data window that an outline
follows the pointer. When you get over the new Script window, it is
highlighted to show that you can drop the value in it.
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3. Release the mouse button to drop the value into the Script window.
TIP: You may want to drop values from the Data window into your
script. For instance, if a value in the Data window contains a folder path
or object reference, this is a quick way to get it in your script.
If you have a text editor or word processor that supports Drag
and Drop, you can drag the variables and their values into them.
More importantly, you can drag a variable from your script into the
expression editing field of the Data window. This saves you the time it
takes to type the variables into the window.

Adding Properties to the Data Window
If your script has properties in it, you can quickly add them to the Data
window using the Add Properties to Data Window extension script.
When you run the script, it collects all of the properties in your script
window and adds them into the Data window of the current script.

Removing Expressions from the Data Window
You can remove variables and expressions from the Data window
individually or you can remove all of them at once.

1. Select the variable that you want to remove from the window.
2. Select Clear Expression from the Debug menu. You can also press Command-I.
You can also clear all of the expressions from the Data window at once.

3. Select Clear All Expressions from the Debug menu.
Selecting the Clear All Expressions command removes all of the
expressions from the window including any that have been inserted by
the Default Script. For instance, "the result" is inserted by the Default
Script. After selecting the Clear All Expressions command, you may
need to re-enter some of your expressions.
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Examining Script Variables
If you removed all of the expressions in the previous section, you
should add them back into the Data window for this portion of the
tutorial.

Whenever you step through a script, you can examine the script's
variables. As you have already noticed, when you add a variable to the
Data window and then step through the script, you can watch as the
variable is updated dynamically. You can also examine these variables at
any time while you are stepping through the script. Let's step through
the Debugging Tutorial script to see how you can watch and examine
variables.

1. Select the Debugging Tutorial script window from the Windows menu if it is not the
frontmost window.

2. Click on the Step button in the Control window or select Step from the Controls menu.
3. Step through the script, watching as the values of the variables change.
You will also notice as you step through the script that any line
containing bold lines are being copied to the Untitled-1 window.

Examining AppleScript Expressions
You can enter expressions and one line scripts that you want to evaluate
directly into the Data window.

1. In the expression editing field, enter the expression:
40 *  8 0  -  2 5

2. Press Return or click the Checkmark to evaluate the expression.
Script Debugger enters the expression in the values area and places the
value after it (Figure 4-9).
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Figure 4-9
Evaluating AppleScript
expressions in the
Data window

E D  U n t i t l e d - 2  ( D a t a )  F Fll

("Default Script", "Dictionary Items", "Examples", "Extension Scripts", "Icon
" "Read Me First", "Script Debugger", "Script Debugger 2", "Template Scripts") L I

`6'

DOD
=
'0'
i l

AppleScript's text { " " }
40 *  80 - 25 3 1 7 5
2(2+4)-8 A  "IC" can't go after this number.
list folder "Hard  ("Default Script", "DictionaryItems","Examples" "Extension
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If the expression cannot be evaluated, Script Debugger enters the
expression in the list of expressions and places an error message in the
values area next to it.

3. Enter the expression:
2 ( 2 + 4 ) - 8

4. Press Return or click the Checkmark to evaluate the expression.
You will see an explanation of the error in the values area. You can also
enter single line expressions in the expression editing area.

5. Enter the path to a folder in the expression editing area:
l i s t  f o l d e r  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r
1 . 0 : "

6. Press Return or click the Checkmark to evaluate the expression.
This expression requires the List Folder scripting addition. Script
Debugger evaluates the expression and places a list with the contents of
the folder that you selected into the value. If you dick on the value, its
contents are displayed in the expression editing area.
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Restrictions
The Data window has a couple of restrictions. Any expressions you
enter cannot reference local variables, and "the result" must appear as
the first item in the Data window.

Due to the nature of AppleScript and the way Script Debugger
operates, the expression "the result" must be the first item in the Data
window. I f  you place "the result" after another expression in the Data
window, the value shown for "the result" will be the value returned
from the prior expression in the Data window. The Default Script
supplied with Script Debugger has "the result" placed as the first item
in the Data window. We recommend that you do not change this in the
Default Script file.

You should avoid displaying long lists or record structures. You are not
limited to the size of the value that you can display in the Data window,
but long lists and record structures may slow down AppleScript and
this will cause single-stepping to slow down. When you display large
values in the Data window, Script Debugger only displays the first few
thousand characters. However, when you copy or drag the value, you
will get the entire value.

Debugging Open, Idle and Quit Handlers
Script Debugger normally executes the Run handler when you use the
Run and Step commands. AppleScript defines three other standard
handlers (open, idle and quit) which scripts can contain. Normally,
you would have to write and test the scripts contained in the handlers
before adding them to the handlers. Three of the extension scripts
for Script Debugger allow you to step through open, idle, and quit
handlers to debug them.

Debugging and Stepping through Scripts 6 1



ÍÓ ›$ø&¨ªÆ Ï

¤®ª$´¨'() ø( —-ª( ÿø(º¥ªÆ
—&ª- $ø-º¥ªÆ0 øÆª 1ª-ªÆø¥¥ß ´0ªº 4±Æ 06Æ7&¨ ø&&¥76ø¨7±-0 ±Æ ºÆ±&¥ª¨0Ú

À0´ø¥¥ßÙ ß±´ ©±´¥º ©Æ7¨ª ø-º ¨ª0¨ ø¥¥ æ´¨ ¨$ª $ø-º¥ªÆ ±4 ¨$ª 06Æ7&¨ 7- ø

06Æ7&¨ ªº7¨±ÆÚ Ã$ª- ß±´ ©±´¥º øºº ¨$ª $ø-º¥ªÆ ø-º 0ø™ª ¨$ª 06Æ7&¨ ø0 ø

06Æ7&¨ ø&&¥76ø¨7±-Ú Ã$ª ¤®ª6´¨ª —&ª- ÿø-º¥ªÆ ¯⁄±¥ºªÆ0ÚÚÚ˜ ø-º ¤®ª6´¨ª

—&ª- ÿø-º¥ªÆ ¯⁄7¥ª0ÚÚÚ˜ ª®¨ª-07±- 06Æ7&¨0 ø¥¥±© ß±´ ¨± ¨ª0¨ ¨$ª $ø-º¥ªÆ

ø-º 06Æ7&¨ ¨±1ª¨$ªÆ æß ª®ª6´¨7-1 ¨$ª ±&ª- $ø-º¥ªÆ 7- ¨$ª 4Æ±-¨E±0¨

©7-º±©Ú F4 ¨$ª 06Æ7&¨ º±ª0 -±¨ 6±-¨ø7- ø- ±&ª- $ø-º¥ªÆÙ Õ6Æ7&¨

‹ªæ´11ªÆ Æª¨´Æ-0 ø- ªÆÆ±Æ ¯⁄#$´Æª ÏÛÔ,˜Ú

⁄"#´Æª ÏÛÔ+

Ã"ª ªÆÆ±Æ Æª¨´Æ)ªº
+, ¨"ª -.Æ+/¨ º±ª-
)±¨ "ø™ª ø) ±/ª)
"ø)º¥ªÆ

Ã± 0ªª $±© ¨$70 4ªø¨´Æª ©±Æµ0 7- Õ6Æ7&¨ ‹ªæ´11ªÆÙ ¥ª¨K0 ¥±±µ ø¨ ø 0øE&¥ª

06Æ7&¨Ú

ÔÚ —/ª) ¨"ª ‹ªæ´88+)8 —/ª) ÿø)º¥ªÆ -.Æ+/¨Ú Ã"+- +- ¨"ª -.Æ+/¨Ê

!¥±æø¥ ¨(ª⁄+¥ª,

±- ±.ª- ¯¨(ª⁄±¥ºªÆ,˜
,ª¨ ¨(ª⁄+¥ª, ¨± •£
Æª.ªø¨ ©+¨( + 6Æ±7 Ô ¨± 9±´-¨ ¨(ª⁄±¥ºªÆ,

,ª¨ ø⁄±¥ºªÆ ¨± +¨ª7 + ±6 ¨(ª⁄±¥ºªÆ,
¥+,¨ 6±¥ºªÆ ¯9±-¨ª-¨, ±6 ø⁄±¥ºªÆ˜
,ª¨ ¨(ª⁄+¥ª, ¨± ¨(ª⁄+¥ª, ˙ ¨(ª Æª,´¥¨

ª-º Æª.ªø¨
ª-º ±.ª-

±- Æ´-
±.ª- ¯9(±±,ª 6±¥ºªÆ ©+¨( .Æ±7.¨ NÕª¥ª9¨ ø 6±¥ºªÆ ¨± ¥+,¨ÚÚÚM˜

ª-º Æ´-

ÓÚ Õª¨ ø æÆªøµ/±+)¨ ±) ¨"ª N¥+-¨ ,±¥ºªÆ ¯.±)¨ª)¨- ±, ø⁄±¥ºªÆ˜M ¥+)ªÚ

ÌÚ flºº ¨"ª ª®/Æª--+±) ¨"ª⁄+¥ª- ¨± ¨"ª ‹ø¨ø ©+)º±©Ú

ÏÚ Õª¥ª.¨ ¤®ª.´¨ª —/ª) ÿø)º¥ªÆ ¯⁄±¥ºªÆ-ÚÚÚ˜ ,Æ±I Õ.Æ+/¨ ‹ªæ´88ªÆK- ¤®¨ª)-+±)- Iª)´Ú

Õ6Æ7&¨ ‹ªæ´11ªÆ ±&ª-0 ¨$ª ›$±±0ª ⁄±¥ºªÆ0 º7ø¥±1 æ±® ©$ªÆª ß±´ 6ø-

0ª¥ª6¨ ¨$ª 4±¥ºªÆ ¨$ø¨ ß±´ ©ø-¨ ¨± ¥70¨ ¯⁄71´Æª ÏÛÔÔ˜Ú

Executing an Open Handler
Open handlers are generally used for script applications or droplets.
Usually, you would write and test all but the handler of the script in a
script editor. Then you would add the handler and save the script as a
script application. The Execute Open Handler (Folders...) and Execute
Open Handler (Files...) extension scripts allow you to test the handler
and script together by executing the open handler in the frontmost
window. If the script does not contain an open handler, Script
Debugger returns an error (Figure 4-10).

Figure 4-10
The error returned
if the script does
not have an open
handler
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 S c r i p t  E r r o r

Script 'Debugging Quit Handler " does not have an Open
handler.

To see how this feature works in Script Debugger, let's look at a sample
script.

1. Open the Debugging Open Handler script. This is the script:
g l o b a l  t h e F i l e s

o n  o p e n  ( t h e F o l d e r s )
s e t  t h e F i l e s  t o  { }
r e p e a t  w i t h  i  f r o m  1  t o  c o u n t  t h e F o l d e r s

s e t  a F o l d e r  t o  i t e m  i  o f  t h e F o l d e r s
l i s t  f o l d e r  ( c o n t e n t s  o f  a F o l d e r )
s e t  t h e F i l e s  t o  t h e F i l e s  &  t h e  r e s u l t

e n d  r e p e a t
e n d  o p e n

o n  r u n
o p e n  ( c h o o s e  f o l d e r  w i t h  p r o m p t  " S e l e c t  a  f o l d e r  t o  l i s t . . . " )

e n d  r u n

2. Set a breakpoint on the "list folder (contents of aFolder)" line.
3. Add the expression theFiles to the Data window.
4. Select Execute Open Handler (Folders...) from Script Debugger's Extensions menu.
Script Debugger opens the Choose Folders dialog box where you can
select the folder that you want to list (Figure 4-11).
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Figure 4-11
The dialog box from
the Execute Open
Handler extension
script
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Add "Script Debugger 1.0" )

o  Hard Disk 234

Eject

Desktop

( C a n c e l

I O p e n

HPFT1111,( )

5. Choose a folder, click the Add button, and then click the Done button. Script
Debugger executes the script up to the breakpoint.

6. Click the Step button in the Control window or select step from the Controls menu.
Notice as you step through the next two lines of the script that the expression theFiles
lists the contents of the folder you selected.

You can also use the Execute Open Handler (Files...) extension script in
the same way if you have a script that collects information about a file
or modifies the contents or attributes of a file.

Executing an Idle Handler
Typically, idle handlers are in Stay Open script applications.
AppleScript periodically sends idle commands to script applications
when a script application is not responding to incoming events. The
Script Editor does not provide you with any way to debug an idle
handler, but Script Debugger does in the Execute Idle Handler
extension. It allows you to execute the handler without the need of
adding to a larger script.

Like the Execute Open Handler extension scripts, the Execute Idle
Handler script allows you to execute the idle handler in the frontmost
window. If the script does not have an idle handler in it, Script
Debugger signals an error (Figure 4-12).
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Figure 4-12
The error
returned if the
script does not
have an idle
handler
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 S c r i p t  Error

Script 'Debugging Open Handler does not have an Idle
handler.

To see how you would test an idle handler script, let's look at a sample
script.

1. Open the Debugging Idle Handler script. The script looks like this:
o n  i d l e

s e t  i  t o  1
r e p e a t  w i t h  i  f r o m  1  t o  1 0

i f  i  =  1  t h e n
b e e p  1

e l s e
i f  i  =  1 0  t h e n

b e e p  2
e n d  i f

e n d  i f
s e t  i  t o  i  +  1

e n d  r e p e a t
e n d  i d l e

This script does not do any work, but it shows you how you can debug
an idle handler in the Script Debugger.

2. Set a breakpoint at the "if i =1 then" line.
3. Add the variable i to the Data window. This allows you to see the variable

incremented as Script Debugger loops through the script.
4. Select Execute Idle Handler from Script Debugger's Extensions menu. Script Debugger

executes the script up to the breakpoint.
5. Click the Step button or select Step from the Controls menu. Step through the

statements of the repeat loop several times to see the value of i incremented.
6. Click the Run button to finish executing the handler.
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Executing a Quit Handler
Typically, quit handlers are in stay open script applications. AppleScript
sends the script application a quit command whenever the user chooses
Quit or presses Command-Q. Script Debugger provides you with a way
to easily debug a quit handler in the Execute Quit Handler extension. It
allows you to execute the handler without the need of adding to a larger
script.

Like the other execute extension scripts, the Execute Quit Handler
script allows you to execute the quit handler in the frontmost window.
If the script does not have a quit handler in it, Script Debugger signals
an error (Figure 4-13).

Figure 4-13
The error returned
if the script does
not have a quit
handler

 S c r i p t  E r r o r

Script 'Debugging Open Handler" does not have a Quit
handler.

Cancel

To see how you would test a quit handler script, let's look at a sample
script.

1. Open the Debugging Quit Handler script. The script looks like this:
o n  q u i t

d i s p l a y  d i a l o g  " D o  y o u  r e a l l y  w a n t  t o  q u i t ? "
b u t t o n s  { " N o t  r e a l l y " ,  " Q u i t " }  d e f a u l t  b u t t o n  " Q u i t "

i f  t h e  r e s u l t  i s  " Q u i t "  t h e n
c o n t i n u e  q u i t

e n d  i f
e n d  q u i t

2. Set a breakpoint at the "display dialog" line.
3. Select Execute Quit Handler from Script Debugger's Extensions menu. Script

Debugger executes the script up to the breakpoint.
4. Click the Step button or select Step from the Controls menu. Step through the line

with the dialog box and click on the Quit button to see the value returned as the
result.
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NOTE: You always need to include the cont inue q u i t  statement in
your handler, otherwise you will have trouble quitting your script applica-
tion. If you have failed to include the statement, you can always quit by
pressing Command-Shift-Q. This will save any changes to the script's
properties and quit immediately.

Script Debugger Extensions
In addition to the debugging tools that are built into Script Debugger,
you can also write your own extensions to add to the Extensions menu.
Chapter 5 discusses Extension scripts, and you will find all of the
documentation for Extension scripts in Appendix A.

Perhaps the best way to test Extension scripts that you are writing for
Script Debugger is to run them from a second copy of Script Debugger
or from Apple's Script Editor. This method would allow you to control
Script Debugger and determine if your script is behaving as it should.
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Customizing Script Debugger
Script Debugger is an attachable application. In other words,
through scripts, you can customize it in a number of ways to
make it better suit your needs. This chapter describes how you
can customize the way Script Debugger formats your scripts
and reacts to certain events. The chapter shows you how to
create custom script templates. It shows you how to add items
to the Extensions menu, and how to change Script Debugger
commands through an Attachments script.
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Changing Script Debugger Default Settings
Script Debugger allows you to alter how it displays AppleScript scripts
and how the debugger responds to certain events. To change any of
these settings, select the Preferences command from the Edit menu.
Selecting this menu item opens the Preferences dialog box (Figure 5-1).

Figure 5-1
Script Debugger's
Preferences
dialog box

Preferences
AppleScript Formatting:

Hew t e x t  ( u r c o m p i l e d )
Opera to rs ,  e t c .  ( +  &
Language  k e y w o r d s
Rpp i  cat i o n  k e g m o r e s

Comments

El Plain Text ❑  Shadow
❑  Bold ❑  Outline
❑  Italic ❑  Condensed
❑  Underline ❑  Expanded

Font: Courier

Size: 1 0 - I C o l o r :  1 1

Startup Action:

None
0  New Document

Open Dialog
Script Error Actions:

0  Bring Debugger To Foreground
[E] Beep
Script Pause Action.

0  Bring Debugger To Foreground
Editing Options:

Fluto Indent
Scripting Options:

0  Enable Script Debugger Dictionary
[E] "path to me" refers to document

( Cancel) OK

AppleScript Formatting
This group of settings lets you change the way AppleScript formats
your scripts. The scrolling list shows the different elements of a script.

NOTE: The formatting changes that you make in Script Debugger's Prefer-
ences dialog change the formatting of the English AppleScript system and
will carry over to the Script Editor and any other application which
displays AppleScript scripts.
New text is anything that you have entered into your script but have
not yet compiled. In other words, it is the script before you click on the
Compile button.
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Operators that you might use in your scripts are the plus (+) and
minus (-) signs, the less than (<) and greater than (>) symbols, and the
equal sign (=).

Language keywords are the AppleScript keywords that appear in your
script.

Application keywords are the keywords from the dictionary of the
application or scripting addition that you are scripting.

Comments are the portions of the script set off by dashes (—) or by
blocks. For example, (* this is a block comment*).

Values are the dates, numbers, strings, and lists that AppleScript returns
whenever expressions are evaluated.

Variables and subroutine names are the names that you enter in your
scripts.

References are the phrases that you use to specify objects within
applications.

You can adjust the text style, font, font size, and color for each of these
items. To change the style of one of the elements:

1. Select the element that you want to change from the scrolling list.
2. Adjust the style of the font by clicking on the checkboxes.
3. Adjust the font and the font size using the pop-up menus.
4. Adjust the color of the element using the color pop-up menu.
You can change another element by selecting it from the list. Closing
the Preferences dialog box saves your changes.

While color scripting may seem frivolous, it can help you understand
scripts and find problems quickly. For instance, you might want to use
color for the language and application keywords, the values, and the
variables in your scripts. While the colors do not carry over to the Data
window, they do show up in the Event Log and the Result windows. If
you are tracing the progress of a variable, you can spot it quickly in the
Event Log by watching for the color you have assigned to variables.

NOTE: After you change AppleScript formatting settings, Script Debugger
will reformat all open scripts and dictionaries. There may be a brief pause
while this takes place.
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Startup Action
The Startup Action group of radio buttons allows you to control what
Script Debugger does when you double-click on its icon. The options
are:

None W h e n  this radio button is selected, Script Debugger does
not perform another action when it starts up. In other
words, Script Debugger does not open a new, untitled script
nor open a file selection dialog.

New Document
When this radio button is selected, Script Debugger creates
a new, untitled script. Script Debugger uses the Default
Script as the template for the new script. This is the default
option setting when Script Debugger is installed.

Open Dialog
When this radio button is selected, Script Debugger
presents a file selection dialog box when it starts up.
This allows you to choose a script when starting Script
Debugger.

Script Error Actions
This group of items lets you control how Script Debugger operates
when there is an error in your script.

Bring Debugger to Foreground
When this item is selected, Script Debugger comes to the
foreground whenever there is a script error.

Beep W h e n  this item is selected, Script Debugger plays the beep
sound whenever there is a script error.
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Script Pause Action
The Script Pause Action allows you to control how Script Debugger
operates when a script pauses or reaches a breakpoint.

Bring Debugger to Foreground
When this item is selected, Script Debugger comes to the
foreground whenever a script is paused or Script Debugger
encounters a breakpoint.

For example, if you are stepping through a script which activates the
Scriptable Finder, selecting this option brings Script Debugger to the
foreground each time you pause. (If you are single-stepping through
the script, you pause at each line.) As you step, Script Debugger
activates the Scriptable Finder to handle the next event and then Script
Debugger comes back to the foreground so you can step again.

This option relies on an auto-activate feature. Script Debugger tries
very hard to track which application is the foreground application. It
does this so that it can re-activate the foreground application whenever
you step over a statement which sends an event. The idea is to ensure,
as much as possible, that the application environment is correct.

Editing Options
When the Auto Indent checkbox is checked, Script Debugger
automatically indents your script as you enter it.
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Scripting Options
If you want to write scripts for the Script Debugger, you need to enable
the Script Debugger Dictionary checkbox in the Preferences dialog box.
After enabling the dictionary, you must quit Script Debugger and
restart it to make the changes take effect. Script Debugger warns you
that you need to do this (Figure 5-2).

Figure 5-2
Enabling the Script
Debugger dictionary
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Enabling or disabling the Script Debugger
dictionary takes effect  the next t ime Script
Debugger is launched.
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Selecting the Enable Script Debugger Dictionary option makes the
Script Debugger's dictionary available. When this option is not
selected, nothing—not even Script Debugger—can display the
dictionary. When it is selected, Script Debugger intercepts the Get
AETE event and returns the appropriate aete data. Script Debugger
must take this approach to allow you to write non-Script Debugger
scripts which use terms that might conflict with the terms in the Script
Debugger dictionary.

NOTE: At present, the only known conflict is with the offset property.
Enabling the Script Debugger Dictionary also enables recording. This
allows you to record operations done in Script Debugger, just as you
can record operations performed in other applications. I f  you do not
want Script Debugger to record its own functions, disable the Script
Debugger Dictionary.

Select the "path to me" checkbox if you want Script Debugger to
intercept the "path to me" command. Doing this causes Script
Debugger to return the path to the document for the command. This is
useful if you save a script as a script application or droplet. In this case,
the "path to me" command returns the same value when the script is
executed within Script Debugger, and when it's executed as a stand
alone application.
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If you do not select this checkbox, Script Debugger returns the path to
itself for the command. This option only has an effect if you save the
script. If the script is new and unsaved, this setting has no effect—the
path to Script Debugger is returned in both cases.

Changing Defaults for New Scripts
The Default Script stationary pad in the Script Debugger folder
supplies all defaults for new scripts. This stationary pad file can supply
defaults for every aspect of a new script. When you save a new script
document as a stationary pad, it retains the window settings and
locations, font and color settings, and script text.

You can hold down the Option key while selecting Default Script from
the New menu to open the Default Script directly and retain the
stationary pad settings.

To change defaults for new scripts, follow these steps:

1. Open a new document.
Use the New command from the File menu to create a new untitled
script document.

2. Alter the new document.
Modify the new script so that it has the settings you prefer. You can
enter a default script description, default script text and default data
expressions. You can also hide or show the script description and save
the window location. You can even set breakpoints if you have default
script text.

3. Save the new document.
Select Save As from the File menu. When the Save As dialog box
appears (Figure 5-3), name your script "Default Script" and select the
Stationary Pad checkbox. Save the script in the Script Debugger folder.
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Figure 5-3
Creating a new
default script
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4. Replace the old Default Script.
When you click on the Save button, Script Debugger asks if the old
Default Script file should be replaced. Answer Yes.

Adding Templates to the Templates Menu

Figure 5-4
The template
scripts in the
File menu
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Script Debugger's Template Scripts folder contains three script
templates: Folder Droplet; File Droplet; and Folder Scanner Droplet.
You can see these templates under the New menu (Figure 5-4). These
three template scripts are the beginnings of general purpose droplet
scripts. They each provide handlers with comments that tell you where
to place your script for processing files or folders.

File
New
Open Script... N O
Open Dictionary ▶  F i l e  Droplet
Close N W  F o l d e r  Droplet

Folder Scanner Droplet

Default Script N N

Save
Save Result Rs...
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You may add your own template scripts to the New menu by placing
scripts saved as stationary pads in the Template Scripts folder.

To add a template script to the New menu, follow these steps:

1. Open a new document.
Use the New command from the File menu to create a new, untitled
script document.

2. Alter the new document.
Create a specialized template script with the handlers and script text
you need. You can enter a script description, text, and data expressions.
You can also hide or show the script description and save the window
location. You can even set breakpoints if you have entered script text.

3. Save the new document.
Select Save As from the File menu. When the Save As dialog box
appears (Figure 5-5), give your template script a name and select the
Stationary Pad checkbox. Save the script in the Template Scripts folder.

File Droplet
Folder Droplet
Folder Scanner Droplet

47,

I Eject )

Desktop

New L I

Save Script as: ( Cancel

Ungzip Droplet ( Save
Kind: 0 .  Debugger Script
❑  Stay Open
❑  Show Startup Screen

Figure 5-5
Creating a
template script

Template Scripts I o  Hard Disk ...

N  Save Debugging Information
Ei Stationary Pad

NOTE: Non-stationary pad files stored in the Template Scripts folder are
listed in the Templates menu. However, if your template is not stored as a
stationary pad, Script Debugger will open the template as a normal
document. In other words, it will not use the template to create a new,
untitled document, and you may overwrite your template script.
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Adding Applications to the Open Dictionary Menu
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The Open Dictionary menu allows you to quickly display dictionary
information for applications and scripting additions without having to
use a file selection dialog box. You can add the names of the scriptable
applications and scripting additions you use frequently to the Open
Dictionary menu.

To add an item to the Open Dictionary menu, do the following:

1. Make an alias for the application or scripting addition.
Use the Finder to make an alias for the application or scripting
addition you want to add to the Open Dictionary menu.

2. Move the alias to the Dictionary Items folder.
Use the Finder to move the alias you created in step 1 to the Dictionary
Items folder. The Dictionary Items folder is located within the Script
Debugger folder.

Figure 5-6 gives an example of a Dictionary Items folder containing a
series of aliases to commonly used scriptable applications.

Figure 5-6
The Dictionary
Items folder
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The resulting Open Dictionary menu is shown in Figure 5-7.

Figure 5-7
The Open Dictionary
menu
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You can also use the Add to Open Dictionary Menu extension script to
add an application's dictionary to the menu. If you have a Dictionary
window open, you can select the Add to Open Dictionary Menu script
from the Extensions menu. The script adds an alias of the application
to the Dictionary Items folder.

NOTE: I f  you add an application to the Dictionary Items folder (in other
words, the program and not the alias), it will not be listed in the Open
Dictionary menu.
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Adding Commands to the Extensions Menu
The Extensions menu allows you to add new commands to Script
Debugger. Each item listed in the Extensions menu corresponds to an
AppleScript script application file or compiled script stored in the
Extension Scripts folder inside the Script Debugger folder.

To add a new item to this menu, follow these steps:

1. Create a script.
Using Script Debugger, create a script which you want to include in the
Extensions menu.

2. Save the script in the Extension Scripts folder.
Save your script in the Extension Scripts folder within the Script
Debugger folder as a script application (applet or droplet) or as a
compiled script. If you save your script in any other format, such as a
Debugger Script or Text File, Script Debugger will not include your file
in the Extensions menu.

You can add a keyboard command to your Extension script by adding
"I<the key>" to the Extension script's name. For instance, if you
wanted to add Command-H to the Hide Descriptions extension, you
would rename it Hide DescriptionslH. The Extensions menu would
change accordingly (Figure 5-8).

Figure 5-8
A keyboard command
added to an Extension
script
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Attaching Scripts to the Menu Items
We have already pointed out elsewhere in this manual that Script
Debugger is scriptable, recordable, and attachable. Like other scriptable
applications, Script Debugger can be scripted and recorded. More
importantly, you can write scripts that extend and add to Script
Debugger's functionality.

You have already seen how you can add commands to Script Debugger
by adding scripts to the Extensions folder. Script Debugger is also
attachable; you can write scripts and attach them to commands in
Script Debugger's menus. This allows you to modify the way in which
some of Script Debugger's commands work.

The rest of this section explains how attachments work, outlines which
commands can be modified, and describes how to write attachment
handlers. For more information about Script Debugger's dictionary,
refer to Appendix B.

How Attachments Work
When Script Debugger starts up, it looks for a compiled script called
"Attachments" in the Script Debugger folder. If the Attachments
script exists, Script Debugger loads it and uses it to handle attachable
commands. When you issue one of the commands listed in Table 5-1,
Script Debugger uses the handler in the Attachments script for the
command. If the Attachments script does not contain a handler for the
command, or if an Attachments script is not present, Script Debugger
handles the command normally.
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NOTE: Before executing an attachable command, Script Debugger checks the modification date of the
Attachments script file. If the file has been changed since Script Debugger last loaded it, it reloads the script.
I f  the Attachments script has been removed or renamed, Script Debugger stops using the attachment handlers.

Table 5-1: ATTACHABLE COMMANDS
Command Menu Command AppleEvent/Handler

Create a new script File/New/Default Script make new document

Open a script document File/Open open

Close an open script File/Close close

Compile a script Controls/Compile compile

Run a script Controls/Run execute, execute open,
execute idle & execute quit

Step a script Controls/Step step

Pause a script Controls/Pause pause

When a script pauses
(following a step, or when a
breakpoint is encountered)

n/a pause

Stop a script Controls/Stop stop

When a script completes
(following a stop, following
an error or when the script
completes)

n/a stop

Start recording Controls/Record record

Save a script File/Save, File/Save As,
File/Save As Run-Only

save

Revert to saved File/Revert To Saved revert

Open an application
dictionary

Open Dictionary/Other open dictionary

Open the Scripting Additions
dictionary

Open Dictionary/Scripting
Additions

open additions dictionary

Close an open dictionary File/Close close
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Creating Attachment Handlers
To attach a script to a Script Debugger command, you must create a
handler for the command's Apple event and add it to the Attachments
script. For examples of attachment handers, look at the Attachment
scripts in the Auto-Add to Dictionary and Every Possible Handler
folders in the Attachments Examples folder. In particular, the Every
Possible Handler script has example handlers for all of the commands
that support attachment.

For instance, if you wanted to attach a script to Script Debugger's Open
Script command, you would add statements inside the open handler.

o n  o p e n  o f  t h e F i l e
t e l l  a p p l i c a t i o n  " F i n d e r "

s e t  d a t e l  t o  m o d i f i c a t i o n  d a t e  o f  t h e F i l e  a s  s t r i n g
s e t  d a t e 2  t o  c r e a t i o n  d a t e  o f  t h e F i l e  a s  s t r i n g

e n d  t e l l
d i s p l a y  d i a l o g  " C r e a t e d :  "  &  d a t e 2  &  r e t u r n  &

" L a s t  m o d i f i e d :  "  &  d a t e l  b u t t o n s  { " C a n c e l " ,  " O K " }  d e f a u l t  b u t t o n  2
c o n t i n u e  o p e n  t h e F i l e

e n d  o p e n

This particular script uses the Scriptable Finder to get the file
information about the file that you are about to open. It puts the
creation and modification date into variables and then displays a dialog
box with that information before the document is opened. Notice that
we do not have to insert a line to choose the file; Script Debugger takes
care of that before calling the handler. Another important item to
notice in this handler is the continue open t h e F i l e  line before
the end of the handler. If this is not included, Script Debugger does not
open the file. You should also notice that the display dialog line is
outside of the tell Finder block so the dialog is displayed in Script
Debugger. You could easily modify this script to use scripting additions
to get the file information and reformat it for display in the dialog box.

Customizing Script Debugger 8 1
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Debugging Extension and Attachment Scripts
It is sometimes difficult to debug Script Debugger extension scripts and
attachment handlers directly within Script Debugger. One way to solve
this problem is to use a second copy of Script Debugger. When you use
two copies of Script Debugger, one copy can host the script, and the
other can respond to Apple events.

When you run two copies of Script Debugger, you should make sure to
send the events to the correct copy. Renaming the second copy of Script
Debugger makes this a little easier.
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6
Common Problems and Troubleshooting

While every effort has been taken to make Script Debugger
a solid and bug-free program, you may still experience some
problems while you are using it. Some of these problems
stem from the interaction of AppleScript and scriptable
programs. This section lists some common problems and
offers suggestions for working around them.

page 225

Use the Include Enclosed Folders checkbox to indicate
whether or not you want Scheduler to include the files stored
in enclosed folders when it calculates the size of the folder.

front matter

Apple, Macintosh, Power Macintosh, PowerBook, AppleScript, APDA, Finder,
Balloon Help, Script Editor are trademarks of Apple Computer, Inc. All other
trademarks are acknowledged as the property of their respective owners.

Unauthorized reproduction by any means, electronic or otherwise, is strictly
forbidden.

page 121
atObject T h e  name of an AppleTalk network object

atType T h e  type name of an AppleTalk network object

atZone T h e  zone name of an AppleTalk network object
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PROBLEM I  can't compile Script Debugger scripts.
ANSWER T h e  Script Debugger dictionary is disabled. You can enable
it by clicking in the Enable Script Debugger Dictionary checkbox in the
Preferences dialog. See the Scripting Options section of Chapter 5:
Customizing Script Debugger, for more information.

PROBLEM I  can't record Script Debugger actions.
ANSWER Recording is only available when the Script Debugger
dictionary is enabled. To record Script Debugger's actions, you must
click on the Enable Script Debugger Dictionary checkbox in the
Preferences dialog. See the Scripting Options section of Chapter 5:
Customizing Script Debugger, for more information.

PROBLEM I  can't display the Script Debugger dictionary.
ANSWER T h e  Script Debugger dictionary is disabled. You can enable
it by clicking in the Enable Script Debugger Dictionary checkbox in the
Preferences dialog. See the Scripting Options section of Chapter 5:
Customizing Script Debugger, for more information.

PROBLEM I  can't open Script Debugger script files with Apple's Script Editor.
ANSWER Y o u r  Script Debugger scripts must be saved in Text,
Compiled Script, or Script Application format before they can be
opened by Apple's Script Editor.

PROBLEM The breakpoint information in my compiled script is missing.
ANSWER I f  you save a compiled script or a script application with
debugging information and then edit the file using Apple's Script
Editor, all of the breakpoint information will be lost when you open
the script again using Script Debugger.

PROBLEM Script Debugger's performance is poor when single-stepping through a
script.

ANSWER I f  you have an excessive number of expressions in the Data
window, Script Debugger slows down when single-stepping.
Expressions that result in long text values, record structures, or object
specifiers are particularly time consuming to update.
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PROBLEM I  can't debug open, idle or quit handlers.
ANSWER 1 Conf i rm that your script contains an open, idle or quit
handler and that it's compiled.

ANSWER 2 Make sure that you have a breakpoint set in your handler,
and that you are executing it using the appropriate Extensions script.

PROBLEM When I try to open a script, Script Debugger tells me that it can't open the
script because it was created by a later version of Script Debugger
(Figure 6-1).

ANSWER Y o u  will need to upgrade to the latest version of Script
Debugger.

NOTE: You can still open the file using Apple's Script Editor. You will lose
any debugging and data saved with the script.

Figure 6-1
Script Debugger
can't open a file
created by a later
version

0 Couldn't complete the last command
because the document was created
by a later  version of  Script
Debugger.

Result Code = 1009

OK

PROBLEM I  can't use Drag and Drop to invoke open handler.
ANSWER 1 M a k e  sure the script is compiled.

ANSWER 2 Make sure your script has an open handler.

ANSWER 3 Make sure you have a breakpoint set in the open handler.

ANSWER 4 Make sure your Macintosh has the Drag and Drop
extension installed or you are running System 7.5.

ANSWER 5 Make sure you are dragging a file (application, document,
etc.) or a folder. Script Debugger will not invoke the open handler if
you drag text or a text clipping.
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PROBLEM I  get an out of memory (-108) error when displaying the Scripting
Additions dictionary.

ANSWER 1 I f  you have a large number of third party scripting additions
installed, you may need to expand Script Debugger's memory partition
before you can display the Scripting Additions Dictionary window.

ANSWER 2 Script Debugger stores some of the information it needs to
display the dictionary using "Temporary Memory" If your system is
low on free memory, you do not have enough space available for Script
Debugger to display the dictionary. Try closing other applications that
you may have running.

PROBLEM I've written an attachment script for Script Debugger, but now I can't quit
the program.

ANSWER W h e n  you are writing scripts for the attachability features in
Script Debugger, you may get into a state where you can't quit the
program. This is caused when an attachment for the Close command
generates an error. The solution is to simply move the Attachments file
out of the Script Debugger folder and try the operation again.

This solution can be used to solve any problems caused by attachments.
It works because Script Debugger checks the Attachments file and
executes any handlers it finds there each time you select a command.

PROBLEM The identifiers in my script are in the lidentl style. (For more information
about identifiers, refer to the AppleScript Language Guide, p. 28.)

ANSWER I f  you open a script using Script Debugger which contains
identifiers that conflict with the identifiers in the Script Debugger
dictionary, the identifiers in the script are converted to the lidenti
style. To avoid this, uncheck the Enable Script Debugger Dictionary
checkbox in the Preferences dialog box.
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Extension Scripts

You can add to Script Debugger's features by writing
Extension scripts and placing them in the Extensions folder.
This appendix describes the Extension scripts that are
shipped with Script Debugger. It explains how to use them
and provides some tips that might not be obvious. If you are
interested in writing Extension scripts for Script Debugger,
be sure to examine the way these scripts are written.

Extension Scripts 8 7



ËË fl##ª%º'® fl

Õ"Æ$%¨ ‹ªæ´,,ªÆ ¤®¨ª/0$±/0
Õ+Æ'#¨ ‹ªæ´11ªÆ #Æ±™'ºª4 ø 4#ª+'ø¥ ¤®¨ª%4'±%4 8ª%´ ¯⁄#$´Æª flÛÔ˜

©:ªÆª ß±´ +ø% øºº øºº'¨'±%ø¥ +±88ø%º4 ¨± ¨:ª #Æ±1Æø8Ú Ã:ª4ª

+±88ø%º4 '%™±µª fl##¥ªÕ+Æ'#¨ 4+Æ'#¨4 ¨:ø¨ ´4ª ¨:ª Õ+Æ'#¨ ‹ªæ´11ªÆ

4+Æ'#¨'%1 '%¨ªÆ?ø+ª ¨± øºº ?´%+¨'±%ø¥'¨ß ¨± ¨:ª #Æ±1Æø8Ú

Õ+Æ'#¨ ‹ªæ´11ªÆ +±8ª4 ©'¨: ¨©ª¥™ª ¤®¨ª%4'±% 4+Æ'#¨4 ¨:ø¨ øÆª

º±+´8ª%¨ªº '% ¨:'4 4ª+¨'±%Ú @? ß±´ ©ø%¨ ¨± øºº ¤®¨ª%4'±% 4+Æ'#¨4 ¨±

¨:'4 8ª%´Ù 4ªª ›:ø#¨ªÆ ÎÙ ›´.¨±1#¶#3$ Õ5Æ#6¨ ‹ªæ´$$ªÆÚ

⁄"#´Æª flÛÔ

Õ"Æ$%¨ ‹ªæ´,,ªÆK.
¤®¨ª1.$±1. 3ª1´

Script Debugger Extensions
Script Debugger provides a special Extensions menu (Figure A-1)
where you can add additional commands to the program. These
commands invoke AppleScript scripts that use the Script Debugger
scripting interface to add functionality to the program.

Script Debugger comes with twelve Extension scripts that are
documented in this section. If you want to add Extension scripts to
this menu, see Chapter 5, Customizing Script Debugger.

Figure A-1
Script Debugger's
Extensions menu
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EHtensions
Rdd Properties to Data Window
Odd To Open Dictionary Menu
Execute Idle Handler
Execute Open Handler (Files)...
Execute Open Handler (Folders)...
Execute Quit Handler
Hide Descriptions
Lock fill Expressions
Paste File Path...
Paste Folder Path...
Show Descriptions
Unlock fill Expressions
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Add Properties To Data Window
The Add Properties to Data Window extension script allows you
to set up the Data window with the object properties from the Script
window. This can save time since you do not have to add each property
in the script individually.

To add the properties to the Data window,

1. Bring the Script window to the front.
2. Select the Add Properties to Data Window command from the Extensions menu.
If you have made any changes to the script, the script extension
prompts you to compile the changes (Figure A-2). This allows Script
Debugger to add any additional globals you have added to the script
since the last time you compiled it. Script Debugger then adds the
object properties to the Data window.

Figure A-2
Compile changes
prompt

Compile changes?

( Cancel i No i W M

If the script has been compiled, this dialog box does not appear.
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Add To Open Dictionary Menu
The Add to Open Dictionary Menu extension script adds an appli-
cation or scripting addition to the Open Dictionary menu. When you
execute the script, it gets the name of the frontmost application or
scripting addition dictionary window. I t  then creates an alias of the
application or scripting addition in the Dictionary Items folder. To add
an application's dictionary to the menu, follow these steps:

NOTE: This script uses the Scriptable Finder.

1. Open an application's or scripting addition's dictionary using the Other sub-menu
under the Open Dictionary menu.

2. Choose Add to Open Dictionary Menu from the Extensions menu.
The script creates an alias in the Dictionary Items folder for the
application.

NOTE: Make certain that you have a Dictionary window in the foreground
when you choose Add to Open Dictionary Menu. I f  you do not, Script
Debugger informs you that the current window is not a Dictionary
window (Figure A-3).

Figure A-3
Not a Dictionary
window error
message
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1  T h e  current window is not a dictionary window

This script uses the Gestalt scripting addition from Late Night Software
Scripting Additions and the Scriptable Finder. If you do not have the
Scriptable Finder installed, an error dialog box appears with the
message that the Scriptable Finder is not installed. See Appendix D,
More Information about AppleScript, for information about getting the
scriptable Finder.

If you try to add a Dictionary window that is already in the Open
Dictionary menu, you will see an error message (Figure A-4).
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An alias already
exists in the
Dictionary Items
folder

 S c r i p t  Error

"JPEGView " already ex is ts  in the Dictionary Iten-is
folder

Execute Idle Handler
The Execute Idle Handler extension script invokes the idle handler in
the current script. Like the Execute Open and Execute Quit scripts, this
script allows you to test and debug idle handlers without the need to
modify your script after you have finished testing it.

The best way to test an idle handler is to set a breakpoint in the handler,
and then select the Execute Idle Handler script. The breakpoint stops
the script in the handler and you can then single-step through it.

NOTE: I f  the current window does not have an idle handler in it, Script
Debugger returns an error message (Figure A-5).

Figure A-5
No Idle handler
error message

Figure A-6
Script running
or recording
error message

 S c r i p t  Error

/ 1 \
Script " t e s t "  does not have an Idle handler.

M i n

Script Debugger also returns an error message if the script in the
current window is running or if you are recording a script in the
current window when you invoke the Execute Idle Handler script
(Figure A-6).

 S c r i p t  Error

1  S c r i p t  " t e s t "  is already running or  recording.
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Execute Open Handler (Files).. .
The Execute Open Handler (Files) extension script invokes the open
handler of the current Script window. If you want to take control of the
script once the handler has been invoked, you should set a breakpoint
in the Open handler. This stops the script in the handler so that you
can single-step through it.

To execute the script,

1. Choose Execute Open Handler (Files) from the Extensions menu.
2. Select the files for the Open handler in the dialog box (Figure A-7) and click the

Add button.

Figure A-7
The Add Files
dialog box
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Script Debugger 1.0

L i  Dictionary I tems
Euamples

LIEF:tension Scripts
D  Icon
19 Read Me First
t r,  Script Debugger
L i  Template Scripts

Files for  Open handler:

Rdd

o  Hard Disk 234

( E l e c t

( Desktop

( C a n c e l

( D o n e

Hard Disk 234:Desktop ...er 1.0:Default Script

As you select files, they are added to the scrolling list at the bottom of
the dialog box.

3. Click the Done button and Script Debugger passes the selected files to the Open
handler as a parameter, and executes it.

If you have Macintosh Drag and Drop installed, you can use the
Drag and Drop feature to execute your Open handler. You do this
by dropping a file or files on the open Script window. For more
information about this feature, refer to Chapter 3, Creating and
Editing Scripts.
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Execute Open Handler (Folders).. .
The Execute Open Handler (Folders) extension script invokes the open
handler of the current Script window. If you want to take control of the
script once the handler has been invoked, you should set a breakpoint
in the Open handler. This stops the script in the handler so that you
can single-step through it.

To execute the script,

1. Choose Execute Open Handler (Folders) from the Extensions menu.
2. Select the folders for the Open handler in the dialog box (Figure A-8) and click the

Add button.

Script Debugger 1.0 o  Hard Disk 234

L I  Dictionary I tems
Examples
Extension Scripts

"U" B e r t

Desktop

Cancel

( Open

Done

Folders for  Open handler:

Odd "Extension Scripts"  ( Remove )

Figure A-8
The Add Files
dialog box

Hard Disk 234:Desktop... 1.0:Template Scripts

3. Click the Done button and Script Debugger passes the selected folders to the open
handler as a parameter, and executes it.

If you have Macintosh Drag and Drop installed, you can use the
Drag and Drop feature to execute your Open handler. You do this
by dropping a folder or folders on the Open Script window. For more
information about this feature, refer to Chapter 3, Creating and
Editing Scripts.
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Execute Quit Handler
The Execute Quit Handler extension script invokes the quit handler in
the current script. As with the other Execute scripts, this script provides
you with a way to debug a Quit handler without having to edit the
script.

If your script needs to be compiled, this script will compile it before the
handler is executed.

NOTE: I f  the current window does not have a quit handler in it when you
choose Execute Quit Handler from the Extensions menu, Script Debugger
returns an error message (Figure A-9).

Figure A-9
No Quit Handler
error message

 S c r i p t  Error

1  S c r i p t  " test "  does not have a Quit handler.

Cancel

Hide and Show Descriptions
The Hide Descriptions extension script lets you hide the description
areas in all currently open scripts. This is quicker than bringing each
window to the front and clicking on its Script Description triangle. To
hide all descriptions, choose Hide Descriptions from the Extensions
menu.
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You can reverse the effect of the Hide Descriptions script by choosing
Show Descriptions from the Extensions menu. The Show Descriptions
extension script lets you show the description areas in any currently
opened scripts. This is quicker than bringing each window to the front
and clicking on its Script Description triangle. To show all descriptions,
choose Show Descriptions from the Extensions menu.

If you do not have any Script windows open, Script Debugger returns
an error (Figure A-10).
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Figure A-10
No open documents
error message

Script Error

/,.. T h e r e  are no open documents
/y  \
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Lock and Unlock All Expressions
The Lock All Expressions extensions script allows you to lock the
contents of the expressions in your Data window. This preserves the
values of the expressions in the Data window. If you run your script
again after you have locked it, the expression values are not changed.
Another advantage of locking expressions is that it speeds up the
performance of your script when you are single-stepping.

To lock the expressions in your script,

1. Bring the Script or Data window to the front.
2. Choose Lock All Expressions from the Extensions menu.
You will notice that locks appear next to the expressions in the Data
window (Figure A-11).

Figure A-11
A Data window
with Locked
Expressions theFile

resFile
numTy pes
totalRsrcs
aResType

Count Resources (Data)

0101
ii alias "MacOS Sy stem Folder Extensions :Scripting Additions :Add Picture" { )
ii 9026
ii 5

"osax"

Now, if you run your script again, the values of the expressions will not
change. If you watch the progress of your script in the Event Log
window, you can see that the expressions are being updated, but their
values in the Data window are not updated.

The Unlock All Expressions script reverses the effects of the Lock All
Expressions script. To unlock the expressions in your script,

1. Bring the Script or Data window to the front.
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2. Choose Unlock All Expressions from the Extensions menu.
Now, if you run your script again, the values of the expressions will be
updated as they normally would.

Paste File Path...
The Paste File Path extension script pastes the path to a file into a
script. You can use this to quickly place the location of files in the
scripts you write. For instance, if you want to define an AppleScript
property containing an alias to a particular file, follow these steps:

1. Enter the beginning of a property definition into your script (Figure A-12).

Figure A-12
Property definition
for a file alias

Figure A-13
The File Selection
dialog box
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!property myFile :alias
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2. Choose the Paste File Path command in the Extensions menu.
When the file selection dialog box opens (Figure A-13), locate the file
whose path you want to place in the script.

Script Debugger 1.0

y, Default Script
L i  Dictionary I tems
L i  Extension Scripts
L i  Script Tools 1.4

Scripting Interface
LiTemplate  Scripts
L I  Useful Scripts
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Once the Open button is pressed, the file's path is added to your script
(Figure A-14).

, D   U n t i t l e d -1  W WI
Script Description... M  L a v J

;property myFile: alias "Hard Disk 234:Desktop Folder:Script Debugger 1.0:5cript Debugger"

Handlers .  1.(1 iiii I Vri

Figure A-14
A file's pathname
pasted into
a script

Paste Folder Path...
The Paste Folder Path extension script is similar to the Paste File Path
extension script. Instead of pasting a file pathname into your script,
however, it pastes a folder's pathname into your script.

To paste a folder path into your script,

1. Choose Paste Folder Path from the Extensions menu.

Figure A-15
The Folder
Selection
dialog box

A folder selection dialog box opens (Figure A-15).

Choose a folder:

Script Debugger 1.0 w

L I  Dictionary I tems
Extension Scripts

L I  Script Tools 1.4
LiTemplate  Scripts
L I  Useful Scripts

(Choose "Script Debugger 1 .0 '

o  Hard Disk 234

( Desktop

( Choose

( C a n c e l

( O p e n
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2. Select the folder whose path you want to add to your script and click the Choose
button.

When you have selected a folder, the dialog box closes and the path is
pasted into your script window (Figure A-16).

Figure A-16
A folder's
pathname
pasted into
a script
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Script Debugger Scripting Interface

This appendix describes the objects available in Script
Debugger's dictionary and the commands that you can
use to manipulate these objects and their contents. The
purpose of the discussion in this appendix is to make it
easier for you to write scripts extending and modifying
Script Debugger's behavior. You can find information
about all of Script Debugger's objects and commands by
opening its dictionary using the Open Dictionary Other
command in the File menu.
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Scripting Script Debugger
As we discussed in Chapter 5, Customizing Script Debugger, you can
write scripts that add commands to Script Debugger's Extensions menu
and modify the behavior of Script Debugger's commands. Toward that
end, this section of the manual briefly elaborates on the description of
the commands that you find in Script Debugger's dictionary.

NOTE: To use the Script Debugger scripting interface effectively, you must
enable the Script Debugger dictionary using the Preferences command.
When you no longer need the Script Debugger dictionary, disable it
to avoid terminology conflicts with Scripting Additions and other
applications. Please refer to Chapter 5 for more details about the
Preferences command.

Certain Restrictions
When you are scripting Script Debugger, you should be aware of
certain restrictions that affect any event which causes a script to
execute. These events are the step, execute, execute open, and other
commands.

Script Debugger only allows one script to be executing at any given
time. If you have a script paused in one window, you cannot begin
executing or recording a script in another window. Whenever you
cannot run a script, check the other open windows to make certain that
you have not paused a script. One exception to this is that you can
compile a script in another window while a script is paused.

Another restriction in Script Debugger is that the event which initiates
the execution of a script (the first step or execute command) will not
complete until the script finishes executing. If you want to be able to
issue additional step events, you must send the first step event using an
AppleScript "ignoring application response" block.

In addition to these restrictions, you will also notice that object
references containing "whose" tests involving strings are limited to
255 characters and not 32,767 as the Apple Event Registry suggests.
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Element Hierarchy
Figure B-1 shows the hierarchy of objects within Script Debugger.
Whenever you see an element in the hierarchy followed by an ellipse,
the element has a sub-tree that is hidden to save space in the graphic.
For more information about objects and inheritance in AppleScript,
refer to the Apple Event Object Support Library Developer Note and the
Apple Event Registry.

Figure B-1
Script Debugger's
object hierarchy
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Perhaps the best way to think of Script Debugger's element hierarchy is
as windows and the information they contain. For example,

Script Debugger
has open documents

which have text
which have data items

has open dictionaries
which have suites

which contain events
which contain classes

This is the core structure for the program. The window classes are built
around this core and provide access to non-document information
such as the dictionary, event log, and result windows. The window
classes also provide alternate access paths to document information
such as the script text and data items. The alternate access paths are
made possible by additions to the Core, Text, and Miscellaneous suites.
You can see these suites in the Script Debugger dictionary.

Augmented Suites
If you look in Script Debugger's Dictionary window, you will see the
core, text, and miscellaneous suites represented along with the Script
Debugger suite. These suites are included in the dictionary because
they have additional commands, classes, and properties that make
scripting Script Debugger easier. We will look at a few of these
commands in this section, and you can find out more about the
additions by examining the dictionary.

Text Suite
The additions to the Text suite allow you to get text from Script
Debugger's document windows. These extensions to the suite are
limited to some additional properties for the text, line, character, and
word classes. For example, the properties "breakpoint" and "breakpoint
set" let you get the breakpoint information about a line in your script.
The extensions to the text suite are modeled on the Scriptable Text
Editor.
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In the Text suite, you can ask for the default value of an object in a few
forms:

1. As text.

g e t  l i n e s  o f  f i r s t  d o c u m e n t  w h o s e  b r e a k p o i n t  s e t  =  t r u e  a s  p l a i n  t e x t

2. As styled text. This is the default.
g e t  f i r s t  l i n e  o f  d o c u m e n t  a s  s t y l e d  t e x t

3. As an object reference.
g e t  l i n e s  o f  f i r s t  d o c u m e n t  w h o s e  b r e a k p o i n t = t r u e  a s  r e f e r e n c e

Object references are important because they allow you to retain
references in your script. This can be very useful if you need to apply a
number of events to the references:

s e t  b p L i n e s  t o  l i n e s  o f  f i r s t  d o c u m e n t  w h o s e  b r e a k p o i n t  s e t  =  t r u e  a s  r e f e r e n c e
s e t  b p L i n e T e x t  t o  c o n t e n t s  o f  b p L i n e s
s e t  b r e a k p o i n t  s e t  o f  b p L i n e s  t o  f a l s e

This is generally faster because the returned object references are
character-based, which is the fastest method. Line-based selections are
the next fastest. Word-based selections are the slowest because Script
Debugger has to find all of the words along the way to resolve the
specification.

Core Suite
The only addition to the Core suite is the Save command. It accepts
some additional parameters which let you specify the file type and
whether or not it is run-only. For instance, you can save a window into
a debugger script.

s a v e  f i r s t  w i n d o w  i n  ( n e w  f i l e )  a s  d e b u g g e r  s c r i p t

Or you could save a compiled script in read only format.

s a v e  f i r s t  w i n d o w  i n  ( n e w  f i l e )  a s  s c r i p t  a p p l i c a t i o n  w i t h  r u n  o n l y
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Miscellaneous Suite
The additions to the Miscellaneous suite allow you to script the menus
and menu items in Script Debugger. As you will see in a script later in
this appendix, you can use the menu commands to bring windows to
the front in your scripts. You can also use menu commands to speed
some otherwise tedious-to-script tasks.

For example, if you want your script to quit Script Debugger and save
all of the windows as Script Debugger is quitting, you could write a
script which cycles through all of the windows and saves each one.
However, the menu commands allow you to accomplish the same task
in fewer lines.

s e l e c t  m e n u  i t e m  " S a v e  A l l "  o f  m e n u  " W i n d o w s "
s e l e c t  m e n u  i t e m  " Q u i t "  o f  m e n u  " F i l e "

Granted, such scripts are not always optimal, but they can save you
time and let you script objects in Script Debugger that you might not
otherwise be able to script.

The Miscellaneous suite also contains an addition to the Select
command. It has a "scroll to selection" parameter which only applies
when selecting objects from the text suite. It allows you to scroll the
newly selected text into view.

Script Debugger Suite
Aside from the additions to the other suites that we have just looked at,
all of the other unique commands are limited to the Script Debugger
suite. The commands in the Script Debugger suite allow you to perform
all of the tasks in scripts that you can perform in the interface. This
extends to the way that scripts are executed and that windows are
opened, in scripts.
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Script Window
When you are executing a script interactively in Script Debugger, the
Script window must be on top. The same holds true of any script that
you write to control Script Debugger. If your script issues events to
Script Debugger which change window order, the window of the
running script remains on top. If your script opens a Dictionary
window, for example, it will be opened below the running script.

Note also that when a script is executing or paused, its text is locked.
Any Apple events which try to alter the text of a running or paused
script, are not handled.

With those restrictions in mind, let's look at some ways that you can
script Script Debugger.

Create a Script Application
This example script creates a script application from the script on the
clipboard. While trivial in itself, this script demonstrates that you can
control Script Debugger through scripts.

Due to Script Debugger's restriction that the executing window must
be on top, you would need to run this script from another script editor
or a second copy of Script Debugger.

t e l l  a p p l i c a t i o n  " S c r i p t  D e b u g g e r "
a c t i v a t e
p a s t e
s a v e  f i r s t  w i n d o w  i n  f i l e  " S c r i p t  A p p "  a s  s c r i p t  a p p l i c a t i o n

e n d  t e l l

Before you run this script, you would need to copy the script for
a script application to your clipboard. When the example script is
executed, activating Script Debugger converts the clipboard. The
paste command inserts the contents of the clipboard into the front-
most window. The save command allows you to save the script as an
application. If you step through the script, you may notice a longer
delay while the save line is executing. This is a result of Script Debugger
compiling the script before it saves it as an application. Of course, any
errors in the script that you are pasting in will cause the script to fail.
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Save as Run-Only
This example script has its basis in the File Droplet template. It takes a
compiled script that you drop on it and saves it as a run-only script.
The script application opens the script dropped on it in Script
Debugger and then saves it.

o n  P r o c e s s A F i l e ( a F i l e )
t e l l  a p p l i c a t i o n  " S c r i p t  D e b u g g e r "

o p e n  a F i l e
s a v e  f i r s t  w i n d o w  i n  ( n e w  f i l e )  a s  s c r i p t - ,
a p p l i c a t i o n  w i t h  r u n  o n l y

e n d  t e l l
e n d  P r o c e s s A F i l e

o n  o p e n  o f  f i l e L i s t
r e p e a t  w i t h  a F i l e  i n  f i l e L i s t

P r o c e s s A F i l e ( c o n t e n t s  o f  a F i l e )
e n d  r e p e a t

e n d  o p e n

o n  r u n
s e t  t h e F i l e  t o  c h o o s e  f i l e
P r o c e s s A F i l e ( t h e F i l e )

e n d  r u n

The script prompts you for a name, but it could just as easily be re-
written to take the name of the original script.

Comment Lines
While the previous scripts show how easy it is to script Script
Debugger, the real power of Script Debugger is in its extendability.
Through Extension scripts, you can add features and power to Script
Debugger. This example script places a block comment around the
selected text and can be run as a script extension. It performs a couple
of checks to make certain that the front window is a script and that it is
not paused or running. It then gets the range of the selected text and
places a block comment mark at the beginning and end of the
selection.
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ª-º
ª-º

i f  f i r s t  d o c u m e n t  e x i s t s  t h e n
i f  c l a s s  o f  f i r s t  w i n d o w  =  documen t  w i n d o w  t h e n

i f  d e b u g g e r  s t a t e  o f  f i r s t  d o c u m e n t  =  s t o p p e d  t h e n
s e t  t h e S e l  t o  s e l e c t i o n  o f  f i r s t  d o c u m e n t
i f  c l a s s  o f  t h e S e l  #  i n s e r t i o n  p o i n t  t h e n

s e t  s t a r t O f f s e t  t o  c h a r a c t e r  o f f s e t  o f  f i r s t  c h a r a c t e r  o f  t h e S e l
s e t  e n d O f f s e t  t o  c h a r a c t e r  o f f s e t  o f  l a s t  c h a r a c t e r  o f  t h e S e l

make n e w  t e x t  a t  a f t e r  c h a r a c t e r  e n d O f f s e t  o f  f i r s t  d o c u m e n t
w i t h  d a t a  " * ) "

make n e w  t e x t  a t  b e f o r e  c h a r a c t e r  s t a r t O f f s e t  o f  f i r s t  d o c u m e n t
w i t h  d a t a  " ( * "

s e l e c t  t e x t  s t a r t O f f s e t  t h r u  ( e n d O f f s e t  +  4 )  o f  f i r s t  d o c u m e n t
e l s e

e r r o r  " C a n ' t  comment e m p t y  s e l e c t i o n "
end i f

e l s e
e r r o r  " S c r i p t  " "  &  (name o f  f i r s t  d o c u m e n t )  &  " "  i s  r u n n i n g  o r  r e c o r d i n g . "

end i f
e l s e

e r r o r  " T h e  c u r r e n t  w i n d o w  i s  n o t  a  d o c u m e n t  w i n d o w "
end i f

e l s e
e r r o r  " T h e r e  a r e  n o  o p e n  d o c u m e n t s "

end i f

You can extend this script to place either block comment marks or
single line comment marks based upon the length of the selection. For
example, if there are more than six lines selected, the script would place
block comment marks. If six lines or less are selected, the script would
place two dashes at the beginning of each line.

Scripting Pointers
When you are writing scripts for Script Debugger's Script window, it is
a good idea to use "whose" expressions as much as possible. This speeds
up script execution considerably. For instance, you could locate all of
the lines containing breakpoints by stepping through each of the lines
and checking to see if the breakpoint is set.

s e t  b p L i n e s  t o  { }
r e p e a t  w i t h  i  f r o m  1  t o  c o u n t  l i n e s  o f  f i r s t  d o c u m e n t

i f  b r e a k p o i n t  s e t  o f  l i n e  i  o f  f i r s t  d o c u m e n t  t h e n
s e t  b p L i n e s  t o  b p L i n e s  &  {  i  }

end
end
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While thorough, this is the slow way to find the breakpoints. A faster
way uses a "whose" expression.

s e t  b p L i n e s  t o  l i n e s  o f  f i r s t  d o c u m e n t  w h o s e  b r e a k p o i n t  s e t  =  t r u e

Whose expressions rely on object references. As noted earlier in this
appendix, they are faster than line and word references.

Data Window
In addition to manipulating the contents of script windows and the
windows themselves, you can also work with the contents and other
Script Debugger windows. For example, you can save the contents of
the Data window. If you save a script that you are working on as a
Debugger script, it retains the expressions and their values between
runs. You might also find it useful to save the contents of the Data
window across several runs of your script for the purpose of
comparison. The following script saves the contents of the Data
window to a text file.

s c r i p t  d a t a I t e m O b j
p r o p e r t y  t h e E x p r s

e n d
{

( * S a v e  t h e  e x p r e s s i o n s  i n  t h e  d a t a  w i n d o w  t o  a  f i l e  * )

s e t  t h e E x p r s  o f  d a t a I t e m O b j  t o  ( e x p r e s s i o n  o f  d a t a  i t e m s  o f  s e c o n d  d o c u m e n t )
s e t  t h e O b j F i l e  t o  n e w  f i l e
s t o r e  s c r i p t  d a t a I t e m O b j  i n  t h e O b j F i l e  r e p l a c i n g  y e s

( * A d d  t h e  e x p r e s s i o n s  s a v e d  i n  a  f i l e  t o  t h e  d a t a  w i n d o w  * )

d e l e t e  d a t a  i t e m s  o f  s e c o n d  d o c u m e n t

s e t  n e w D a t a I t e m O b j  t o  l o a d  s c r i p t  t h e O b j F i l e
r e p e a t  w i t h  a n E x p r  i n  t h e E x p r s  o f  n e w D a t a I t e m O b j

make  n e w  d a t a  i t e m  a t  e n d  o f  s e c o n d  d o c u m e n t  w i t h  d a t a  ( c o n t e n t s  o f  a n E x p r )
e n d  r e p e a t
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Dictionary Window
The dictionary commands in the Script Debugger suite allow you to
open any Dictionary window or the Scripting Additions Dictionary
window. The scripting interface also allows you to retrieve information
from the Dictionary window. If you have selected text in a Dictionary
window, you can retrieve the text with the script

g e t  t e x t  f r o m  t h e  f i r s t  d i c t i o n a r y  w i n d o w

You can also specify the text for Script Debugger to retrieve. For
example, the script

g e t  l i n e s  1  t h r o u g h  5  o f  t h e  f i r s t  d i c t i o n a r y  w i n d o w

returns the specified lines. The full text suite is supported so you
can perform "whose" tests or any operation you can do in the other
windows.

NOTE: The text in Dictionary windows is not modifiable.

For a better idea of the capabilities in Script Debugger's
implementation of the dictionary window, open the Additions
Inventory script application that you will find in the Script Debugger
Examples folder of the Examples folder. This script uses Script
Debugger to open the dictionary window for each addition in the
Scripting Additions folder, to copy the class and event information, and
to write it to a Scriptable Text Editor file. The business end of the script
begins after the "tell application "Script Debugger" statement which is
located toward the end of the file.
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t e l l  a p p l i c a t i o n  " S c r i p t  D e b u g g e r "
s e t  t h e D i c t  t o  o p e n  d i c t i o n a r y  a d d i t i o n P a t h

t e l l  me  t o  O u t p u t Te x t ( " A d d i t i o n  " "  &  name o f  a d d i t i o n I n f o  &
s e t  n u m S u i t e s  t o  c o u n t  e v e r y  d i c t i o n a r y  s u i t e  o f  t h e D i c t
r e p e a t  w i t h  i  f r o m  1  t o  n u m S u i t e s

t e l l  me  t o  O u t p u t Te x t ( "  S u i t e :  "  &  name o f  - .
d i c t i o n a r y  s u i t e  i  o f  t h e D i c t )

i f  d i c t i o n a r y  e v e n t  1  o f  d i c t i o n a r y  s u i t e  i  o f  t h e D i c t  e x i s t s  t h e n
t e l l  me  t o  O u t p u t Te x t ( "  E v e n t s :  "  &  - .

(name o f  e v e r y  d i c t i o n a r y  e v e n t  o f  - .
d i c t i o n a r y  s u i t e  i  o f  t h e D i c t )  a s  s t r i n g )

e l s e
t e l l  me  t o  O u t p u t Te x t ( "  E v e n t s :  n o n e " )
end i f
i f  d i c t i o n a r y  c l a s s  1  o f  d i c t i o n a r y  s u i t e  i  o f  t h e D i c t  e x i s t s  t h e n
t e l l  me  t o  O u t p u t Te x t ( "  C l a s s e s :  "  &  - .

(name o f  e v e r y  d i c t i o n a r y  c l a s s  o f  - .
d i c t i o n a r y  s u i t e  i  o f  t h e D i c t )  a s  s t r i n g )

e l s e
t e l l  me  t o  O u t p u t Te x t ( "  C l a s s e s :  n o n e " )
end i f

end r e p e a t
t e l l  me  t o  O u t p u t Te x t ( "  " )
c l o s e  t h e D i c t

end t e l l

In this portion of the script, Script Debugger counts the suites in the
scripting additions window. It then checks for and lists the events and
classes in each of the suites in the Dictionary window. Notice that it is
retrieving the information as a string and then concatenating the string
with a label to paste in the Scriptable Text Editor window.
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Event and Result Windows
The Script Debugger suite contains classes that allow you to refer to the
Event and Result windows. You can use the save command to write the
contents of the window to a file.

While you are testing a script, you might want to save the contents of
the Event Log or Result windows during different runs of a script. This
would provide you with a source of comparison as you make changes
to your script and help you isolate problems. It is easy enough to bring
the Event Log or Result window to the front and perform a save, but it
is even simpler to incorporate the save command into your script.

For example, you can add a line to the end of your script that prompts
you for a name and saves the contents of the Result window to disk.

t e l l  a p p l i c a t i o n  " S c r i p t  D e b u g g e r "
l i s t  f o l d e r  " H a r d  D i s k  2 4 5 : S y s t e m  F o l d e r : E x t e n s i o n s : S c r i p t i n g  A d d i t i o n s : "
s a v e  " R e s u l t "  w i n d o w  ( n e w  f i l e  w i t h  d e f a u l t - ,

" A d d i t i o n s  L i s t i n g " )
e n d  t e l l

You can script the Event Log window in the same way. You should
remember that the events are not recorded in the window if it is not
open. To make sure that the window is open to catch events, you can
add a line to the beginning of your script that opens the window, and
then one at the end that saves the contents of the window.

t e l l  a p p l i c a t i o n  " S c r i p t  D e b u g g e r "
s e l e c t  m e n u  i t e m  " S h o w  E v e n t  L o g "  o f  m e n u  " W i n d o w s "
l i s t  f o l d e r  ( c h o o s e  f o l d e r )
s a v e  e v e n t  l o g  w i n d o w  i n  ( n e w  f i l e )

e n d  t e l l

Note that this rather simplistic script will fail if the Event Log window
is already open since its menu will be disabled. You can check for the
status of a menu with this line of script.

g e t  e n a b l e d  o f  m e n u  i t e m  " E n t e r  S e l e c t i o n "  o f  m e n u  " S e a r c h "

This will return a boolean on which you can base the behavior of your
script .
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Scripting Additions

This appendix describes each of the AppleScript commands
in the Late Night Software Scripting Additions package.
Scripting additions are a special type of software that add
new features to the AppleScript language.

The Late Night Software Scripting Additions are automatically
installed when you select Easy Install when installing Script
Debugger (see Chapter 1). You will find the example scripts in
the Examples folder which is inside the Examples folder of the
Script Debugger folder.

Scripting Additions 1 1 3



ÔÔÏ fl$$ª&º(® ›

flºº#¨#±&' ¤®ø,-¥ª'
Ã-ª flºº(¨(±&0 ¤®ø3$¥ª0 5±¥ºªÆ (&0(ºª ¨-ª ¤®ø3$¥ª0 5±¥ºªÆ 7±&¨ø(&0 ø

0ªÆ(ª0 ±5 ª®ø3$¥ª fl$$¥ªÕ7Æ($¨ 07Æ($¨0 0-±©(&: -±© ¨± ´0ª ¨-ª &ª©

7±33ø&º0 $Æ±™(ºªº æß ¨-ª ‘ø¨ª “(:-¨ Õ±5¨©øÆª Õ7Æ($¨(&: flºº(¨(±&0Ú

fl¥¥ ±5 ¨-ª0ª ª®ø3$¥ª0 øÆª 0¨±Æªº ø0 Õ7Æ($¨ ‹ªæ´::ªÆ 07Æ($¨0 ±Æ 07Æ($¨

ø$$¥(7ø¨(±&0Ú

fl--¥ªÃø¥µ ⁄±¥ºªÆ

fl""¥ªÃø¥µ Õ¨ø¨ª

Ã-(0 ª®ø3$¥ª º(0$¥øß0 ¨-ª 7´ÆÆª&¨ 0¨ø¨ª ±5 ¨-ª fl$$¥ªÃø¥µ

&ª¨©±ÆµÚ

‘,-¨ ⁄,¥ª ÕªÆ™ªÆ-

Ã-(0 ª®ø3$¥ª ¥(0¨0 ¨-ª 5(¥ª 0ªÆ™ªÆ0 ø™ø(¥øæ¥ª ±& ß±´Æ

fl$$¥ªÃø¥µ &ª¨©±ÆµÚ

⁄#¥ª' ˙ ⁄±¥ºªÆ' ⁄±¥ºªÆ

›2±±-ª ⁄,¥ª 45 –Æª7- ⁄±¥ºªÆ

Ã-(0 ª®ø3$¥ª 0-±©0 -±© ¨± ´0ª ¨-ª Õª¨ ‹ª5ø´¥¨ ⁄±¥ºªÆ ø&º

Ÿª¨ ‹ª5ø´¥¨ ⁄±¥ºªÆ 7±33ø&º0 ¨± 7±&¨Æ±¥ ¨-ª 0¨øÆ¨(&: 5±¥ºªÆ

$Æª0ª&¨ªº æß ¨-ª ›-±±0ª ⁄(¥ª 7±33ø&ºÚ

›2±±-ª “ª© ⁄,¥ª ¤®ø="¥ª

Ã-(0 0-±Æ¨ ª®ø3$¥ª 0-±©0 ¨-ª ›-±±0ª “ª© ⁄(¥ª 7±33ø&º

(& ´0ªÚ

›2±±-ª Õª™ªÆø¥ ⁄,¥ª- ¤®ø="¥ª

Ã-(0 0-±Æ¨ ª®ø3$¥ª 0-±©0 ¨-ª ›-±±0ª Õª™ªÆø¥ ⁄(¥ª0

7±33ø&º (& ´0ªÚ

›2±±-ª Õª™ªÆø¥ ⁄±¥ºªÆ- ¤®ø="¥ª

Ã-(0 0-±Æ¨ ª®ø3$¥ª 0-±©0 ¨-ª ›-±±0ª Õª™ªÆø¥ ⁄±¥ºªÆ0

7±33ø&º (& ´0ªÚ

⁄,¥ª 4— ¤®ø="¥ª

Ã-(0 ª®ø3$¥ª 7Æªø¨ª0 ø ¨ª®¨ 5(¥ª ø&º ©Æ(¨ª0 ø 0-±Æ¨ 3ª00ø:ª

¨± (¨ ´0(&: ¨-ª ⁄(¥ª F— 7±33ø&º0Ú

⁄,¥ª 4— ¤®ø="¥ª 44

Ã-(0 ª®ø3$¥ª ±$ª&0 ø ¨ª®¨ 5(¥ª ø&º º(0$¥øß0 ¨-ª 7±&¨ª&¨0 ±5

¨-ª 5(¥ªÙ ¥(&ª æß ¥(&ªÚ

Additions Examples
The Additions Examples folder inside the Examples folder contains a
series of example AppleScript scripts showing how to use the new
commands provided by the Late Night Software Scripting Additions.
All of these examples are stored as Script Debugger scripts or script
applications.

AppleTalk Folder
AppleTalk State

This example displays the current state of the AppleTalk
network.

List File Servers
This example lists the file servers available on your
AppleTalk network.

Files & Folders Folder
Choose File In Preft Folder

This example shows how to use the Set Default Folder and
Get Default Folder commands to control the starting folder
presented by the Choose File command.

Choose New File Example
This short example shows the Choose New File command
in use.

Choose Several Files Example
This short example shows the Choose Several Files
command in use.

Choose Several Folders Example
This short example shows the Choose Several Folders
command in use.

File I0 Example
This example creates a text file and writes a short message
to it using the File IO commands.

File I0 Example II
This example opens a text file and displays the contents of
the file, line by line.
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List Folders
This example uses the Choose Several Folders and the File
IO commands to produce a listing of the files stored in
folders.

Misc. Folder
Quit All Applications

This example illustrates how to use the List Processes, Get
Process and Get Current Process commands to quit all the
non-essential applications running on your Macintosh.

Shutdown
This example illustrates the use of the Shutdown command.

Regular Expressions Folder
Regular Expression Example

This example uses the Regular Expression commands to
modify the names of all the files in a folder (note the file
names are not actually changed).

Regular Expression Example II
This example uses Regular Expression and File IO
commands to read and parse a simple text file.

Resources
Count Resource

This example counts the number of resources in a resource
file.

Enumerate All Resource Types
This example displays all of the resource types in the
current resource file chain.

Get Chosen Printer
This example displays the name of the currently selected
printer.

Remove "ckid" Resources
This droplet script scans a directory tree and removes `ckid'
resources from the files it finds in the directory tree. `ckid'
resources are added to files by Projector/SourceServer.
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Speech Folder
Happy Birthday To You

This example script application sings the happy birthday
song using the various voices installed in your system.

Speak A Text File
This example script application speaks the contents of a file,
line by line.

Libraries
The Libraries folder contains the following AppleScript libraries.

Gestalt Selector Lib
This library defines the Gestalt selectors which are
documented in Inside Macintosh, Volume VI.

Error/Return Codes Lib
This library defines a variety of Macintosh OS error and
return codes.

AppleScript Error Codes Lib
This library defines AppleScript and AppleEvent related
error codes.
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Script Tools 1.3
The Late Night Software Scripting Additions are based on the popular
and award winning Script Tools 1.3 package. I f  you have been using
Script Tools 1.3, you may notice that some of the scripting additions
have changed and some new ones have been added. These new
additions include AppleTalk Control, More Math, List Manipulation,
and Resource IO.

You will also notice that the Choose Folder command has been
removed because it conflicts with Apple's Choose Folder command.
The handler is still in the Choose Files & Folders scripting addition to
provide backward compatiblity with older scripts, but the dictionary
entry has been removed.

AppleScript 1.1 Issues
With the release of AppleScript 1.1, Apple has introduced a number of
new scripting additions which make some Late Night Software
commands obsolete. However, you may continue to use the commands
without fear of conflicting with Apple's new commands.

Now that the Scriptable Finder has been released by Apple, you may
find the functionality provided by some commands is also available
through the Finder. Here too, you may continue to use the scripting
additions without conflicting with the new Finder.
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AppleTalk Control
The AppleTalk Control addition allows your scripts to perform
AppleTalk network management operations. This section describes
each of the AppleScript commands provided in the AppleTalk Control
addition.

Get Zone
The Get Zone command allows you to determine the name of the
AppleTalk zone to which your Macintosh belongs. If your AppleTalk
network has only one zone, the command returns the string "*".

Syntax
get zone

Parameters
None.

Result
None.

Example
s e t  m y Z o n e  t o  g e t  z o n e
i f  m y Z o n e  =  " * "  t h e n

d i s p l a y  d i a l o g  " N o  z o n e s "  b u t t o n s  {  " O K "  }
e l s e

d i s p l a y  d i a l o g  " Z o n e :  "  &  m y Z o n e  b u t t o n s  {  " O K "  }
e n d  i f

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

g e t  z o n e
—> " A R A "

d i s p l a y  d i a l o g  " Z o n e :  A R A "  b u t t o n s  { " O K " }
—> { b u t t o n  r e t u r n e d : " O K " }
e n d  t e l l

Errors
This command can return any of the errors which are returned by the
ToolBox GetMyZone routine. These errors are explained in detail in the
Inside Mac series.
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List Zones
The List Zones command allows you to find the names of all the zones
on your local network.

Syntax
l i s t  zones

Parameters
None.

Result
None.

Example
s e t  l o c a l Z o n e N a m e s  t o  l i s t  z o n e s
d i s p l a y  d i a l o g  " Z o n e s :  "  &  c o u n t  o f  l o c a l Z o n e N a m e s

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

l i s t  z o n e s
—> { " E n g i n e e r i n g 2 " ,  " M a r k e t i n g " ,  " M a r k e t i n g 2 " ,  " R a n d D " ,
" A d m i n " ,  " E n g i n e e r i n g " }

d i s p l a y  d i a l o g  " Z o n e s :  6 "
—> { b u t t o n  r e t u r n e d : " O K " }
e n d  t e l l

Errors
This command can return any of the errors which are returned by the
ToolBox GetLocalZones routine. These errors are explained in detail in
the Inside Mac series.
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List Network Names
The List Network Names command allows you to search for services
available on an AppleTalk network.

Each Macintosh registers a series of names representing the various
network services available on the machine. Other systems query these
registered names to find the network addresses.

Syntax
l i s t  n e t w o r k  names

[ o b j e c t  o b j e c t N a m e  ]
[ t y p e  t y p e N a m e  ]
[ z o n e  z o n e N a m e  ]

Parameters
objectName T h i s  optional parameter specifies the objects to be

found. I f  the parameter is not supplied, all objects are
found.

Wildcard characters (=) may be used to replace portions
of the object name. For example, "=Server" matches any
object name ending in "Server".

typeName T h i s  optional parameter specifies the types of objects to
be found. If the parameter is not supplied, all object
types are found.

Wildcard characters (=) may be used to replace portions
of the type name. For example, "=Server" matches any
object types ending in "Server".

zoneName T h i s  optional parameter specifies the zone to search. If
the parameter is omitted, the current zone is searched.
No wildcard characters are allowed.
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Result
The result of the list network names command is a list of Network
Name classes. Network Name dasses contain the following fields:

atObject T h e  name of an AppleTalk network object

atType T h e  type name of an AppleTalk network object

atZone T h e  zone name of an AppleTalk network object

Example

-  F i n d  a l l  t h e  A p p l e S h a r e  s e r v e r s

l -  i s t  n e t w o r k  n a m e s  t y p e  " A F P S e r v e r "

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

l i s t  n e t w o r k  n a m e s  t y p e  " A F P S e r v e r "
—> { { c l a s s : n e t w o r k  n a m e ,  a t O b j e c t : " p b 1 " ,  a t T y p e : " A F P S e r v e r " ,
a t Z o n e : " * " } ,  { c l a s s : n e t w o r k  n a m e ,  a t O b j e c t : " p f ' s  P o w e r B o o k
1 7 0 " ,  a t T y p e : " A F P S e r v e r " ,  a t Z o n e : " * " } }
e n d  t e l l
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Get Network State
The Get Network State command allows your script to determine if the
network is active.

Syntax
get network s t a t e

Parameters
N o n e .

Result
N o n e .

Example
g e t  n e t w o r k  s t a t e

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

g e t  n e t w o r k  s t a t e
—> n e t w o r k  a c t i v e
end t e l l
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Choose Files and Folders Addition
The Choose Files & Folders addition allows you to prompt the user to
select files and folders in your scripts. This addition builds on the file
prompting capabilities provided by Apple in the AppleScript software.
This section describes each of the AppleScript commands provided in
the Choose Files & Folders addition.

Choose New File
The Choose New File command presents the standard Macintosh new
file selection dialog box (Figure C-2).

Figure C-2
The Choose New File
dialog box

Archive Folder

Select a new archive file:
Testing

o  Hard Disk 234

Syntax
choose new f i l e

[ w i t h  p r o m p t  promptString
[ d e f a u l t  name nameString

( E j e c t

( Desktop

( N e w  M

( C a n c e l

Save

Parameters
promptString

This parameter is a string which is displayed in the dialog
box. If this parameter is omitted, the string "Save As:" is
displayed.

nameString
This parameter is a string which is offered as the default
name for the new file. If this parameter is omitted, no
default name is presented.
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Result
The result of the Choose New File is a record containing three values:

filename returned
This value is a string representing the name of the new file.

folder returned
This value is an alias to the folder where the new file is to
be placed.

replacing
This Boolean value indicates whether or not the new file
replaces an existing file (TRUE = Yes, FALSE = No).

Example
— A s k  t h e  u s e r  f o r  a  n e w  f i l e
s e t  n e w F i l e  t o  c h o o s e  n e w  f i l e

w i t h  p r o m p t  " S e l e c t  a  n e w  a r c h i v e  f i l e : "
d e f a u l t  n a m e  " T e s t i n g "

Outcome:
—> { r e s o u r c e  n a m e : " T e s t i n g " ,  r e p l a c i n g : f a l s e ,  f o l d e r
r e t u r n e d : a l i a s  " H a r d  D i s k  2 3 4 : A r c h i v e  F o l d e r : " }
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Choose Several Files
The Choose Several Files command presents a modified standard file
selection dialog box which allows the user to choose several files at one
time (Figure C-3).

Figure C-3
Choose Several Files
dialog box

Script Debugger 1.0

Ei Default Script
LjDictionary I tems
LID-lamples
LjEntension Scripts
(&-A, Script Debugger
(&-A, Script Debugger.Debug
LjTemplate  Scripts

Select files to be archived:

Open

o  Hard Disk 234

I jp( )

( Desktop

( C a n c e l

( D o n e

Remove

Hard Disk 234:Desktop...r:Script Debugger 1.0

Syntax
choose s e v e r a l  f i l e s

[ w i t h  p r o m p t  promptString
[ o f  t y p e  typeList ]
[ s t a r t i n g  w i t h  fileList ]

Parameters
promptString

This parameter is a string which is displayed in the dialog
box. If you omit the wi th  prompt  parameter, no prompt
is displayed.

typeList T h i s  parameter is a list of strings specifying the file types of
the files to be displayed in the dialog box. Each string is a
four-character code for the file type, such as "TEXT" ,
"APPL", "PICT" or "PNTG". I f  you omit the of t y p e
parameter, all files are displayed. You may specify up to four
file types.
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fileList T h i s  parameter is a list of aliases referring to files which
are to be displayed as already selected. If you omit the
s t a r t i n g  w i t h  parameter, the selected files list is left
empty.

Result
The result is a list of aliases referring to the files selected by the user.

Example
c h o o s e  s e v e r a l  f i l e s

w i t h  p r o m p t  " S e l e c t  f i l e s  t o  b e  a r c h i v e d : "
o f  t y p e  { " A P P L " ,  " a s D F "  }
s t a r t i n g  w i t h - ,

{ a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : "

Outcome:
—> { a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : " }

Choose Several Folders
The Choose Several Folders command presents a modified standard
file selection dialog box allowing the user to choose several folders at
one time (Figure C-4).

Figure C-4
Choose Several Folders
dialog box
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Syntax
choose s e v e r a l  f o l d e r s

[ w i t h  p r o m p t  promptString
[ s t a r t i n g  w i t h  folderList

Parameters
promptString

This parameter is a string which is displayed in the dialog
box. If you omit the wi th  prompt  parameter, no prompt
is displayed.

folderList This parameter is a list of aliases referring to folders which
are to be displayed as already selected. If you omit the
s t a r t i n g  w i t h  parameter, the selected folders list is left
empty.

Result
The result is a list of aliases referring to the folders selected by the user.

Example
c h o o s e  s e v e r a l  f o l d e r

w i t h  p r o m p t  " S e l e c t  f i l e s  t o  b e  a r c h i v e d : "
s t a r t i n g  w i t h

{ a l i a s  " H a r d  D i s k  2 3 4 : S y s t e m  F o l d e r : "
a l i a s  " H a r d  D i s k  2 3 4 : S y s t e m  F o l d e r : E x t e n s i o n s : " }

Outcome:
—> { a l i a s  " H a r d  D i s k  2 3 4 : S y s t e m  F o l d e r : " ,  a l i a s  " H a r d  D i s k
2 3 4 : S y s t e m  F o l d e r : E x t e n s i o n s : " }
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Get Default Folder
The Get Default Folder command returns the current folder used by
the Choose File and Choose Folder commands in this package and
those provided by Apple as part of AppleScript.

Syntax
g e t  c u r r e n t  f o l d e r

Result
This command returns an alias to the current default folder.

Example
s e t  s a v e F o l d e r  t o  g e t  d e f a u l t  f o l d e r
s e t  d e f a u l t  f o l d e r  p a t h  t o  e x t e n s i o n s
c h o o s e  f i l e
s e t  d e f a u l t  f o l d e r  s a v e F o l d e r

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

g e t  d e f a u l t  f o l d e r
—> a l i a s  " M a c O S : S y s t e m  F o l d e r : E x t e n s i o n s : "

p a t h  t o  p r e f e r e n c e s  f o l d e r
—> a l i a s  " M a c O S : S y s t e m  F o l d e r : E x t e n s i o n s : "

s e t  d e f a u l t  f o l d e r  a l i a s  " M a c O S : S y s t e m
F o l d e r : P r e f e r e n c e s : "

c h o o s e  f i l e
—> a l i a s  " M a c O S : S y s t e m  F o l d e r : E x t e n s i o n s : A p p l e S c r i p t ' "

s e t  d e f a u l t  f o l d e r  a l i a s  " M a c O S : S y s t e m  F o l d e r : E x t e n s i o n s : "
e n d  t e l l

NOTE: I f  you have System 7.5 installed, the General Controls control panel
has a setting that allows you to set the folder to which the Open and Save
As commands default. The Choose commands in the example above do
not override the effect of the control panel.
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Set Default Folder
The Set Default Folder command changes the current folder used by
the Choose File and Choose Folder commands in this package and
those provided by Apple as part of AppleScript.

Syntax
s e t  d e f a u l t  f o l d e r  f o l d e r P a t h

Result
This command returns no result.

Parameters
folderPath This parameter is an alias to the folder which is to become

the default folder. If you provide an alias to a file, the folder
containing the file becomes the default folder.

Example
s e t  d e f a u l t  f o l d e r  p a t h  t o  e x t e n s i o n s
c h o o s e  f i l e

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

p a t h  t o  e x t e n s i o n s  f o l d e r
—> a l i a s  " M a c O S : S y s t e m  F o l d e r : E x t e n s i o n s : "

s e t  d e f a u l t  f o l d e r  a l i a s  " M a c O S : S y s t e m  F o l d e r : E x t e n s i o n s : "
c h o o s e  f i l e

—> a l i a s  " M a c O S : S y s t e m  F o l d e r : E x t e n s i o n s : A p p l e S c r i p t ' "
e n d  t e l l

NOTE: Under System 7.5, the Set Default Folder command does not have
any effect.
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File 10 Addition
The File JO addition allows your scripts to perform file operations
directly within your scripts. Using the commands of the File JO
addition, your scripts can move, rename, and delete files. Your scripts
can also read and write text data. This section describes each of the
AppleScript commands provided by the File JO addition.

CloseFile
The closeFile command closes a file previously opened with the
openFile command.

Syntax
c l o s e F i l e  f i l e R e f N u m

Parameters
fileRefNum

This parameter is the reference number of a file. This value
is returned by the Open File command.

Result
None.

Example
s e t  f i l e P a t h  t o  c h o o s e  f i l e

w i t h  p r o m p t  " S e l e c t  a  f i l e  t o  o p e n : "
o f  t y p e  " T E X T "

s e t  r e f N u m  t o  o p e n F i l e  f i l e P a t h  f o r  r e a d i n g
c l o s e F i l e  r e f N u m

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  f i l e  w i t h  p r o m p t  " S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " T E X T "
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E v e n t  L o g "

o p e n F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E v e n t  L o g "  f o r
r e a d i n g
—> 8 7 4 4

c l o s e F i l e  8 7 4 4
e n d  t e l l

Errors
This command can return any of the errors which are returned by the
ToolBox FSClose routine.
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CreateFde
The createFile command creates a new file of type "TEXT".

Syntax
c r e a t e F i l e  f i l e N a m e

[ i n  folder ]
[ o w n e r  signature ]

Parameters
fileName Th is  parameter is the new file's name.

folder T h i s  parameter is an alias to the folder where the new file is
to be placed. If this parameter is omitted, the file is created
in the current default folder.

signature This  parameter is a list of aliases referring to folders which
are to be displayed as already selected. If you omit the
owner parameter, the new file is given the signature

? ? ? ?

Result
None.

Example
s e t  n e w F i l e  t o  c h o o s e  n e w  f i l e

w i t h  p r o m p t  " P i c k  a  n e w  f i l e  n a m e : "

c r e a t e F i l e  ( f i l e n a m e  r e t u r n e d  o f  n e w F i l e )
i n  ( f o l d e r  r e t u r n e d  o f  n e w F i l e )
o w n e r  " t t x t "  —  T e a c h T e x t

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  n e w  f i l e  w i t h  p r o m p t  " P i c k  a  n e w  f i l e  n a m e : "
—> { r e s o u r c e  n a m e : " a  t e x t  f i l e " ,  r e p l a c i n g : f a l s e ,  f o l d e r  r e t u r n e d : a l i a s  " H a r d  D i s k
2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : " }

c r e a t e F i l e  " a  t e x t  f i l e "  i n  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r
1 . 0 : "  o w n e r  " t t x t "
e n d  t e l l

Errors
This command can return any of the errors which are returned by the
ToolBox HCreate routine.
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CreateFolder
The createFolder command creates a new folder.

Syntax
c r e a t e F o l d e r  f o l d e r N a m e

[ i n  f o l d e r  ]

Parameters
folderName

This parameter is the new folder's name.

folder T h i s  parameter is an alias to a folder where the new folder is
to be placed. If this parameter is omitted, the file is created
in the current default folder.

Result
None.

Example
s e t  n e w F o l d e r  t o  c h o o s e  n e w  f i l e

w i t h  p r o m p t  " P i c k  a  n e w  f o l d e r  n a m e : "

c r e a t e F o l d e r  ( f i l e n a m e  r e t u r n e d  o f  n e w F o l d e r )
i n  ( f o l d e r  r e t u r n e d  o f  n e w F o l d e r )

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  n e w  f i l e  w i t h  p r o m p t  " P i c k  a  n e w  f o l d e r  n a m e : "
—> { r e s o u r c e  n a m e : " E m p t y  F o l d e r " ,  r e p l a c i n g : f a l s e ,  f o l d e r  r e t u r n e d : a l i a s  " H a r d
D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : " }

c r e a t e F o l d e r  " E m p t y  F o l d e r "  i n  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t
D e b u g g e r  1 . 0 : "
e n d  t e l l

Errors
This command can return any of the errors which are produced by the
ToolBox DirCreate routine.
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DeleteFile
The deleteFile command deletes a file without placing it in the Trash.

Syntax
d e l e t e F i l e  t h e F i l e

Parameters
theFile

This parameter is an alias referring to the file being deleted.

Result
The result is a list of aliases referring to the folders selected by the user.

Example
c h o o s e  f i l e - ,

w i t h  p r o m p t  " S e l e c t  a  f i l e  t o  b e  d e l e t e d : "
s e t  t r a s h M e  t o  t h e  r e s u l t
d e l e t e F i l e  t r a s h M e

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  s e v e r a l  f i l e s  w i t h  p r o m p t  " S e l e c t  f i l e s  t o  b e  d e l e t e d : "
—> { a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : a  t e x t  f i l e " }

d e l e t e F i l e  { a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : a  t e x t
f i l e " }
e n d  t e l l

Errors
This command can return any of the errors which are returned by the
ToolBox HDelete routine.
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ExchangeFile
The exchangeFile command swaps the data stored in two files.

Syntax
e x c h a n g e F i l e  f i r s t F i l e  w i t h  s e c o n d F i l e

Parameters
firstFile T h i s  parameter is an alias which identifies the first of the

two files.

secondFile This parameter is an alias which identifies the second of the
two files.

NOTE: The two files being exchanged must be on the same disk volume.

Result
None.

Example
e x c h a n g e F i l e  ( c h o o s e  f i l e )  w i t h  ( c h o o s e  f i l e )

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  f i l e
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : B a c k u p "

c h o o s e  f i l e
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E v e n t  L o g "

e x c h a n g e F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : B a c k u p "
w i t h  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E v e n t  L o g "
e n d  t e l l

Errors
This command can return any of the errors which are produced by the
ToolBox PBExchangeFiles routine.
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GetFileLength
The getFileLength command gets the length (in bytes) of the file.

Syntax
g e t F i l e L e n g t h  f i l e R e f N u m

Parameters
fileRefNum

This parameter is the reference number of a file. This value
is returned by the Open File command.

Result
The number of bytes stored in the file.

Example
s e t  f i l e P a t h  t o

c h o o s e  f i l e  w i t h  p r o m p t
" S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " T E X T "

s e t  r e f N u m  t o  o p e n F i l e  f i l e P a t h  f o r  r e a d i n g
— p o s i t i o n  t h e  m a r k e r  a t  t h e  e n d  o f  t h e  f i l e  s o
— d a t a  c a n  b e  a p p e n d e d  t o  t h e  f i l e
g e t F i l e L e n g t h  r e f N u m
c l o s e F i l e  r e f N u m

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  f i l e  w i t h  p r o m p t  " S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " T E X T "
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E v e n t  L o g "

o p e n F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E v e n t  L o g "  f o r
r e a d i n g
—> 8 8 3 8

g e t F i l e L e n g t h  8 8 3 8
—> 2 8 3 7

c l o s e F i l e  8 8 3 8
e n d  t e l l

Errors
This command can return any of the errors which are produced by the
ToolBox GetEOF routine.
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GetFilePosition
The getFilePosition command obtains the current position of a file's
marker. A file marker represents the address within a file where the next
read or write will begin.

Syntax
g e t F i l e P o s i t i o n  f i l e R e f N u m

Parameters
fileRefNum

This parameter is the reference number of a file. This value
is returned by the Open File command.

Result
The result is a number representing the address of the file's marker.

Example
s e t  f i l e P a t h  t o

c h o o s e  f i l e  w i t h  p r o m p t
" S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " T E X T "

s e t  r e f N u m  t o  o p e n F i l e  f i l e P a t h  f o r  r e a d i n g
g e t F i l e L e n g t h  r e f N u m
p o s i t i o n F i l e  r e f N u m  a t  ( g e t F i l e L e n g t h  r e f N u m )
g e t F i l e P o s i t i o n  r e f N u m
c l o s e F i l e  r e f N u m

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  f i l e  w i t h  p r o m p t  " S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " T E X T "
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E v e n t  L o g "

o p e n F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E v e n t  L o g "  f o r
r e a d i n g
—> 7 8 0 4

g e t F i l e L e n g t h  7 8 0 4
—> 2 8 3 7

p o s i t i o n F i l e  7 8 0 4  a t  2 8 3 7
—> 2 8 3 7

g e t F i l e P o s i t i o n  7 8 0 4
—> 2 8 3 7

c l o s e F i l e  7 8 0 4
e n d  t e l l

Errors
This command can return any of the errors which are produced by the
ToolBox GetFPos routine.
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LengthenFile
You can use the lengthenFile command to shorten or extend the size of
a file. Note that you must open the file for writing to lengthen or
shorten a file.

Syntax
l e n g t h e n F i l e  f i l e R e f N u m  l e n g t h  f i l e L e n g t h

Parameters
fileRefNum

This parameter is the reference number of a file. This value
is returned by the Open File command.

fileLength This parameter is the new length of the file.

Result
None.

Example
s e t  f i l e P a t h  t o

c h o o s e  f i l e  w i t h  p r o m p t
" S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " T E X T "

s e t  r e f N u m  t o  o p e n F i l e  f i l e P a t h  f o r  w r i t i n g
— e m p t y  t h e  c o n t e n t s  o f  a  f i l e
l e n g t h e n  f i l e  r e f N u m  l e n g t h  0
c l o s e F i l e  r e f N u m

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  f i l e  w i t h  p r o m p t  " S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " T E X T "
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E v e n t  L o g "

o p e n F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E v e n t  L o g "  f o r
w r i t i n g
—> 8 8 3 8

l e n g t h e n F i l e  8 8 3 8  l e n g t h  0
c l o s e F i l e  8 8 3 8

e n d  t e l l
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MoveFile
The moveFile command moves a file or a folder from one folder to
another.

Syntax
m o v e F i l e  f i l e O r F o l d e r  t o  d e s t i n a t i o n

Parameters
fileOrFolder

This parameter is an alias which identifies the file or folder
being moved.

destination
This parameter is an alias referring to the destination folder
for fileOrFolder.

NOTE: The file or folder being moved must be on the same disk volume as
the destination.

Result
None.
NOTE: The file or folder being moved and the destination folder must be on
the same volume.

Example
m o v e F i l e  (  c h o o s e  f i l e  )  t o  (  c h o o s e  f o l d e r  )

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  f i l e
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : B a c k u p "

c h o o s e  f o l d e r
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E m p t y  F o l d e r : "

m o v e F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : B a c k u p "  t o
a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E m p t y  F o l d e r : "
e n d  t e l l

Errors
This command can return any of the errors which are produced by the
ToolBox PBCatMove routine.
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OpenFile
The openFile command opens a text file for reading and/or
writing. This command, when used with the readLine and writeLine
commands, allows you to process text files within scripts without the
aid of a scriptable text editor application.

Syntax
o p e n F i l e  f i l e

[ f o r  r e a d i n g l u p d a t e l w r i t i n g  ]

Parameters
file T h i s  parameter is an alias to the file which is to be opened.

Result
The result is a file reference number. You must provide this number to
all other commands that you issue when processing the file.

Example
s e t  f i l e P a t h  t o

c h o o s e  f i l e  w i t h  p r o m p t
" S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " T E X T "

s e t  r e f N u m  t o  o p e n F i l e  f i l e P a t h  f o r  r e a d i n g
c l o s e F i l e  r e f N u m

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  f i l e  w i t h  p r o m p t  " S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " T E X T "
—> a l i a s  " H a r d  D i s k  2 3 4 : S c r i p t  D e b u g g e r  M a n u a l : S D  e r r o r  m e s s a g e e s "

o p e n F i l e  a l i a s  " H a r d  D i s k  2 3 4 : S c r i p t  D e b u g g e r  M a n u a l : S D  e r r o r  m e s s a g e e s "  f o r
r e a d i n g
—> 9 0 2 6

c l o s e F i l e  9 0 2 6
e n d  t e l l

NOTE: When the optional f o r  is not specified, the file is opened for
update.

NOTE: Be careful to ensure you close all the files you open. Due to the
nature of AppleScript additions, the Open File command does not ensure
the file is closed when a script aborts without first closing the file with the
Close File command.

Errors
This command can return any of the errors which are returned by the
ToolBox HOpen routine.
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PositionFile
The positionFile command changes the current position of a file's
marker. A file marker represents the address within a file where the next
read or write will begin.

Syntax
p o s i t i o n F i l e  f i l e R e f N u m  a t  f i l e P o s i t i o n

Parameters
fileRefNum

This parameter is the reference number of a file. This value
is returned by the Open File command.

filePosition
This parameter is the new address for the file's marker.

Result
None.

Example
s e t  f i l e P a t h  t o

c h o o s e  f i l e  w i t h  p r o m p t
" S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " T E X T "

s e t  r e f N u m  t o  o p e n F i l e  f i l e P a t h  f o r  r e a d i n g
— p o s i t i o n  t h e  m a r k e r  a t  t h e  e n d  o f  t h e  f i l e  s o
— d a t a  c a n  b e  a p p e n d e d  t o  t h e  f i l e
p o s i t i o n F i l e  r e f N u m  a t  ( g e t F i l e L e n g t h  r e f N u m )
c l o s e F i l e  r e f N u m

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  f i l e  w i t h  p r o m p t  " S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " T E X T "
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E v e n t  L o g "

o p e n F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E v e n t  L o g "  f o r
r e a d i n g
—> 8 8 3 8

g e t F i l e L e n g t h  8 8 3 8
—> 2 8 3 7

p o s i t i o n F i l e  8 8 3 8  a t  2 8 3 7
—> 2 8 3 7

c l o s e F i l e  8 8 3 8
e n d  t e l l

Errors
This command can return any of the errors which are produced by the
ToolBox SetFPos routine.
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ReadLine
The readLine command reads a "line" of text from a file opened with the
openFile command. A line in this case means all characters up to the next
carriage return in the file. This is referred to as a paragraph in some
applications since these lines may wrap around a number of times when
displayed in a window.

Syntax
r e a d L i n e  f i l e R e f N u m

[maximum l e n g t h  m a x L e n g t h ]

Parameters
fileRefNum This parameter is the reference number of a file. This value is

returned by the openFile command.

maxLength This integer parameter specifies the maximum number of
characters you wish to read. Normally, the readFile command
reads a maximum of 1024 characters. The practical maximum
for this value is limited only by the memory available.

Result
The command returns a string representing the data from the file.

Example
s e t  m y F i l e  t o  c h o o s e  f i l e

w i t h  p r o m p t  " S e l e c t  a  t e x t  f i l e : "
o f  t y p e  " T E X T "

s e t  r e f N u m  t o  o p e n F i l e  m y F i l e
s e t  i n p u t L i n e  t o  r e a d L i n e  r e f N u m
d i s p l a y  d i a l o g  i n p u t L i n e
c l o s e F i l e  r e f N u m

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  f i l e  w i t h  p r o m p t  " S e l e c t  a  t e x t  f i l e : "  o f  t y p e  " T E X T "
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E v e n t  L o g "

o p e n F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E v e n t  L o g "
—> 9 3 0 8

r e a d L i n e  9 3 0 8
—> " t e l l  a p p l i c a t i o n  \ " F i n d e r \ " "

d i s p l a y  d i a l o g  " t e l l  a p p l i c a t i o n  \ " F i n d e r \ " "
—> { b u t t o n  r e t u r n e d : " O K " }

c l o s e F i l e  9 3 0 8
e n d  t e l l

Errors
This command can return any of the errors which are returned by the
ToolBox PBRead routine.
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RenameFile
The renameFile command changes a file's name.

Syntax
r e n a m e F i l e  f i l e  t o  newName

Parameters
file T h i s  parameter is an alias which identifies the file whose

name is being changed.

newName This parameter is a text string containing the file's new
name.

Result
None.

Example
r e n a m e F i l e  (  c h o o s e  f i l e  )  t o  " B a c k u p "

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

choose f i l e
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E v e n t  L o g "

r e n a m e F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E v e n t  L o g "  t o
"Backup"
end t e l l

Errors
This command can return any of the errors which are produced by the
ToolBox PBHRename routine.
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WriteLine
The writeLine command writes a line to a text file.

Syntax
w r i t e L i n e  f i l e R e f N u m  t e x t  d a t a

Parameters
fileRefNum

This parameter is the reference number of a file. This value
is returned by the openFile command.

data T h i s  parameter is the line of text to be written to the file.

Result
None.

Example
s e t  m y F i l e  t o

c h o o s e  f i l e  w i t h  p r o m p t  " S e l e c t  a  t e x t  f i l e : "  o f  t y p e
" T E X T "
s e t  r e f N u m  t o  o p e n F i l e  m y F i l e
w r i t e L i n e  r e f N u m  t e x t  " h e l l o "
c l o s e F i l e  r e f N u m

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  f i l e  w i t h  p r o m p t  " S e l e c t  a  t e x t  f i l e : "  o f  t y p e  " T E X T "
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E v e n t  L o g "

o p e n F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E v e n t  L o g "
—> 9 3 0 8

w r i t e L i n e  9 3 0 8  t e x t  " h e l l o "
c l o s e F i l e  9 3 0 8

e n d  t e l l

Errors
This command can return any of the errors which are returned by the
ToolBox FSWrite routine.
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WriteString
The writeString command writes a string of text to a file. This
command differs from writeLine in that it does not add a new-line
character to the end of the text you write.

Syntax
w r i t e S t r i n g  f i l e R e f N u m  t e x t  d a t a

Parameters
fileRefNum

This parameter is the reference number of a file. This value
is returned by the openFile command.

data T h i s  parameter is the line of text to be written to the file.

Result2
None.

Example
s e t  m y F i l e  t o

c h o o s e  f i l e  w i t h  p r o m p t  " S e l e c t  a  t e x t  f i l e : "  o f  t y p e  " T E X T "
s e t  r e f N u m  t o  o p e n F i l e  m y F i l e
w r i t e S t r i n g  r e f N u m  t e x t  " h e l l o "
c l o s e F i l e  r e f N u m

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  f i l e  w i t h  p r o m p t  " S e l e c t  a  t e x t  f i l e : "  o f  t y p e  " T E X T "
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E v e n t  L o g "

o p e n F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : E v e n t  L o g "
—> 9 3 0 8

w r i t e S t r i n g  9 3 0 8  t e x t  " h e l l o "
c l o s e F i l e  9 3 0 8

e n d  t e l l

Errors
This command can return any of the errors which are returned by the
ToolBox FSWrite routine.
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Find Application
The Find Application addition allows you to determine the application
which owns a file.

findApplication
The findApplication command allows you to find the application
which owns a file.

Syntax
f i n d A p p l i c a t i o n  s i g n a t u r e  o n  v o l u m e N a m e

[ i n d e x  a p p i n d e x  ]

Parameters
signature This  parameter is a four-character string representing an

application signature. The findApplication command
locates the application with this signature.

volumeName
This parameter specifies the name of the disk volume to
search.

appIndex This  optional parameter specifies which version of the
application to find. If you omit this parameter, the
findApplication command returns the version of the
application with the most recent creation date.

This parameter is only useful if you keep multiple copies of
application files on your disk.

Result
The result of the findApplication command is an application file
corresponding to the signature specified.

Example
f i n d  a p p l i c a t i o n  " a s D B "  o n  " H a r d  D i s k  2 4 5 : "

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

f i n d  a p p l i c a t i o n  " a s D B "  o n  " H a r d  D i s k  2 4 5 : "
—> f i l e  " H a r d  D i s k  2 4 5 : S c r i p t  D e b u g g e r  1 . 0 : S c r i p t  D e b u g g e r "
e n d  t e l l
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Gestalt Addition
The Gestalt addition allows you to determine the services available on
the Macintosh running your scripts. This section describes each of the
Gestalt commands provided by the Get Gestalt addition.

Get Gestalt
The Get Gestalt command gets information about the operating
environment.

Syntax
g e t  g e s t a l t  s e l e c t o r  ]

[ b i t  b i t N u m b e r  ]
[ w i t h / w i t h o u t  r e p o r t  m i s s i n g  s e l e c t o r s

Parameters
selector T h i s  parameter is a string representing the type of operating

environment information you want. This parameter must
be a four-character code. The gestalt Selectors Lib file
defines all of the Gestalt selectors documented in Inside
Macintosh, volume VI, as well as selectors for Apple's Speech
Manager.

bitNumber
This optional parameter defines which bit of the selectors
value to test. If this parameter is specified, the command
returns a Boolean value. If the parameter is omitted, the
command returns the entire selector value.

Result
The result of this command is either the selector's integer value when
the bit parameter is not specified or a Boolean value when the bit
parameter is specified.

NOTE: When the optional with r e p o r t  m i s s i n g  s e l e c t o r s  is
specified, the Get Gestalt command reports errors associated with un-
known selectors. Otherwise, a value of 0 is returned.
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Example
— v e r i f y  t h a t  t h e  Speech  M g r  i s  p r e s e n t

p r o p e r t y  g e s t a l t S p e e c h A t t r  :  " t t s c "
p r o p e r t y  g e s t a l t S p e e c h M g r P r e s e n t  :  0

i f  g e t  g e s t a l t  g e s t a l t S p e e c h A t t r  - .
b i t  g e s t a l t S p e e c h M g r P r e s e n t  t h e n

d i s p l a y  d i a l o g  " S p e e c h  M g r  P r e s e n t "
e l s e

d i s p l a y  d i a l o g  " S p e e c h  M g r  M i s s i n g "
end i f

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

g e t  g e s t a l t  " t t s c "  b i t  0
—> t r u e

d i s p l a y  d i a l o g  " S p e e c h  M g r  P r e s e n t "
—> { b u t t o n  r e t u r n e d : " O K " }
end t e l l
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List Manipulation
The List Manipulation scripting addition has commands that let you
manipulate lists quickly. Its commands allow you to find the difference,
intersection or union of two lists.

Difference of
The Difference of command compares two lists and produces a list
which contains the differences of the two lists. In other words, it
produces a list of items which the two lists do not have in common.

Syntax
d i f f e r e n c e  o f  l i s t l  a n d  l i s t 2

Parameters
list/ A  list of items.

list2 A  second list that you compare to the first list.

Result
The result of this command is a list containing the items that are not
common to both lists.

Example
s e t  t h e D i f f e r e n c e  t o  d i f f e r e n c e

o f  { 1 ,  5 ,  1 0 ,  " t h i s  i s  a  t e s t " ,  4 }
a n d  { 4 ,  2 ,  " h i  t h e r e " ,  " t h i s  i s  a  t e s t " ,  1 }

Outcome:
—> { " h i  t h e r e " ,  2 ,  5 ,  1 0 }
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Intersection of
The Intersection of command compares two lists and produces a list
which contains the intersection of the two lists. In other words, it
produces a list of items which both lists have in common.

Syntax
i n t e r s e c t i o n  o f  l i s t l  a n d  l i s t 2

Parameters
list/ A  list of items.

list2 A  second list that you compare to the first list.

Result
The result of this command is a list containing the items common to
both lists.

Example
s e t  t h e I n t e r s e c t i o n  t o  i n t e r s e c t i o n - ,

o f  { 1 ,  5 ,  1 0 ,  " t h i s  i s  a  t e s t " ,  4 }
a n d  { 4 ,  2 ,  " h i  t h e r e " ,  " t h i s  i s  a  t e s t " ,  1 }

Outcome:
—> { " t h i s  i s  a  t e s t " ,  1 ,  4 }
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Union of
The Union of command compares two lists and produces a list which
contains all of the unique items of the two lists. This command is
useful when you are trying to merge the contents of two lists quickly. It
saves you the trouble of comparing each item in the two separate lists
and then creating a third, unique list.

Syntax
un ion  o f  l i s t /  a n d  l i s t 2

Parameters
list/ A  list of items.

list2 A  second list that you compare to the first list.

Result
The result of this command is a list containing all of the unique items
in the two lists. It is a merged list.

Example
s e t  t h e U n i o n  t o  u n i o n - ,

o f  { 1 ,  5 ,  1 0 ,  " t h i s  i s  a  t e s t " ,  4 } - ,
a n d  { 4 ,  2 ,  " h i  t h e r e " ,  " t h i s  i s  a  t e s t " ,  1 }

Outcome:
—> { " h i  t h e r e " ,  " t h i s  i s  a  t e s t " ,  1 ,  2 ,  4 ,  5 ,  1 0 }

150 A p p e n d i x  C



Õ"Æ$%¨$'( flºº$¨$±'- ÔÎÔ

”±Æª ”ø¨( flºº+¨+±,
Ã$ª ”±Æª ”ø¨$ ø,º ”±Æª ”ø¨$ ÍËËËÔ øºº0¨0±,1 ø¥¥±© ß±´Æ 16Æ07¨1 ¨±

7ªÆ8±Æ9 9ø¨$ª9ø¨06ø¥ ±7ªÆø¨0±,1Ú Ã$01 1ª6¨0±, ºª16Æ0æª1 ªø6$ ±8 ¨$ª
fl77¥ªÕ6Æ07¨ 6±99ø,º1 7Æ±™0ºªº æß ¨$ª ”±Æª ”ø¨$ ø,º ”±Æª ”ø¨$

ÍËËËÔøºº0¨0±,Ú Ã$ª Õ6Æ07¨ ‹ªæ´@@ªÆ 0,1¨ø¥¥ªÆ 0,1¨ø¥¥1 ª0¨$ªÆ ¨$ª ”±Æª
”ø¨$ ±Æ ”±Æª ”ø¨$ ÍËËËÔÚ A8 ß±´Æ ”ø60,¨±1$ $ø1 ø 8¥±ø¨0,@ 7±0,¨

ø66ª¥ªÆø¨±ÆÙ ”±Æª ”ø¨$ ÍËËËÔ 01 0,1¨ø¥¥ªºÚ

øæ1 Ã$ª øæ1 6±99ø,º Æª¨´Æ,1 ¨$ª øæ1±¥´¨ª ™ø¥´ª ±8 ø, 0,¨ª@ªÆÚ

Õß#¨ø®Ê
øæ# $'¨ ø¥´ª

ø6±1 Ã$ª ø6±1 6±99ø,º 6±97´¨ª1 ¨$ª øÆ6 6±10,ª ±8 ø ™ø¥´ªÚ

Õß#¨ø®Ê
ø$±# ™ø¥´ª

ø10, Ã$ª ø10, 6±99ø,º 6±97´¨ª1 ¨$ª øÆ6 10,ª ±8 ø ™ø¥´ªÚ

Õß#¨ø®Ê
ø#&' ™ø¥´ª

ø¨ø, Ã$ª ø¨ø, 6±99ø,º 6±97´¨ª1 ¨$ª øÆ6 ¨ø,@ª,¨ ±8 ø ™ø¥´ªÚ

Õß#¨ø®Ê
ø¨ø' ™ø¥´ª

ø¨ø,Ó Ã$ª ø¨ø,Ó 6±99ø,º 6±97´¨ª1 ¨$ª øÆ6 ¨ø,@ª,¨ ±8 ¨$ª Ø´±¨0ª,¨ ±8 ¨©±
™ø¥´ª1Ú

Õß#¨ø®Ê
ø¨ø'Ó ™ø¥´ªÔ ±™ªÆ ™ø¥´ªÓ

6±1 Ã$ª 6±1 6±99ø,º 6±97´¨ª1 ¨$ª 6±10,ª ±8 ø ™ø¥´ªÚ

Õß#¨ø®Ê
$±# ™ø¥´ª

6±1$ Ã$ª 6±1$ 6±99ø,º 6±97´¨ª1 ¨$ª $ß7ªÆæ±¥06 6±10,ª ±8 ø ™ø¥´ªÚ

Õß#¨ø®Ê
$±#- ™ø¥´ª

More Math Addition
The More Math and More Math 68881 additions allow your scripts to
perform mathematical operations. This section describes each of the
AppleScript commands provided by the More Math and More Math
68881addition. The Script Debugger installer installs either the More
Math or More Math 68881. If your Macintosh has a floating point
accelerator, More Math 68881 is installed.

abs

acos

asin

atan

The abs command returns the absolute value of an integer.
Syntax:
abs intValue

The acos command computes the arc cosine of a value.
Syntax:
acos value

The asin command computes the arc sine of a value.
Syntax:
asin value

The atan command computes the arc tangent of a value.
Syntax:
atan value

atan2 T h e  atan2 command computes the arc tangent of the quotient of two
values.
Syntax:
atan2 valuel o v e r  value2

cos

cosh

The cos command computes the cosine of a value.
Syntax:
cos value

The cosh command computes the hyperbolic cosine of a value.
Syntax:
cosh value
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fabs The fabs command calculates the absolute value of a floating point
value.
Syntax:
fabs value

log T h e  log command computes the natural logarithm of a value.
Syntax:
log value

log10 T h e  log10 command computes the base-10 logarithm of a value.
Syntax:
1 og l  0 value

power T h e  power command raises a value to a power.
Syntax:
power value t o  powe

sin

sinh

tan

tanh
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The sin command computes the sign of a value.
Syntax:
s in  value

The sinh command computes the hyperbolic sign of a value.
Syntax:
sinh value

The tan command computes the tangent of a value.
Syntax:
tan value

The tanh command computes the hyperbolic tangent of a value.
Syntax:
tanh value
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Processes
The Processes scripting addition lets you get detailed information
about the applications running on your Macintosh. It has commands
to get the foreground application and currently executing application
as well as any desk accessories and faceless background-only
applications.

List Processes
The List Processes command obtains a list of the names of the
applications running on your Macintosh. This includes normal
Macintosh applications, desk accessories, and faceless-background-
only applications.

Syntax
l i s t  p r o c e s s e s

Parameters
None.

Result
The result is a list of strings representing the names of all the running
applications.

Example
l i s t  p r o c e s s e s

Outcome:

—> { " P o w e r T a l k  M a n a g e r " ,  " F i n d e r " ,  " Q u i c K e y s '  T o o l b o x " ,  " S c r i p t  D e b u g g e r . D e b u g " ,
" M i c r o s o f t  W o r d " ,  " C a n v a s '  3 . 5 " ,  " S c r i p t  D e b u g g e r " }
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Get Process
The Get Process command obtains detailed information about a
running application.

Syntax
g e t  p r o c e s s  p r o c e s s N a m e

Parameters
processName

This parameter specifies the name of the process you want
information about.

Result
The result of the Get Process command is a record containing the
following values:

process name
This string is the name of the process.

process number
This value represents the serial number of the process.
AppleScript translates this value into an application object
automatically.

application type
This string is the application's four-character file type.
Normally this value is "APPL".

signature
This string is the application's four-character signature.

partition size
This integer value represents the amount of memory the
application occupies.

free memory
This integer value represents the amount of free memory
within the application's partition.

launcher
This string is the name of the application which launched
this application. If it's blank, then the application is no
longer running.
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launch date
This integer value represents the date and time when the
application was launched.

active time
This integer value is the amount of CPU time used by the
application since it was launched. The units for this value are
ticks (1/60th of a second).

application file
This value is a reference to the application's file.

deskAccessory
multiLaunch
needSuspendResume
canBackground
activateOnForegroundSwitch
compatible32Bit
onlyBackground
getFrontClicks
getApplicationDiedEvents
highLevelEventAware
localAndRemoteEvents
stationeryAware
use TextEditServices

These Boolean values represent the application's mode flags.

Example
g e t  p r o c e s s  ( f i r s t  i t e m  o f  ( l i s t  p r o c e s s e s ) )

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

l i s t  p r o c e s s e s  c u r r e n t  a p p l i c a t i o n
—> { " F i n d e r " ,  " Q u i c K e y s '  T o o l b o x " ,  " S c r i p t  D e b u g g e r . D e b u g " ,  " M i c r o s o f t  W o r d " ,
" C a n v a s '  3 . 5 " ,  " S c r i p t  D e b u g g e r " }

g e t  p r o c e s s  " F i n d e r "
—> { c l a s s : p r o c e s s  i n f o ,  r e s N a m e : " F i n d e r " ,  p r o c e s s  n u m b e r : a p p l i c a t i o n  " F i n d e r " ,
a p p l i c a t i o n  t y p e : " F N D R " ,  s i g n a t u r e : " M A C S " ,  p a r t i t i o n  s i z e : 3 7 7 8 5 6 ,  f r e e
m e m o r y : 2 0 4 4 4 8 ,  l a u n c h  d a t e : d a t e  " S a t u r d a y ,  M a r c h  4 ,  1 9 9 5  2 : 2 4 : 0 2  P M " ,  a c t i v e
t i m e : 3 2 0 3 2 6 1 ,  a p p l i c a t i o n  f i l e : f i l e  " M a c O S : S y s t e m  F o l d e r : F i n d e r " ,
d e s k D c c e s s o r y : f a l s e ,  m u l t i L a u n c h : f a l s e ,  n e e d S u s p e n d R e s u m e : t r u e ,  c a n B a c k g r o u n d : t r u e ,
a c t i v a t e O n F o r e g r o u n d S w i t c h : t r u e ,  o n l y B a c k g r o u n d : f a l s e ,  g e t F r o n t C l i c k s : t r u e ,
g e t A p p l i c a t i o n D i e d E v e n t s : t r u e ,  c o m p a t i b l e 3 2 B i t : t r u e ,  h i g h L e v e l E v e n t A w a r e : t r u e ,
l o c a l A n d R e m o t e E v e n t s : t r u e ,  s t a t i o n e r y A w a r e : f a l s e ,  u s e T e x t E d i t S e r v i c e s : f a l s e ,
l a u n c h e r : " " }
e n d  t e l l
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Get Foreground Process
The Get Foreground Process command gets the name of the
foreground application. The foreground application is the application
whose windows are presently active. Note that the foreground
application is not necessarily the current application (see the Get
Current Application command).

Syntax
g e t  f o r e g r o u n d  p r o c e s s

Parameters
None.

Result
The result of this command is a string representing the name of the
foreground application.

Example
g e t  f o r e g r o u n d  p r o c e s s

Outcome:
—> " S c r i p t  D e b u g g e r "
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Get Current Process
The Get Current Process command gets the name of the currently
executing application. This command is useful for finding the name of
the process executing a script. The value returned by the Get Current
Process command is different from the value returned by the Get
Foreground Process command when the current process is in the
background.

Syntax
get c u r r e n t  process

Parameters
None.

Result
The result of this command is a string representing the name of the
currently executing application.

Example
g e t  c u r r e n t  p r o c e s s

Outcome:
—> " S c r i p t  D e b u g g e r "
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Regular Expressions Addition
The Regular Expressions addition allows you to perform simple and
complex textual pattern matching within your scripts. This section
describes each of the AppleScript commands provided in the Regular
Expressions addition.

Compile Regular Expression
The Compile Regular Expression command compiles a pattern string.
Compiled Regular Expressions are used by the Match Regular
Expression and Substitute Regular Expression commands.

Syntax
compi le  r e g u l a r  e x p r e s s i o n  p a t t e r n S t r i n g

Parameters
patternString

This parameter is a string which is displayed in the dialog
box. If you omit the wi th  prompt  parameter, no prompt
is displayed.

For a description of the syntax of pattern strings, see the
documentation for the UNIX grep command and the
section More about Regular Expressions below. Information
about Regular Expressions is also available in the THINK C
User's Guide.

Result
The result is a compiled version of the patternString. This compiled
pattern is used with the Match Regular Expression and Substitute
Regular Expression commands.

Example
s e t  p a t t e r n  t o  c o m p i l e

r e g u l a r  e x p r e s s i o n  " ( c a t I d o g ) ( f i s h l f i g h t ) "

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c o m p i l e  r e g u l a r  e x p r e s s i o n  " ( c a t I d o g ) ( f i s h l f i g h t ) "
—> "<nonprintable characters>"
end t e l l
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Errors
Compile Regular Expression returns errors when there is a problem
with the expression being compiled. The error code returned is -50
(paramErr), and the error string contains the actual error. If you want
to capture the actual error text, you could do the following:

t r y
s e t  t h e E x p r  t o  " ( . * ) : ( * ) "
s e t  t h e P a t t e r n  t o  c o m p i l e  r e g u l a r  e x p r e s s i o n  t h e E x p r

o n  e r r o r  e r r M s g
e r r o r  " C a n ' t  c o m p i l e  \ " "  &  t h e E x p r  &  " \ "  -  "  &  e r r M s g

e n d  t r y

Match Regular Expression
The Match Regular Expression command matches a string to a Regular
Expression and returns the portions of the string which match the
regular expression.

Syntax
match r e g u l a r  express ion compiledExpression

t o  c a n d i d a t e S t r i n g

Parameters
compiledExpression

This parameter is a compiled regular expression. This value
is returned by the Compile Regular Expression command.

candidateString
This parameter is the string that is to be matched to the
regular expression.

Result
The result of the Match Regular Expression command is a record
containing the following values:

matched T h i s  Boolean value indicates if there was a match.

match string
This string value represents the largest match found.
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match 1 T h i s  string value represents the portion of the string
matching the first 0 expression.

match 2 T h i s  string value represents the portion of the string
matching the second 0 expression.

match 3 T h i s  string value represents the portion of the string
matching the third 0 expression.

match 4 T h i s  string value represents the portion of the string
matching the fourth 0 expression.

match 5 T h i s  string value represents the portion of the string
matching the fifth 0 expression.

match 6 T h i s  string value represents the portion of the string
matching the sixth 0 expression.

match 7 T h i s  string value represents the portion of the string
matching the seventh 0 expression.

match 8 T h i s  string value represents the portion of the string
matching the eighth 0 expression.

match 9 T h i s  string value represents the portion of the string
matching the ninth 0 expression.

Example
s e t  p a t t e r n  t o

c o m p i l e  r e g u l a r  e x p r e s s i o n  " T h i s  ( . * )  t e s t "
s e t  r e s u l t  t o  m a t c h  r e g u l a r  e x p r e s s i o n  p a t t e r n

t o  " T h i s  i s  a  t e s t "
{ r e s u l t  }

This script compiles a regular expression and then matches it to a
string. It produces a match string and a match:

t e l l  c u r r e n t  a p p l i c a t i o n
c o m p i l e  r e g u l a r  e x p r e s s i o n  " T h i s  ( . * )  t e s t "

—> "<nonprintable characters>"
match r e g u l a r  express ion "<nonprintable chmucters>"

—> { c l a s s : m a t c h  r e p l y ,  m a t c h e d : t r u e ,  m a t c h  s t r i n g : " T h i s  i s  a  t e s t " ,  m a t c h  1 : " i s
a " }
e n d  t e l l
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Substitute Regular Expression
The Substitute Regular Expression command extracts the elements
from a candidate string which match the patterns of a Regular
Expression, and then substitutes the extracted elements into a template
string.

Syntax
s u b s t i t u t e  r e g u l a r  e x p r e s s i o n  c o m p i l e d E x p r e s s i o n

o f  c a n d i d a t e S t r i n g
w i t h  t e m p l a t e S t r i n g

Parameters
compiledExpression

This parameter is a compiled Regular Expression pattern.
Regular Expressions are compiled using the Compile
Regular Expression command.

candidateString
This parameter is a string representing the text which is to
be compared to the Regular Expression, and then modified.

templateString
This parameter is a string representing a template for the
substitutions which are to be performed. See the following
section titled Replacements for Regular Expressions, for a
description of the format of this string.

Result
The result is the substituted string.

Example
s e t  p a t t e r n  t o

c o m p i l e  r e g u l a r  e x p r e s s i o n  " T h i s  ( . * )  t e s t "
s u b s t i t u t e  r e g u l a r  e x p r e s s i o n  p a t t e r n

o f  " T h i s  i s  a  t e s t "  w i t h  " — \ \ 1 — "

Outcome:
— i s  a —

Scripting Additions 1 6 1



ÔÍÓ fl%%ª'º)® ›

Œª#¥ø&ª'ª(¨* ,±Æ Œª/´¥øÆ ¤®#Æª**3±(*
…)¨/)' ø ¨ª1%¥ø¨ª 3¨Æ)'5Ù ¨/ª 7±¥¥±©)'5 :±'™ª'¨)±'3 ø%%¥ßÊ

! fl æø:µ3¥ø3/ Ø´±¨ª3 ¨/ª 7±¥¥±©)'5 :/øÆø:¨ªÆÚ Ã/ª 3%ª:)ø¥ :/øÆø:¨ªÆ3

©)¨/)' ø ¨ª1%¥ø¨ª 3¨Æ)'5 øÆª L˙K ø'º LƒKÂ ¨/ª3ª øÆª ¨/ª ±'¥ß

:/øÆø:¨ªÆ3 ¨/ø¨ 'ªªº ¨± æª Ø´±¨ªºÚ  Ã/ª :±'3¨Æ´:¨ Nƒ˙M %Æ±º´:ª3 ø

3)'5¥ª L˙K ø'º ¨/ª :±'3¨Æ´:¨ NƒƒM %Æ±º´:ª3 ø 3)'5¥ª æø:µ3¥ø3/Ú

! fl' ø1%ªÆ3ø'º ¯˙˜ )'º):ø¨ª3 ¨/ª ª'¨)Æª 1ø¨:/ªº Æª5´¥øÆ ª®%Æª33)±'Ú

⁄±Æ ª®ø1%¥ªÙ ¨/ª Æª%¥ø:ª1ª'¨ N˙˙M ©±´¥º :±'3)3¨ ±7 ¨©± :±%)ª3 ±7

¨/ª 1ø¨:/ªº ª®%Æª33)±'Ú

! Ã/ª 3ªØ´ª':ª Nƒ MÙ ©/ªÆª ' )3 ø 3)'5¥ª º)5)¨Ù )'º):ø¨ª3 ¨/ª ¨ª®¨

1ø¨:/)'5 ¨/ª !¨/ %øÆª'¨/ª3)¶ªº :±1%±'ª'¨ ±7 ¨/ª Æª5´¥øÆ

ª®%Æª33)±'Ú

”±Æª øæ±´¨ Œª/´¥øÆ ¤®#Æª**3±(*
Ã/)3 3ª:¨)±' )3 ¨øµª' ©)¨/ %ªÆ1)33)±' 7Æ±1 –ø´¥ …Ú flæÆø/ø13 ø'º

fiÆ´:ª ŒÚ ‘øÆ3±'K3À“$» '±Æ ¨+ª $-.ø¨0ª!¨ ¯flºº)3±'Û…ª3¥ªßÙ ÔÁÁÓ˜Ù

%%Ú ÎUÛÎÌÚ

fl Œª5´¥øÆ ¤®%Æª33)±' ºª7)'ª3 ø %ø¨¨ªÆ' ±7 ¨ª®¨ ¨± æª 1ø¨:/ªºÚ Ã/ª

ºª7)')¨)±' ±7 ø Æª5´¥øÆ ª®%Æª33)±' /ªÆª )3 ø 3´æÛ3ª¨ ±7 ¨/ª Æª5´¥øÆ

ª®%Æª33)±'3 7±´'º ±' À“Z» ø'º ±¨/ªÆ 3ß3¨ª13Ú

Z' 5ª'ªÆø¥Ù ø'ß :/øÆø:¨ªÆ ø%%ªøÆ)'5 )' ø Æª5´¥øÆ ª®%Æª33)±' 1ø¨:/ª3 ¨/ø¨

:/øÆø:¨ªÆ )' ¨/ª ¨ª®¨Ú ⁄±Æ ª®ø1%¥ªÙ ¨/ª Æª5´¥øÆ ª®%Æª33)±' Nª¥™)3M

1ø¨:/ª3 ¨/ª 3¨Æ)'5 Nª¥™)3MÚ ÿ±©ª™ªÆÙ :ªÆ¨ø)' :/øÆø:¨ªÆ3 øÆª ´3ªº ¨±

3%ª:)7ß ™øÆ)øæ¥ª %ø¨¨ªÆ'3 ø'º øÆª ¨/ªÆª7±Æª 3%ª:)ø¥Ú Z' øºº)¨)±'Ù ±¨/ªÆ

:/øÆø:¨ªÆ3 øÆª 3%ª:)ø¥ ´'ºªÆ %øÆ¨):´¥øÆ :±'º)¨)±'3Ú

Z7 ß±´ ©ø'¨ ¨± ´3ª ø 3%ª:)ø¥ :/øÆø:¨ªÆ )' ø %ø¨¨ªÆ'Ù ß±´ 1´3¨ Ø´±¨ª )¨Ù )'

ª77ª:¨Ù æß ª3:ø%)'5 )¨ ©)¨/ ø %Æª:ªº)'5 æø:µ3¥ø3/ ¯ƒ˜Ú ⁄±Æ ª®ø1%¥ªÙ ¨/ª

Æª5´¥øÆ ª®%Æª33)±' N:/ªø% ø¨ ¸ÁƒÚÁËM 1ø¨:/ª3 ¨/ª 3¨Æ)'5 N:/ªø% ø¨ ÁÚÁËMÚ

ÿªÆª ¨/ª LÚK 'ªªº3 ¨± æª Ø´±¨ªº æ´¨ ¨/ª L¸K º±ª3 '±¨ æª:ø´3ª )¨ )3'K̈  ø¨ ¨/ª

ª'º ±7 ¨/ª 3¨Æ)'5 ø'º ¨/ªÆª7±Æª )3'K̈  3%ª:)ø¥Ú

Replacements for Regular Expressions
Within a template string, the following conventions apply:

■ A  backslash quotes the following character. The special characters
within a template string are ̀ &' and ' \ '; these are the only
characters that need to be quoted. The construct " \  &" produces a
single '&' and the construct "\  \" produces a single backslash.

■ A n  ampersand (&) indicates the entire matched regular expression.
For example, the replacement "&&" would consist of two copies of
the matched expression.

■ T h e  sequence " \n " ,  where n is a single digit, indicates the text
matching the nth parenthesized component of the regular
expression.

More about Regular Expressions
This section is taken with permission from Paul W. Abrahams and
Bruce R. Larson's UNIX for the Impatient (Addison-Wesley, 1992),
pp. 50-53.

A Regular Expression defines a pattern of text to be matched. The
definition of a regular expression here is a sub-set of the regular
expressions found on UNIX and other systems.

In general, any character appearing in a regular expression matches that
character in the text. For example, the regular expression "elvis"
matches the string "elvis". However, certain characters are used to
specify variable patterns and are therefore special. In addition, other
characters are special under particular conditions.

If you want to use a special character in a pattern, you must quote it, in
effect, by escaping it with a preceding backslash ( \ ). For example, the
regular expression "cheap at $9\.98" matches the string "cheap at 9.98".
Here the '.' needs to be quoted but the '$' does not because it isn't at the
end of the string and therefore isn't special.
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ˆ fl -+*,¥ª 2%øÆø2¨ªÆ /±¥¥±©ªº æß ø* ø-¨ªÆ+-µ (ø¨2%ª- ¶ªÆ± ±Æ

(±Æª ±22´ÆÆª*2ª- ±/ ¨%ø¨ 2%øÆø2¨ªÆÚ Õ+(+¥øÆ¥ßÙ ø 1ø¨¨ªÆ* ¨%ø¨

(ø¨2%ª- ø -ª¨ ±/ 2%øÆø2¨ªÆ- /±¥¥±©ªº æß ø* ø-¨ªÆ+-µ (ø¨2%ª-

¶ªÆ± ±Æ (±Æª 2%øÆø2¨ªÆ- /Æ±( ¨%ø¨ -ª¨Ú B* 1øÆ¨+2´¥øÆÙ LˆK

(ø¨2%ª- ø* øÆæ+¨ÆøÆßÙ 1±--+æ¥ß ª(1¨ßÙ -¨Æ+*,Ú  Ã%ª ¥±*,ª-¨

1±--+æ¥ª (ø¨2%+*, -ªØ´ª*2ª +- ø¥©øß- ´-ªºÙ ø¥¨%±´,% ¨%ª

(ø¨2%+*, (ª2%ø*+-( +- 2¥ª™ªÆ ª*±´,% ¨± 2±*-+ºªÆ ¨%ª ©%±¥ª

-¨Æ+*, ©%ª* ¨ª-¨+*, /±Æ ø (ø¨2%Ú ⁄±Æ ª®ø(1¥ªÙ +¨ 2ø* º+-2±™ªÆ

¨%ø¨ N¬øÚˆæÚ(¸M (ø¨2%ª- Nø®ßææ((MÙ ª™ª* ¨%±´,% ¨%+-

(ø¨2% ÆªØ´+Æª- ¨%ø¨ ¨%ª NÚˆM -%±´¥º 2±*-´(ª ¨%ª /+Æ-¨ LæKÙ æ´¨

*±¨ ¨%ª -ª2±*º ±*ªÚ

ı Ã%ª 1¥´- 2%øÆø2¨ªÆ /±¥¥±©+*, ø Æª,´¥øÆ ª®1Æª--+±* (ø¨2%ª- ±*ª

±Æ (±Æª ±22´ÆÆª*2ª- ±/ ¨%ø¨ ª®1Æª--+±*Ú

· Ã%ª Ø´ª-¨+±* (øÆµ 2%øÆø2¨ªÆ /±¥¥±©+*, ø Æª,´¥øÆ ª®1Æª--+±*

(ø¨2%ª- ¶ªÆ± ±Æ ±*ª ±22´ÆÆª*2ª ±/ ¨%ø¨ Æª,´¥øÆ ª®1Æª--+±*Ù +ÚªÚ

+¨ (ø¨2%ª- ø* ±1¨+±*ø¥ Æª,´¥øÆ ª®1Æª--+±*Ú

¸ fl º±¥¥øÆ -+,* ø¨ ¨%ª ª*º ±/ ø* ±´¨ªÆ(±-¨ Æª,´¥øÆ ª®1Æª--+±*

(ø¨2%ª- ¨%ª ª*º ±/ ¨%ª ¥+*ªÚ fl*ß©%ªÆª ª¥-ª +* ø Æª,´¥øÆ

ª®1Æª--+±*Ù +¨ (ø¨2%ª- +¨-ª¥/Ú

¬ fl %ø¨ ø¨ ¨%ª æª,+**+*, ±/ ø* ±´¨ªÆ(±-¨ Æª,´¥øÆ ª®1Æª--+±*

(ø¨2%ª- ¨%ª æª,+**+*, ±/ ø ¥+*ªÚ fl*ß©%ªÆª ª¥-ª +* ø Æª,´¥øÆ

ª®1Æª--+±*Ù +¨ (ø¨2%ª- +¨-ª¥/Ú

The meanings of the special characters are as follows:

\  T h e  backslash quotes the character after it, whether special or
not.

The period matches any single character.

* A  single character followed by an asterisk matches zero or
more occurrences of that character. Similarly, a pattern that
matches a set of characters followed by an asterisk matches
zero or more characters from that set. In particular, `*'
matches an arbitrary, possibly empty, string. The longest
possible matching sequence is always used, although the
matching mechanism is clever enough to consider the whole
string when testing for a match. For example, it can discover
that " A a . *b . c$" matches "axybbcc", even though this
match requires that the " . *" should consume the first 'b', but
not the second one.

+ T h e  plus character following a regular expression matches one
or more occurrences of that expression.

? T h e  question mark character following a regular expression
matches zero or one occurrence of that regular expression, i.e.
it matches an optional regular expression.

$ A  dollar sign at the end of an outermost regular expression
matches the end of the line. Anywhere else in a regular
expression, it matches itself.

A A hat at the beginning of an outermost regular expression
matches the beginning of a line. Anywhere else in a regular
expression, it matches itself.
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! "fl -ª¨ ±0 12øÆø1¨ªÆ- )' -Ø´øÆª æÆø1µª¨- 9ø¨12ª- ø'ß -)';¥ª

12øÆø1¨ªÆ 0Æ±9 ¨2ª -ª¨Ú ⁄±Æ ª®ø9%¥ªÙ N!$±®'ª"M 9ø¨12ª-

ø'ß ±0 ¨2ª 12øÆø1¨ªÆ- ¯ª ) 9 ± ®˜Ú Ã2)- '±¨ø¨)±' )- ª®¨ª'ºªº ø-

0±¥¥±©-Ê

! …)¨2)' ¨2ª -ª¨Ù ¨2ª ±'¥ß 12øÆø1¨ªÆ- ©)¨2 -%ª1)ø¥ 9ªø')';-

øÆª ¯Û " ¬˜Ú fl¥¥ ±¨2ªÆ 12øÆø1¨ªÆ-Ù ª™ª' LƒKÙ -¨ø'º 0±Æ

¨2ª9-ª¥™ª-Ú

! Ã2ª '±¨ø¨)±' !ÔÛ!Ó )'º)1ø¨ª- ¨2ª -ª¨ ±0 flÕ›JJ 12øÆø1¨ªÆ-

Æø';)'; 0Æ±9 !Ô ¨± !ÓÚ  ⁄±Æ ª®ø9%¥ªÙ N!øÛ¶flÛ1¡"M

9ø¨12ª- ø'ß ¥±©ªÆ1ø-ª ±Æ ´%%ªÆ1ø-ª ¥ª¨¨ªÆÙ ±Æ ø'

´'ºªÆ-1±ÆªÚ fl 9)'´- -);' ø¨ ¨2ª æª;)'')'; ±Æ ª'º ±0 ¨2ª

-ª¨ -¨ø'º- 0±Æ )¨-ª¥0Ù 2±©ª™ªÆÙ ¨2)- N!ıÛ"M 9ø¨12ª- ø %¥´-

±Æ ø 9)'´-Ú

! fl Æ);2¨ æÆø1µª¨ ø- ¨2ª 0)Æ-¨ 12øÆø1¨ªÆ ±0 ¨2ª -ª¨ Æª%Æª-ª'¨-

)¨-ª¥0 ø'º º±ª- '±¨ ª'º ¨2ª -ª¨Ú  ¯…)¨2)' ¨2ª -ª¨Ù ø ¥ª0¨

æÆø1µª¨ )- '±¨ -%ª1)ø¥Ú˜ Ã2´- N!"!"M 9ø¨12ª- ø ¥ª0¨

æÆø1µª¨ ±Æ ø Æ);2¨ æÆø1µª¨Ú

! Ã2ª -ªØ´ª'1ª !¬ " 9ø¨12ª- ø'ß 12øÆø1¨ªÆ ¨2ø¨ )- %±¨

)' (ª¨Ú  ¯)' ¨2)- 1ø-ª ø LÛK ±Æ L"K 0±¥¥±©)'; ¨2ª )')¨)ø¥ L¬K

-¨ø'º- 0±Æ )¨-ª¥0Ù ø- øæ±™ªÚ˜  Ã2)- N!¬4ÛÁ"M 9ø¨12ª- ø'ß

12øÆø1¨ªÆ ª®1ª%¨ ø º);)¨Ú

“±¨ª ¨2ø¨ ø -ª¨ ±0 12øÆø1¨ªÆ- 1ø' æª 0±¥¥±©ªº æß ø' ø-¨ªÆ)-µÚ

Ã2´- N!4ÛÁøÛ6"ˆM 9ø¨12ª- ø %±--)æ¥ß ª9%¨ß -ªØ´ª'1ª ±0

12øÆø1¨ªÆ-Ù ªø12 ±0 ©2)12 )- ª)¨2ªÆ ø º);)¨ ±Æ ø ¥ª¨¨ªÆ æª¨©ªª' ø

ø'º 6Ú

§ Ã©± Æª;´¥øÆ ª®%Æª--)±'- -ª%øÆø¨ªº æß L§K 9ø¨12 ø' ±11´ÆÆª'1ª

±0 ª)¨2ªÆ ±0 ¨2ª9Ù ¨2ø¨ )-Ù ¨2ª L§K ±%ªÆø¨±Æ ø1¨- ø- ø' ±ÆÚ

¯ –øÆª'¨2ª-ª- øÆª ´-ªº 0±Æ ;Æ±´%)';Ú ⁄±Æ ª®ø9%¥ªÙ ¨2ª %ø¨¨ªÆ'

N¯:ø¨§º±=˜¯6'?@§6'=@¨˜M  9ø¨12ª- ø'ß ¥)'ª

1±'¨ø)')'; ª)¨2ªÆ N:ø¨6'?@MÙ N:ø¨6'=@¨MÙ Nº±=6'?@M

±Æ Nº±=6'=@¨MÚ

[ se t] A set of characters in square brackets matches any single
character from the set. For example, " [moxie1 " matches
any of the characters (e i m o x). This notation is extended as
follows:

■ W i th in  the set, the only characters with special meanings
are ( - ]  A  ). All other characters, even `V, stand for
themselves.

■ T h e  notation cl-c2 indicates the set of ASCII characters
ranging from a to c2. For example, " [a- zA- Z i  "
matches any lowercase or uppercase letter, or an
underscore. A minus sign at the beginning or end of the
set stands for itself, however, this " [+- l " matches a plus
or a minus.

■ A  right bracket as the first character of the set represents
itself and does not end the set. (Within the set, a left
bracket is not special.) Thus " El El " matches a left
bracket or a right bracket.

■ T h e  sequence [ A set ] matches any character that is not
in set. (in this case a' -' or 1 ' following the initial `A'
stands for itself, as above.) This " E A 0 - 91 " matches any
character except a digit.

Note that a set of characters can be followed by an asterisk.
Thus " E 0 - 9 a - f 1 * "  matches a possibly empty sequence of
characters, each of which is either a digit or a letter between a
and f.
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1 Two regular expressions separated by' I ' match an occurrence
of either of them, that is, the ' I' operator acts as an or.

( Paren theses  are used for grouping. For example, the pattern
" ( ca t  I dog) (  f i sh  I f i g h t  ) "  matches any line
containing either " c a t  f i sh " ,  " c a t  f i g h t " ,  " d o g f i s h "
or " d o g f i g h t " .



Õ"Æ$%¨$'( flºº$¨$±'- ÔÍÎ

ŸÆ±´(ªº ª®(Æª--.±/- øÆª ø¥-± ´-ªº ¨± .ºª/¨.3ß -ª5¨.±/- ±3 ø

-¨Æ./6 ©8.58 øÆª ¨± æª -´æ-¨.¨´¨ªº ©.¨8 ¨8ª Õ´æ-¨.¨´¨ª Œª6´¥øÆ

¤®(Æª--.±/ 5±==ø/ºÚ

• «±´ 5ø/ 3±¥¥±© ø -./6¥ª 58øÆø5¨ªÆÙ ±Æ ø Æª6´¥øÆ ª®(Æª--.±/ ¨8ø¨

ºª/±¨ª- ø -./6¥ª 58øÆø5¨ªÆÙ ©.¨8 ±/ª ±3 ¨8ª 3±¥¥±©./6 3±Æ=-Ê

•"£ •"Ù£ •"Ù%£

ÿªÆª = ø/º / øÆª /±/Û/ª6ø¨.™ª ./¨ª6ªÆ- ¥ª-- ¨8ø/ ÓÎÍÚ  ‘ª¨ Õ æª

¨8ª -ª¨ 5±/¨ø././6 ª.¨8ªÆ ¨8ª -./6¥ª 58øÆø5¨ªÆ ±Æ ¨8ª 58øÆø5¨ªÆ-

¨8ø¨ =ø¨58 ø Æª6´¥øÆ ª®(Æª--.±/Ú

! Ã8ª 3.Æ-¨ 3±Æ= ºª/±¨ª- ª®ø5¨¥ß = ±55´ÆÆª/5ª- ±3 58øÆø5¨ªÆ-

æª¥±/6./6 ¨± ÕÚ

! Ã8ª -ª5±/º 3±Æ= ºª/±¨ª- ø¨ ¥ªø-¨ = ±55´ÆÆª/5ª- ±3

58øÆø5¨ªÆ- æª¥±/6./6 ¨± ÕÚ

! Ã8ª ¨8.Æº 3±Æ= ºª/±¨ª- æª¨©ªª/ = ø/º / ±55´ÆÆª/5ª- ±3

58øÆø5¨ªÆ- æª¥±/6./6 ¨± ÕÚ

⁄±Æ ª®ø=(¥ªÙ N'(ÛÁ+•ÓÙ£M =ø¨58ª- ø -ªØ´ª/5ª

5±/-.-¨./6 ±3 ¨©± ±Æ =±Æª º.6.¨-Ú

Grouped expressions are also used to identify sections of a
string which are to be substituted with the Substitute Regular
Expression command.

You can follow a single character, or a regular expression that
denotes a single character, with one of the following forms:

{m,n}

Here m and n are non-negative integers less than 256. Let S be
the set containing either the single character or the characters
that match a regular expression.

■ T h e  first form denotes exactly m occurrences of characters
belonging to S.

■ T h e  second form denotes at least m occurrences of
characters belonging to S.

■ T h e  third form denotes between m and n occurrences of
characters belonging to S.

For example, " [ 0 - 91 { 2 , } " matches a sequence
consisting of two or more digits.
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Œª#´¥øÆ ¤®+Æª,,-±/ ¤ÆÆ±Æ ”ª,,ø#ª,
Ã-ª Œª/´¥øÆ ¤®$Æª55(±& 57Æ($¨(&/ øºº(¨(±& Æª¨´Æ&5 ªÆÆ±Æ 9ª55ø/ª5 (: (¨

-ø5 $Æ±æ¥ª95 7±9$(¥(&/ ß±´Æ ª®$Æª55(±&Ú Ã-ª :±¥¥±©(&/ 5ª7¨(±&

7±&¨ø(&5 5±9ª ±: ¨-ª ªÆÆ±Æ 9ª55ø/ª5 ¨-ø¨ ß±´ øÆª ¥(µª¥ß ¨± 5ªªÙ ø&º

$Æ±™(ºª5 ß±´ ©(¨- æÆ(ª: ª®$¥ø&ø¨(±&5 ±: ¨-ª 9ª55ø/ª5Ú

¤ÆÆ±ÆÊ Æª'ª®) ¨±± æ,'

«±´ ©(¥¥ 5ªª ¨-(5 ªÆÆ±Æ 9ª55ø/ª (: ¨-ª Æª/´¥øÆ ª®$Æª55(±& (5

¥øÆ/ªÆ ¨-ø& ÌÓµÚ

¤ÆÆ±ÆÊ ±´¨ ±. /)ø1ª

«±´ ©(¥¥ 5ªª ¨-(5 ªÆÆ±Æ 9ª55ø/ª (: ß±´ Æ´& ±´¨ ±: 9ª9±Æß

©-(¥ª ß±´Æ Æª/´¥øÆ ª®$Æª55(±& (5 7±9$(¥(&/Ú

¤ÆÆ±ÆÊ ¨±± 2ø3ß ¯˜

«±´ ©(¥¥ 5ªª ¨-(5 ª®$Æª55(±& (: ß±´ -ø™ª 9±Æª ¨-ø& &(&ª $ø(Æ5

±: $øÆª&¨-ª5ª5 (& ß±´Æ Æª/´¥øÆ ª®$Æª55(±&Ú

¤ÆÆ±ÆÊ ´32ø¨17ªº ¯˜

«±´ ©(¥¥ 5ªª ¨-(5 ªÆÆ±Æ 9ª55ø/ª (: ß±´ º± &±¨ -ø™ª ¨-ª 5ø9ª

&´9æªÆ ±: ¥ª:¨ ø&º Æ(/-¨ $øÆª&¨-ª5ª5 (& ß±´Æ Æª/´¥øÆ

ª®$Æª55(±&Ú

¤ÆÆ±ÆÊ ˆı ±)ªÆø3º 1±´¥º æª ª2)¨ß

fl ı ±Æ ˆ ±$ªÆø¨±Æ 9´5¨ :±¥¥±© ø& ø¨±9Ú ⁄±Æ (&5¨ø&7ªÙ ¨±

9ø¨7- ø&ß &´9æªÆ ±: NøM 7-øÆø7¨ªÆ5Ù ß±´ ©±´¥º ´5ª NøˆM (&

ß±´Æ ª®$Æª55(±&Ú J: ¨-ª NøM (5 9(55(&/Ù ¨-ª ª®$Æª55(±& (5

(&7±9$¥ª¨ª ø&º ©(¥¥ /ª&ªÆø¨ª ø& ªÆÆ±ÆÚ

¤ÆÆ±ÆÊ 3ª/¨ªº ˆ·ı

«±´ ©(¥¥ 5ªª ¨-(5 ªÆÆ±Æ (: ß±´ ´5ª N·ˆM (& ø& ª®$Æª55(±&Ú Ã-ª

ª®$Æª55(±& (5 (&™ø¥(º æª7ø´5ª N·M (5 ø& ±$ªÆø¨±ÆÚ J: ß±´ ©ø&¨

¨± :(&º ø&ß &´9æªÆ ±: N·M 7-øÆø7¨ªÆ5Ù ß±´ ©±´¥º -ø™ª ¨±

ª&¨ªÆ Nƒ·ˆMÚ “±¨ª ¨-ø¨ (& fl$$¥ªÕ7Æ($¨Ù ß±´ -ø™ª ¨± ª57ø$ª ¨-ª

NƒM 7-øÆø7¨ªÆ ø5 Nƒƒ·ˆMÚ

Regular Expression Error Messages
The Regular Expression scripting addition returns error messages if it
has problems compiling your expression. The following section
contains some of the error messages that you are likely to see, and
provides you with brief explanations of the messages.

Error: regexp too big
You will see this error message if the regular expression is
larger than 32k.

Error: out of space
You will see this error message if you run out of memory
while your regular expression is compiling.

Error: too many 0
You will see this expression if you have more than nine pairs
of parentheses in your regular expression.

Error: unmatched 0
You will see this error message if you do not have the same
number of left and right parentheses in your regular
expression.

Error: *+ operand could be empty
A + or * operator must follow an atom. For instance, to
match any number of "a" characters, you would use "a*" in
your expression. If the "a" is missing, the expression is
incomplete and will generate an error.

Error: nested *?+
You will see this error if you use "?*" in an expression. The
expression is invalid because "?" is an operator. If you want
to find any number of "?" characters, you would have to
enter "\?*". Note that in AppleScript, you have to escape the
"\" character as "\\?*".
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¤ÆÆ±ÆÊ $'™ø¥$º 34 Æø'(ª

«±´ ©)¥¥ +ªª ¨.)+ ªÆÆ±Æ )0 ß±´ ´+ª ø3 )3™ø¥)º 6.øÆø6¨ªÆ Æø37ª

)3 ß±´Æ ª®9Æª++)±3Ú ⁄±Æ ª®ø<9¥ªÙ  ¨.ª ª®9Æª++)±3 N?@ÛøBM )+

3±¨ ø ™ø¥)º Æø37ª ±0 6.øÆø6¨ªÆ+Ú

¤ÆÆ±ÆÊ ´'7ø¨"8ªº 34

«±´ ©)¥¥ +ªª ¨.)+ ªÆÆ±Æ <ª++ø7ª )0 ß±´ º± 3±¨ .ø™ª ¨.ª +ø<ª

3´<æªÆ ±0 ¥ª0¨ ø3º Æ)7.¨ æÆø6µª¨+ )3 ß±´Æ Æª7´¥øÆ

ª®9Æª++)±3Ú

¤ÆÆ±ÆÊ ·ıˆ <±¥¥±©- '±¨8$'(

«±´ ©)¥¥ +ªª ¨.)+ ªÆÆ±Æ <ª++ø7ª )0 ß±´ .ø™ª 3±¨ )36¥´ºªº ø3

ª®9Æª++)±3 ¨± Æª9ªø¨Ú Ã.ª ·ıˆ ±9ªÆø¨±Æ+ øÆª Æª9ªø¨)37

±9ªÆø¨±Æ+Ù ø3º ¨.ªß <´+¨ .ø™ª ø3 ª®9Æª++)±3 ¨± Æª9ªø¨Ú ⁄±Æ

)3+¨ø36ªÙ ?@ÛÁBˆ )3º)6ø¨ª+ ø3ß 3´<æªÆ ±0 º)7)¨+Ú

¤ÆÆ±ÆÊ ¨Æø$¥$'( ƒƒ

«±´ ©)¥¥ +ªª ¨.)+ ªÆÆ±Æ <ª++ø7ª )0 ß±´Æ Æª7´¥øÆ ª®9Æª++)±3

6±3¨ø)3+ ¨Æø)¥)37 æø6µ+¥ø+.ª+Ú

¤ÆÆ±ÆÊ $'¨ªÆ'ø¥ º$-ø-¨ªÆ

«±´ ©)¥¥ +ªª ¨.)+ ªÆÆ±Æ <ª++ø7ª )0 ¨.ªÆª )+ ø3 )3¨ªÆ3ø¥ 0ø)¥´Æª

±0 ¨.ª +±0¨©øÆªÚ

Error: invalid 0 range
You will see this error if you use an invalid character range
in your expression. For example, the expression "[0-a]" is
not a valid range of characters.

Error: unmatched 0
You will see this error message if you do not have the same
number of left and right brackets in your regular
expression.

Error: ?+* follows nothing
You will see this error message if you have not included an
expression to repeat. The ?+* operators are repeating
operators, and they must have an expression to repeat. For
instance, [0-9]* indicates any number of digits.

Error: trailing \\
You will see this error message if your regular expression
contains trailing backslashes.

Error: internal disaster
You will see this error message if there is an internal failure
of the software.
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Œª#±´Æ'ª )— flºº-¨-±/
Ã.ª Œª0±´Æ4ª 5— fl%%¥ªÕ4Æ)%¨ øºº)¨)±' ø¥¥±©0 ß±´ ¨± ©Æ)¨ª 04Æ)%¨0

©.)4. =ø')%´¥ø¨ª ¨.ª 4±'¨ª'¨0 ±> Æª0±´Æ4ª >)¥ª0Ú Ã.)0 )'4¥´ºª0 æ±¨.

Æªøº)'A ø'º ©Æ)¨)'A Æª0±´Æ4ª ºø¨øÚ Ã.)0 0ª4¨)±' ºª04Æ)æª0 ªø4. ±> ¨.ª

4±==ø'º0 )' ¨.ª Œª0±´Æ4ª 5— øºº)¨)±'Ú

›flÀÃ%—“ Ê Ã"ª %±''ø)º+ ,Æ±™/ºªº /) ¨"ª Œª+±´Æ%ª 3— øºº/¨/±) %ø) ºø'ø5ª ß±´Æ

7/¥ª+Ù /7 ´+ªº /',Æ±,ªÆ¥ßÚ –¥ªø+ª ª)+´Æª ¨"ø¨ ß±´ 7´¥¥ß ´)ºªÆ+¨ø)º "±©

Æª+±´Æ%ª+ ±,ªÆø¨ª ±) ¨"ª ”ø%/)¨±+" æª7±Æª ß±´ æª5/) ´+/)5 ¨"ª+ª %±'Û

'ø)º+Ú 3) ,øÆ¨/%´¥øÆÙ ß±´ +"±´¥º æª 7ø'/¥/øÆ ©/¨" fl,,¥ªK+ Œª+¤º/¨ ø,,¥/%øÛ

¨/±) ø)º ¨"ª Œª+±´Æ%ª ”ø)ø5ªÆ %"ø,¨ªÆ+ ±7 ¨"ª N3)+/ºª ”ø%/)¨±+"M +ªÆ/ª+

±7 ,´æ¥/%ø¨/±)+ 7Æ±' fl,,¥ª ˙ flºº/+±) …ª+¥ªßÚ

flººŒª#±´Æ'ª
Ã.ª øººŒª0±´Æ4ª 4±==ø'º øºº0 ø 'ª© Æª0±´Æ4ª ¨± ø Æª0±´Æ4ª >)¥ªÚ

Õß$¨ø®
øººŒª%±´Æ)ª  ¨ß-ª  .º  ºø¨ø

/ 0ø1ª  2
/ ©.¨4Ò©.¨4±´¨ -´Æ6ªøæ¥ª 2
/ ©.¨4Ò©.¨4±´¨ -Æ±¨ª)¨ªº 2
/ ©.¨4Ò©.¨4±´¨ -Æª¥±øº 2
/ ©.¨4Ò©.¨4±´¨ ¥±)µªº 2
/ ©.¨4Ò©.¨4±´¨ %ß%¨ª1 4ªø- 2

–øÆø*ª¨ªÆ,

7/¥ªŒª7“´'

Ã.ª øººŒª0±´Æ4ª 4±==ø'º øºº0 ¨.ª 'ª© Æª0±´Æ4ª ¨± ¨.ª

Æª0±´Æ4ª >)¥ª Æª>ªÆÆªº ¨± æß ¨.)0 Æª>ªÆª'4ª '´=æªÆÚ Ã.)0 ™ø¥´ª

)0 Æª¨´Æ'ªº æß ¨.ª ±%ª'Œª0±´Æ4ª⁄)¥ª 4±==ø'ºÚ
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Resource 10 Addition
The Resource IO AppleScript addition allows you to write scripts
which manipulate the contents of resource files. This includes both
reading and writing resource data. This section describes each of the
commands in the Resource IO addition.

CAUTION: The commands provided in the Resource I0 addition can damage your
files, if used improperly. Please ensure that you fully understand how
resources operate on the Macintosh before you begin using these com-
mands. In particular, you should be familiar with Apple's ResEdit applica-
tion and the Resource Manager chapters of the "Inside Macintosh" series
of publications from Apple & Addison Wesley.

AddResource
The addResource command adds a new resource to a resource file.

Syntax
a d d R e s o u r c e  f i l e R e f N u m  t y p e  r e s T y p e  i d  r e s l D  d a t a

r e s D a t a
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name r e s N a m e
w i t h / w i t h o u t
w i t h / w i t h o u t
w i t h / w i t h o u t
w i t h / w i t h o u t
w i t h / w i t h o u t

Parameters
fileRefNum

p u r g e a b l e  ]
p r o t e c t e d  ]
p r e l o a d  ]
l o c k e d  ]
s y s t e m  h e a p  ]

The addResource command adds the new resource to the
resource file referred to by this reference number. This value
is returned by the openResourceFile command.

resType T h i s  parameter specifies the four-character resource type of
the new resource. For example, " P I C T "  , " T E X T "  .

resiD T h i s  parameter specifies the ID of the new resource.

resData T h i s  parameter specifies the data for the new resource.

resName T h i s  optional parameter specifies the ID of the new
resource. If this parameter is omitted, the resource is added
with a blank name.
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purgeable, protected, preload, locked, system heap
These optional parameters allow you to specify values for
their corresponding resource status bits.

Result
None.

Example
s e t  t h e F i l e  t o  c h o o s e  f i l e  o f  t y p e  " r s r c "
s e t  r e s F i l e  t o  o p e n R e s o u r c e F i l e  t h e F i l e
addResource r e s F i l e  o f  t y p e  "TEST"  i d  1 2 8  - .

name - .
" Te s t i n g "  d a t a  " Te s t i n g "

c l o s e R e s o u r c e F i l e  r e s F i l e

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

choose f i l e  o f  t y p e  " r s r c "
—> a l i a s  " H a r d  D i s k  2 4 5 : p f : S c r i p t  D e b u g g e r  M a n u a l : C u r r e n t  D r a f t s : r e s o u r c e  f i l e "

o p e n R e s o u r c e F i l e  a l i a s  " H a r d  D i s k  2 4 5 : p f : S c r i p t  D e b u g g e r  M a n u a l : C u r r e n t
D r a f t s : r e s o u r c e  f i l e "
—> 7 1 4 6

addResource 7 1 4 6  o f  t y p e  "TEST"  i d  1 2 8  name " Te s t i n g "  d a t a  " Te s t i n g "
c l o s e R e s o u r c e F i l e  7 1 4 6

end t e l l

Errors
The addResource command can return any of the error codes provided
by the ResError() toolbox function.
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ChangeResource
The changeResource command changes the data, ID, name or status
flags of a resource in a resource file.

Syntax
c h a n g e R e s o u r c e  f i l e R e f N u m  t y p e  r e s T y p e

i d  r e s l D  I  n a m e  r e s N a m e
d a t a  r e s D a t a  ]
newName newResName ]
newID  n e w R e s l D  ]
w i t h / w i t h o u t  p u r g e a b l e  ]
w i t h / w i t h o u t  p r o t e c t e d  ]
w i t h / w i t h o u t  p r e l o a d  ]
w i t h / w i t h o u t  l o c k e d  ]
w i t h / w i t h o u t  s y s t e m  h e a p  ]

Parameters
fileRefNum

The changeResource command modifies a resource in the
resource file referred to by this reference number. This value
is returned by the openResourceFile and createResourceFile
commands.

resType T h i s  parameter specifies the four-character resource type of
resource you want to change. For example, "P I CT",
" T E X T " .

resiD T h i s  parameter specifies the ID of the resource being
modified. If you specify this parameter, you cannot use the
resName parameter.

resName T h i s  parameter specifies the Name of the resource being
modified. If you specify this parameter, you cannot use the
reslD parameter.

resData T h i s  optional parameter specifies your new data for the
resource being modified. If you do not provide this
parameter, the resources data is not changed.

newResName
This optional parameter specifies a new name for the
resource. If this parameter is omitted, the resource's Name
is not changed.
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newReslD This optional parameter specifies a new ID for the resource.
If this parameter is omitted, the resource's ID is not
changed.

purgeable, protected, preload, locked, system heap
These optional parameters allow you to specify new values
for the resources status bits.

Result
None.

Example
s e t  t h e F i l e  t o  c h o o s e  f i l e  o f  t y p e  " r s r c "
s e t  r e s F i l e  t o  o p e n R e s o u r c e F i l e  t h e F i l e
changeResource r e s F i l e  o f  t y p e  "TEST"  i d  1 2 8  - .

d a t a  "New  D a t a "
c l o s e R e s o u r c e F i l e  r e s F i l e

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

choose f i l e  o f  t y p e  " r s r c "
—> a l i a s  " H a r d  D i s k  2 4 5 : p f : S c r i p t  D e b u g g e r  M a n u a l : C u r r e n t  D r a f t s : r e s o u r c e  f i l e "

o p e n R e s o u r c e F i l e  a l i a s  " H a r d  D i s k  2 4 5 : p f : S c r i p t  D e b u g g e r  M a n u a l : C u r r e n t
D r a f t s : r e s o u r c e  f i l e "
—> 7 1 4 6

changeResource 7 1 4 6  o f  t y p e  "TEST"  i d  1 2 8  d a t a  "New D a t a "
c l o s e R e s o u r c e F i l e  7 1 4 6

end t e l l

Errors
The changeResource command can return any of the error codes
provided by the ResError() toolbox function.
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ChangeStringResource
The changeStringResource command changes the data, ID, name or
status flags of an '  S r e s o u r c e  in a resource file.

Syntax
c h a n g e S t r i n g R e s o u r c e  f i l e R e f N u m

i d  r e s l D  I  n a m e  r e s N a m e
[ d a t a  r e s D a t a  ]
[ newName newResName
[ n e w I D  n e w R e s l D  ]
[ w i t h / w i t h o u t  p u r g e a b l e  ]
[ w i t h / w i t h o u t  p r o t e c t e d  ]
[ w i t h / w i t h o u t  p r e l o a d  ]
[ w i t h / w i t h o u t  l o c k e d  ]
[ w i t h / w i t h o u t  s y s t e m  h e a p  ]

Parameters
fileRefNum

The changeStrResource command modifies a resource in
the resource file referred to by this reference number. This
value is returned by the openResourceFile and
createResourceFile commands.

resiD T h i s  parameter specifies the ID of the S  r e s o u r c e
being modified. If you specify this parameter, you cannot
use the resName parameter.

resName T h i s  parameter specifies the Name of the '  S
resource being modified. If you specify this parameter, you
cannot use the reslD parameter.

resData T h i s  optional parameter specifies your new string for the
resource being modified. If you do not provide this
parameter, the resources data is not changed.

newResName
This optional parameter specifies a new name for the
resource. If this parameter is omitted, the resource's Name
is not changed.

newReslD This optional parameter specifies a new ID for the resource.
If this parameter is omitted, the resource's ID is not
changed.
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purgeable, protected, preload, locked, system heap
These optional parameters allow you to specify new values
for the resources status bits.

Result
None.

Example
s e t  t h e F i l e  t o  c h o o s e  f i l e  o f  t y p e  " r s r c "
s e t  r e s F i l e  t o  o p e n R e s o u r c e F i l e  t h e F i l e
c h a n g e S t r i n g R e s o u r c e  r e s F i l e  i d  1 2 8

d a t a  " N e w  D a t a "
c l o s e R e s o u r c e F i l e  r e s F i l e

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  f i l e  o f  t y p e  " r s r c "
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : j u n k  f i l e "

o p e n R e s o u r c e F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : j u n k  f i l e "
—> 5 7 3 6

c h a n g e S t r i n g R e s o u r c e  5 7 3 6  i d  1 2 8  d a t a  " N e w  D a t a "
c l o s e R e s o u r c e F i l e  5 7 3 6

e n d  t e l l

Errors
The changeStringResource command can return any of the error codes
provided by the ResError() toolbox function.
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CloseResourceFile
The closeResourceFile command closes a resource file which was
previously opened by the openResourceFile command.

Syntax
c l o s e R e s o u r c e F i l e  f i l e R e f N u m

Parameters
fileRefNum

This parameter specifies the reference number of an open
resource file. This value is returned by the openResourceFile
and createResourceFile commands.

Result
None.

Example
s e t  t h e F i l e  t o  c h o o s e  f i l e  o f  t y p e  " r s r c "
s e t  r e s F i l e  t o  o p e n R e s o u r c e F i l e  t h e F i l e
c l o s e R e s o u r c e F i l e  r e s F i l e

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  f i l e  o f  t y p e  " r s r c "
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : j u n k  f i l e "

o p e n R e s o u r c e F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : j u n k  f i l e "
—> 6 6 7 6

c l o s e R e s o u r c e F i l e  6 6 7 6
e n d  t e l l

Errors
The closeResourceFile command can return any of the error codes
provided by the ResError() toolbox function.
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Countl Resources
Use the countlResources command to count the number of resources
of a certain type in a resource file.

Syntax
c o u n t l R e s o u r c e s  f i l e R e f N u m  t y p e  r e s T y p e

Parameters
fileRefNum

This parameter specifies the reference number of an open
resource file. This value is returned by the openResourceFile
and createResourceFile commands.

resType T h i s  parameter is the type code of the resources you want to
count. Specify the type code as a four-character string, for
instance: "PICT" or "TEXT" .

Result
An integer value representing the number of resources of the type
specified in the resource file.

Example
s e t  t h e F i l e  t o  c h o o s e  f i l e  o f  t y p e  " r s r c "
s e t  r e s F i l e  t o  o p e n R e s o u r c e F i l e  t h e F i l e
s e t  n u m R s r c s  t o  c o u n t l R e s o u r c e s  r e s F i l e  o f  t y p e  " P I C T "
c l o s e R e s o u r c e F i l e  r e s F i l e

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  f i l e  o f  t y p e  " r s r c "
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : r e s o u r c e  f i l e "

o p e n R e s o u r c e F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r
1 . 0 : r e s o u r c e  f i l e "
—> 6 4 8 8

c o u n t l R e s o u r c e s  6 4 8 8  o f  t y p e  " P I C T "
—> 0

c l o s e R e s o u r c e F i l e  6 4 8 8
e n d  t e l l

Errors
The countlResources command can return any of the error codes
provided by the ResError() toolbox function.
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Countl ResourceTypes
Use the countlResourceTypes command to count the number of
different types of resources stored in a resource file.

Syntax
c o u n t l R e s o u r c e T y p e s  f i l e R e f N u m

Parameters
fileRefNum

This parameter specifies the reference number of an open
resource file. This value is returned by the openResourceFile
and createResourceFile commands.

Result
An integer value representing the number of different types of
resources stored in the resource file.

Example
s e t  t h e F i l e  t o  c h o o s e  f i l e  o f  t y p e  " r s r c "
s e t  r e s F i l e  t o  o p e n R e s o u r c e F i l e  t h e F i l e
s e t  n u m R s r c T y p e s  t o  c o u n t l R e s o u r c e T y p e s  r e s F i l e
c l o s e R e s o u r c e F i l e  r e s F i l e

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  f i l e  o f  t y p e  " r s r c "
—> a l i a s  " j u n k : r e s o u r c e  f i l e "

o p e n R e s o u r c e F i l e  a l i a s  " j u n k : r e s o u r c e  f i l e "
—> 8 8 3 8

c o u n t l R e s o u r c e T y p e s  8 8 3 8
—> 6

c l o s e R e s o u r c e F i l e  8 8 3 8
e n d  t e l l

Errors
The countlResourceTypes command can return any of the error codes
provided by the ResError() toolbox function.
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CountResources
Use the countResources command to count the number of resources of
a certain type in a chain of resource files.

The Macintosh Resource Manager maintains a chain of open resource
files. The chain is extended each time a new resource file is opened. For
more detailed information about resource file chains, consult the
Resource Manager chapter of Inside Macintosh.

Syntax
c o u n t R e s o u r c e s  f i l e R e f N u m  t y p e  r e s T y p e

Parameters
fileRefNum

This parameter specifies the reference number of the
first resource file to search. This value is returned by the
openResourceFile and createResourceFile commands.

resType T h i s  parameter is the type code of the resources you want to
count. Specify the type code as a four-character string, for
instance: "PICT" or "TEXT" .

Result
An integer value representing the number of resources of the type
specified in the open resource files.

Example
s e t  t h e F i l e  t o  c h o o s e  f i l e  o f  t y p e  " r s r c "
s e t  r e s F i l e  t o  o p e n R e s o u r c e F i l e  t h e F i l e
s e t  n u m R s r c s  t o  c o u n t R e s o u r c e s  r e s F i l e  o f  t y p e  " P I C T "
c l o s e R e s o u r c e F i l e  r e s F i l e

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  f i l e  o f  t y p e  " r s r c "
—> a l i a s  " j u n k : r e s o u r c e  f i l e "

o p e n R e s o u r c e F i l e  a l i a s  " j u n k : r e s o u r c e  f i l e "
—> 8 8 3 8

c o u n t R e s o u r c e s  8 8 3 8  o f  t y p e  " P I C T "
—> 4 2

c l o s e R e s o u r c e F i l e  8 8 3 8
e n d  t e l l

Errors
The countResources command can return any of the error codes
provided by the ResError() toolbox function.
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CountResourceTypes
Use the countResourceTypes command to count the number of
different types of resources stored in a chain of resource files.

The Macintosh Resource Manager maintains a chain of open resource
files. The chain is extended each time a new resource file is opened. For
more detailed information about resource file chains, consult the
Resource Manager chapter of Inside Macintosh.

Syntax
c o u n t R e s o u r c e Ty p e s  f i l e R e f N u m

Parameters
fileRefNum

This parameter specifies the reference number of an open
resource file. This value is returned by the openResourceFile
and createResourceFile commands..

Result
An integer value representing the number of different types of
resources stored in the resource file.

Example
s e t  t h e F i l e  t o  c h o o s e  f i l e  o f  t y p e  " r s r c "
s e t  r e s F i l e  t o  o p e n R e s o u r c e F i l e  t h e F i l e
s e t  n u m R s r c T y p e s  t o  c o u n t l R e s o u r c e T y p e s  r e s F i l e
c l o s e R e s o u r c e F i l e  r e s F i l e

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  f i l e  o f  t y p e  " r s r c "
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : r e s o u r c e  f i l e "

o p e n R e s o u r c e F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : r e s o u r c e  f i l e "
—> 8 8 3 8

c o u n t l R e s o u r c e T y p e s  8 8 3 8
—> 6

c l o s e R e s o u r c e F i l e  8 8 3 8
e n d  t e l l

Errors
The count ResourceTypes command can return any of the error codes
provided by the ResError() toolbox function.
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CreateResourceFile
The createResourceFile command creates a new resource file.

Syntax
c r e a t e R e s F i l e  f i l e N a m e

[ i n  f o l d e r  ]
[ o w n e r  s i g n a t u r e  ]
[ f i l e t y p e  t y p e  ]

Parameters
fileName Th is  parameter is the new file's name.

folder T h i s  parameter is an alias to the folder where the new file is
to be placed. If this parameter is omitted, the file is created
in the current default folder.

signature This  parameter defines the application signature code of the
new file. Specify this value as a four-character string such as
"MSWD" o r  "RSED".

If you omit this parameter, the new file is given the
signature code "? ? ? ?". The Finder uses this information
to link the file to the application which can open it.

type

Result
None.

This parameter defines the file type code of the new
file. Specify this value as a four-character string such as
"TEXT"  o r  " P I C T " .

If you omit the owner parameter, the new file is given the
file type code "? ?? ?".

Example
s e t  n e w F i l e  t o  c h o o s e  n e w  f i l e

w i t h  p r o m p t  " P i c k  a  n e w  f i l e  n a m e : "

c r e a t e R e s o u r c e F i l e  ( f i l e n a m e  r e t u r n e d  o f  n e w F i l e )
i n  ( f o l d e r  r e t u r n e d  o f  n e w F i l e )
o w n e r  " R S E D "  —  R e s E d i t
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Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  n e w  f i l e  w i t h  p r o m p t  " P i c k  a  n e w  f i l e  n a m e : "
—> { r e s o u r c e  n a m e : " j u n k  f i l e " ,  r e p l a c i n g : f a l s e ,  f o l d e r  r e t u r n e d : a l i a s  " H a r d  D i s k
2 3 4 : D e s k t o p  F o l d e r : " }

c r e a t e R e s o u r c e F i l e  " j u n k  f i l e "  i n  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : "
s i g n a t u r e  " R S E D "
e n d  t e l l

Errors
This command can return any of the errors which are returned by the
toolbox ResError routine.

Getl IndexedResource
The getllndexedResource command allows you to read a resource of a
given type by index rather than ID or name. The getllndexedResource
command indexes through all the resources of the type specified in a
single resource file. If you want to index through the resources in a
chain of resource files, see the getlndexedResource command.

This command is useful if you do not know the names or IDs of the
resources you want to access. Also, when combined with the
countResources command, you can use the getllndexedResource
command to read all of the resources of a given type.

Syntax
g e t l l n d e x e d R e s o u r c e  f i l e R e f N u m

t y p e  r e s T y p e  i n d e x  r e s l n d e x
[ a s  d a t a T y p e  ]

Parameters
fileRefNum

This parameter specifies the reference number of an open
resource file. This value is returned by the openResourceFile
and createResourceFile commands.

resType T h i s  parameter specifies the type of resource you want to
read. Specify resource types as four-character strings such as
" P I C T "  o r  " T E X T " .

resIndex T h i s  parameter specifies the index of the resource you want
to read. The value of this parameter must be in the range of
1 to the value returned by Count1Resources for resType.
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data7j/pe This  parameter allows you to control the data type
applied to the resource data. For instance, you can use this
parameter to have your resource data treated as a string,
picture, number or any other type of information.

Result
The result of this command is a Resource class. See the Resource Class
sub-section below for more information.

Example
s e t  f i l e P a t h  t o

choose f i l e  w i t h  p r o m p t
" S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " r s r c "

s e t  r e s F i l e  t o  o p e n R e s o u r c e F i l e  f i l e P a t h  f o r  r e a d i n g
s e t  numRsrcs  t o  c o u n t l R e s o u r c e s  r e s F i l e  o f  t y p e  " P I C T "
s e t  t h e P I C Ts  t o  { }
r e p e a t  w i t h  i  f r o m  1  t o  numRsrcs

s e t  t h e P I C Ts  t o  t h e P I C Ts  &
{ g e t l l n d e x e d R e s o u r c e  r e s F i l e  o f  t y p e  " P I C T "  i n d e x

end r e p e a t
c l o s e R e s o u r c e F i l e  r e s F i l e

Outcome:

i }

t e l l  c u r r e n t  a p p l i c a t i o n
choose f i l e  w i t h  p r o m p t  " S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " r s r c "

—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : r e s o u r c e  f i l e "
o p e n R e s o u r c e F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : r e s o u r c e  f i l e "  f o r  r e a d i n g

—> 9 2 1 4
c o u n t l R e s o u r c e s  9 2 1 4  o f  t y p e  " P I C T "

—> 1
g e t l I n d e x e d R e s o u r c e  9 2 1 4  o f  t y p e  " P I C T "  i n d e x  1

—> { c l a s s : r e s o u r c e ,  r e s T y p e : " P I C T " ,  r e s I D : 1 2 8 ,  r e s N a m e : " " ,  r e s D a t a : « d a t a
****OADC000000000022002CFOCOOF2C0000000000988034016100BA0183000000000000004E0000...
ECFAOOFEFFED000BF20001FOOFBF10001F9FFFD008F00000F9FE30002CD0002CD0002CD00000OFF3.,
r e s P u r g e a b l e : f a l s e ,  r e s P r e l o a d : f a l s e ,  r e s P r o t e c t e d : f a l s e ,  r e s L o c k e d : f a l s e ,
r e s S y s t e m H e a p : f a l s e }

c l o s e R e s o u r c e F i l e  9 2 1 4
end t e l l

Errors
This command can return any of the errors which are returned by the
ResError() toolbox routine.
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Ÿª¨Ô1'ºª®ªºŒª3±´Æ7ªÃß%ª ø¥¥±©3 ß±´ ¨± ø77ª33 ¨.ª ¨ß%ª 7±ºª3 ø™ø)¥øæ¥ª

)' ø 3)'/¥ª Æª3±´Æ7ª >)¥ªÚ 1> ß±´ ©ø'¨ ¨± ø77ª33 ¨ß%ª 7±ºª3 )' ø 7.ø)' ±>

Æª3±´Æ7ª >)¥ª3Ù 3ªª ¨.ª /ª¨1'ºª®ªºŒª3±´Æ7ªÃß%ª 7±99ø'ºÚ

Õß#¨ø®
!ª¨Ô%&ºª®ªºŒª*±´Æ.ªÃß1ª  3&ºª® 

–øÆø)ª¨ªÆ+

!"¥ªŒª!“´(

Ã.)3 %øÆø9ª¨ªÆ 3%ª7)>)ª3 ¨.ª Æª>ªÆª'7ª '´9æªÆ ±> ø' ±%ª'

Æª3±´Æ7ª >)¥ªÚ Ã.)3 ™ø¥´ª )3 Æª¨´Æ'ªº æß ¨.ª ±%ª'Œª3±´Æ7ª⁄)¥ª

ø'º 7Æªø¨ªŒª3±´Æ7ª⁄)¥ª 7±99ø'º3Ú

¨ß+ª,-ºª® Ã.)3 %øÆø9ª¨ªÆ 3%ª7)>)ª3 ¨.ª )'ºª® ±> ¨.ª Æª3±´Æ7ª ¨ß%ª ß±´

©ø'¨ ¨± ÆªøºÚ Ã.ª ™ø¥´ª ±> ¨.)3 %øÆø9ª¨ªÆ 9´3¨ æª )' ¨.ª

Æø'/ª ±> Ô ¨.Æ±´/. ¨.ª ™ø¥´ª ±> 7±´'¨Œª3±´Æ7ªÃß%ª3 >±Æ ¨.ª

Æª3±´Æ7ª >)¥ªÚ

Œª+´¥¨
Ã.ª Æª3´¥¨ ±> ¨.)3 7±99ø'º )3 ø >±´ÆÛ7.øÆø7¨ªÆ 3¨Æ)'/ Æª%Æª3ª'¨)'/ ø

Æª3±´Æ7ª ¨ß%ª 7±ºªÚ

¤®ø)0¥ª
Ã.ª >±¥¥±©)'/ ª®ø9%¥ª æ´)¥º3 ø ¥)3¨ 7±'¨ø)')'/ ¨.ª ¨ß%ª 7±ºª3 ±> ø¥¥ ¨.ª

Æª3±´Æ7ª3 3¨±Æªº )' ø Æª3±´Æ7ª >)¥ªÚ

*ª¨ ¨ß1ª*‘3*¨ ¨± •£
*ª¨ 73¥ª–ø¨; ¨± ^

.;±±*ª 73¥ª ©3¨; 1Æ±>1¨ ^
NÕª¥ª.¨ ø 73¥ª ¨± ±1ª&ÊM ±7 ¨ß1ª NÆ*Æ.M

*ª¨ Æª*⁄3¥ª ¨± ±1ª&Œª*±´Æ.ª⁄3¥ª 73¥ª–ø¨; 7±Æ Æªøº3&!
Æª1ªø¨ ©3¨; 3 7Æ±> Ô ¨± .±´&¨ÔŒª*±´Æ.ªÃß1ª* Æª*⁄3¥ª

*ª¨ ¨ß1ª*‘3*¨ ¨± ¨ß1ª*‘3*¨ ˙ ^
•!ª¨Ô%&ºª®ªºŒª*±´Æ.ªÃß1ª Æª*⁄3¥ª 3&ºª® 3£

ª&º Æª1ªø¨
.¥±*ªŒª*±´Æ.ª⁄3¥ª Æª*⁄3¥ª

Getl I ndexedResourceType
The getllndexedResourceType command allows you to obtain the type
codes of each of the different resource types stored in a resource file.

Get llndexedResourceType allows you to access the type codes available
in a single resource file. If you want to access type codes in a chain of
resource files, see the getlndexedResourceType command.

Syntax
g e t l l n d e x e d R e s o u r c e T y p e  f i l e R e f N u m  i n d e x  t y p e l n d e x

Parameters
fileRefNum

This parameter specifies the reference number of an open
resource file. This value is returned by the openResourceFile
and createResourceFile commands.

typeIndex This parameter specifies the index of the resource type you
want to read. The value of this parameter must be in the
range of 1 through the value of countResourceTypes for the
resource file.

Result
The result of this command is a four-character string representing a
resource type code.

Example
The following example builds a list containing the type codes of all the
resources stored in a resource file.

s e t  t y p e s L i s t  t o  { }
s e t  f i l e P a t h  t o

c h o o s e  f i l e  w i t h  p r o m p t
" S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " r s r c "

s e t  r e s F i l e  t o  o p e n R e s o u r c e F i l e  f i l e P a t h  f o r  r e a d i n g
r e p e a t  w i t h  i  f r o m  1  t o  c o u n t l R e s o u r c e T y p e s  r e s F i l e

s e t  t y p e s L i s t  t o  t y p e s L i s t  &
{ g e t l l n d e x e d R e s o u r c e T y p e  r e s F i l e  i n d e x

e n d  r e p e a t
c l o s e R e s o u r c e F i l e  r e s F i l e
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%-±±.ª /+¥ª ©+¨- *Æ±1*¨ NÕª¥ª%¨ ø /+¥ª ¨± ±*ª(ÊM ±/ ¨ß*ª NÆ.Æ%M

O‚ ø¥+ø. NÿøÆº ‹+.µ ÓÌÏÊ‹ª.µ¨±* ⁄±¥ºªÆÊÕ%Æ+*¨ ‹ªæ´BBªÆ ÔÚEÊÆª.±´Æ%ª /+¥ªM
±*ª(Œª.±´Æ%ª⁄+¥ª ø¥+ø. NÿøÆº ‹+.µ ÓÌÏÊ‹ª.µ¨±* ⁄±¥ºªÆÊÕ%Æ+*¨ ‹ªæ´BBªÆ

ÔÚEÊÆª.±´Æ%ª /+¥ªM /±Æ Æªøº+(B
O‚ ÍÌÁÏ

%±´(¨ÔŒª.±´Æ%ªÃß*ª. ÍÌÁÏ
O‚ Í

Bª¨ÔJ(ºª®ªºŒª.±´Æ%ªÃß*ª ÍÌÁÏ +(ºª® Ô
O‚ N+%.ÏM

Bª¨ÔJ(ºª®ªºŒª.±´Æ%ªÃß*ª ÍÌÁÏ +(ºª® Ó
O‚ N+%.ËM

Bª¨ÔJ(ºª®ªºŒª.±´Æ%ªÃß*ª ÍÌÁÏ +(ºª® Ì
O‚ N+%.˝M

Bª¨ÔJ(ºª®ªºŒª.±´Æ%ªÃß*ª ÍÌÁÏ +(ºª® Ï
O‚ N+%¥ÏM

Bª¨ÔJ(ºª®ªºŒª.±´Æ%ªÃß*ª ÍÌÁÏ +(ºª® Î
O‚ N+%¥ËM

Bª¨ÔJ(ºª®ªºŒª.±´Æ%ªÃß*ª ÍÌÁÏ +(ºª® Í
O‚ NJ›“˝M

%¥±.ªŒª.±´Æ%ª⁄+¥ª ÍÌÁÏ
ª(º ¨ª¥¥

¤ÆÆ±Æ$
Ã%&' )±++ø-º )ø- Æª¨´Æ- ø-ß ±4 ¨%ª ªÆÆ±Æ' ©%&)% øÆª Æª¨´Æ-ªº æß ¨%ª

Œª'¤ÆÆ±Æ¯˜ ¨±±¥æ±® Æ±´¨&-ªÚ

Outcome:

1 . O : r e s o u r c e  f i l e "  f o r  r e a d i n g
—> 6 3 9 4

c o u n t l R e s o u r c e Ty p e s  6 3 9 4
—> 6

g e t l I n d e x e d R e s o u r c e Ty p e 6394 i n d e x  1
—> " i c s 4 "

g e t l I n d e x e d R e s o u r c e Ty p e 6394 i n d e x  2
—> " i c s 8 "

g e t l I n d e x e d R e s o u r c e Ty p e 6394 i n d e x  3
—> " i c s # "

g e t l I n d e x e d R e s o u r c e Ty p e 6394 i n d e x  4
—> " i c 1 4 "

g e t l I n d e x e d R e s o u r c e Ty p e 6394 i n d e x  5
—> " i c 1 8 "

g e t l I n d e x e d R e s o u r c e Ty p e 6394 i n d e x  6
—> "ICN#"

t e l l  c u r r e n t  a p p l i c a t i o n
choose f i l e  w i t h  p r o m p t  " S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " r s r c "

—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . O : r e s o u r c e  f i l e "
o p e n R e s o u r c e F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r

c l o s e R e s o u r c e F i l e  6 3 9 4
end t e l l

Errors
This command can return any of the errors which are returned by the
ResError() toolbox routine.
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?±Æ ø Æª2±´Æ6ªÚ

Õß#¨ø®
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. ø&  1
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Æª2±´Æ6ª ?)¥ªÚ Ã.)2 ™ø¥´ª )2 Æª¨´Æ'ªº æß ¨.ª ±%ª'Œª2±´Æ6ª⁄)¥ª

ø'º 6Æªø¨ªŒª2±´Æ6ª⁄)¥ª 6±77ø'º2Ú
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Æª*.‹ Ã.)2 %øÆø7ª¨ªÆ 2%ª6)?)ª2 ¨.ª E‹ ±? ¨.ª Æª2±´Æ6ª ß±´ ©ø'¨ ¨±

ÆªøºÚ E? ß±´ 2%ª6)?ß ¨.)2 %øÆø7ª¨ªÆÙ ß±´ 6ø''±¨ ´2ª ¨.ª

Æª2“ø7ª %øÆø7ª¨ªÆÚ

Æª*“ø(ª Ã.)2 %øÆø7ª¨ªÆ 2%ª6)?)ª2 ¨.ª “ø7ª ±? ¨.ª Æª2±´Æ6ª ß±´ ©ø'¨

¨± ÆªøºÚ E? ß±´ 2%ª6)?ß ¨.)2 %øÆø7ª¨ªÆÙ ß±´ 6ø''±¨ ´2ª ¨.ª

Æª2E‹ %øÆø7ª¨ªÆÚ

Æª*Ãß-ª Ã.)2 %øÆø7ª¨ªÆ ø¥¥±©2 ß±´ ¨± 6±'¨Æ±¥ ¨.ª ºø¨ø ¨ß%ª ø%%¥)ªº

¨± ¨.ª Æª2±´Æ6ª ºø¨øÚ ⁄±Æ )'2¨ø'6ªÙ ß±´ 6ø' ´2ª ¨.)2

%øÆø7ª¨ªÆ ¨± .ø™ª ß±´Æ Æª2±´Æ6ª ºø¨ø ¨Æªø¨ªº ø2 ø 2¨Æ)'/Ù

%)6¨´ÆªÙ '´7æªÆ ±Æ ø'ß ±¨.ªÆ ¨ß%ª ±? )'?±Æ7ø¨)±'Ú

Œª+´¥¨
Ã.ª Æª2´¥¨ ±? ¨.)2 6±77ø'º )2 ø Œª2±´Æ6ª 6¥ø22Ú Õªª ¨.ª Œª2±´Æ6ª ›¥ø22

2´æÛ2ª6¨)±' æª¥±© ?±Æ 7±Æª )'?±Æ7ø¨)±'Ú

Getl Resource
The getlResource command allows you to read a resource.
GetlResource looks only in the resource file specified. See the
getResource command if you want to search a chain of resource files
for a resource.

Syntax
g e t l R e s o u r c e  f i l e R e f N u m  t y p e  r e s T y p e

[ i d  r e s l D  ]
[ n a m e  r e s N a m e  ]
[ a s  r e s T y p e  ]

Parameters
fileRefNum

This parameter specifies the reference number of an open
resource file. This value is returned by the openResourceFile
and createResourceFile commands.

resType T h i s  parameter specifies the type of resource you want to
read. Specify resource types as four-character strings such
as "PICT" o r  "TEXT".

resiD T h i s  parameter specifies the ID of the resource you want to
read. If you specify this parameter, you cannot use the
resName parameter.

resName T h i s  parameter specifies the Name of the resource you want
to read. If you specify this parameter, you cannot use the
reslD parameter.

resType T h i s  parameter allows you to control the data type applied
to the resource data. For instance, you can use this
parameter to have your resource data treated as a string,
picture, number or any other type of information.

Result
The result of this command is a Resource class. See the Resource Class
sub-section below for more information.

184 A p p e n d i x  C



Õ"Æ$%¨$'( flºº$¨$±'- ÔËÎ

¤®ø$%¥ª
!ª¨ %&¥ª–ø¨* ¨± ^

-*±±!ª %&¥ª ©&¨* /Æ±1/¨ ^
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-¥±!ªŒª!±´Æ-ª⁄&¥ª Æª!⁄&¥ª

—´¨"±0ªÊ

¨ª¥¥ -´ÆÆª4¨ ø//¥&-ø¨&±4
-*±±!ª %&¥ª ©&¨* /Æ±1/¨ NÕª¥ª-¨ ø %&¥ª ¨± ±/ª4ÊM ±% ¨ß/ª NŒÕŒ›M

O‚ ø¥&ø! NÿøÆº ‹&!µ ÓÌÏÊ‹ª!µ¨±/ ⁄±¥ºªÆÊÕ-Æ&/¨ ‹ªæ´<<ªÆ ”ø4´ø¥Êfl//¥ªÕ-Æ&/¨
&-±4!ÚÆ!Æ-M

±/ª4Œª!±´Æ-ª⁄&¥ª ø¥&ø! NÿøÆº ‹&!µ ÓÌÏÊ‹ª!µ¨±/ ⁄±¥ºªÆÊÕ-Æ&/¨ ‹ªæ´<<ªÆ
”ø4´ø¥Êfl//¥ªÕ-Æ&/¨ &-±4!ÚÆ!Æ-M %±Æ Æªøº&4<
O‚ ÈËOÏ

<ª¨ÔŒª!±´Æ-ª ÈËOÏ ±% ¨ß/ª N–?›ÃM &º ÔÓË
O‚ •-¥ø!!ÊÆª!±´Æ-ªÙ Æª!Ãß/ªÊM–?›ÃMÙ Æª!?‹ÊÔÓËÙ Æª!“ø1ªÊMMÙ Æª!‹ø¨øÊYºø¨ø
ˆ̂ ˆ̂ Ofl‹›OOOOOOOOOOÓÓOOÓ›OÓ⁄⁄O›O⁄⁄OOÓ›OOOOOOOOOOÔOOOflOOOOÓ›OOÁËËOÌÏOÔÍÔOOfiflÌOO¤‹OOOOOOOOOOOOOÏ¤OOOOÚÚÚ
¤›⁄flOO⁄¤⁄⁄¤‹OOOfi⁄ÓOOOÔ⁄Á⁄⁄⁄⁄¤flÔOOOOOOÔ⁄Á⁄⁄⁄‹OO⁄‹⁄⁄¤ÈOOOOO⁄Á⁄‹⁄⁄¤ÌOOOÓ›OÓ›‹OOOÓ›‹OOOOOO⁄⁄XÙ
Æª!–´Æ<ªøæ¥ªÊ%ø¥!ªÙ Æª!–Æª¥±øºÊ%ø¥!ªÙ Æª!–Æ±¨ª-¨ªºÊ%ø¥!ªÙ Æª!‘±-µªºÊ%ø¥!ªÙ

Æª!Õß!¨ª1ÿªø/Ê%ø¥!ª£
-¥±!ªŒª!±´Æ-ª⁄&¥ª ÈËOÏ

ª4º ¨ª¥¥

¤ÆÆ±Æ*
Ã%&' )±++ø-º )ø- Æª¨´Æ- ø-ß ±4 ¨%ª ªÆÆ±Æ' ©%&)% øÆª Æª¨´Æ-ªº æß ¨%ª

Œª'¤ÆÆ±Æ¯˜ ¨±±¥æ±® Æ±´¨&-ªÚ

Example
s e t  f i l e P a t h  t o

choose f i l e  w i t h  p r o m p t
" S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " r s r c "

s e t  r e s F i l e  t o  o p e n R e s o u r c e F i l e  f i l e P a t h  f o r  r e a d i n g
s e t  s t r D a t a  t o  g e t l R e s o u r c e  r e s F i l e  o f  t y p e  " P I C T "  i d  1 2 8
c l o s e R e s o u r c e F i l e  r e s F i l e

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

choose f i l e  w i t h  p r o m p t  " S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  "RSRC"
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  M a n u a l : A p p l e S c r i p t
i c o n s . r s r c "

o p e n R e s o u r c e F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r
M a n u a l : A p p l e S c r i p t  i c o n s . r s r c "  f o r  r e a d i n g
—> 7 8 0 4

g e t l R e s o u r c e  7 8 0 4  o f  t y p e  " P I C T "  i d  1 2 8
—> { c l a s s : r e s o u r c e ,  r e s T y p e : " P I C T " ,  r e s I D : 1 2 8 ,  r e s N a m e : " " ,  r e s D a t a : « d a t a
****OADC000000000022002CO2FFOCOFF002C00000000001000A00002C00988034016100BA300ED00000000000004E0000...
ECFAO0F111=000BF20001F9FFFFEA10000001F9FFFDOOFDFFE700000F9FDFFE30002CO2CD0002CD00000OFF>,
r e s P u r g e a b l e : f a l s e ,  r e s P r e l o a d : f a l s e ,  r e s P r o t e c t e d : f a l s e ,  r e s L o c k e d : f a l s e ,
r e s S y s t e m H e a p : f a l s e }

c l o s e R e s o u r c e F i l e  7 8 0 4
end t e l l

Errors
This command can return any of the errors which are returned by the
ResError() toolbox routine.
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Ã.ª /ª¨1'ºª®ªºŒª3±´Æ7ª 7±88ø'º ø¥¥±©3 ß±´ ¨± Æªøº ¨.ª Æª3±´Æ7ª3 ±=

ø /)™ª' ¨ß%ª æß )'ºª® Æø¨.ªÆ ¨.ø' 1‹ ±Æ 'ø8ªÚ Ã.ª /ª¨1'ºª®ªºŒª3±´Æ7ª

7±88ø'º )'ºª®ª3 ¨.Æ±´/. ø¥¥ ¨.ª Æª3±´Æ7ª3 ±= ¨.ª ¨ß%ª 3%ª7)=)ªº )' ¨.ª

ª'¨)Æª Æª3±´Æ7ª =)¥ª 7.ø)'Ú 1= ß±´ ©ø'¨ ¨± )'ºª® ¨.Æ±´/. ¨.ª Æª3±´Æ7ª3 )'

ø 3)'/¥ª =)¥ªÙ 3ªª ¨.ª Ÿª¨Ô1'ºª®ªºŒª3±´Æ7ª 7±88ø'ºÚ

Ã.)3 7±88ø'º )3 ´3ª=´¥ )= ß±´ º± '±¨ µ'±© ¨.ª 'ø8ª3 ±Æ 1‹3 ±=

¨.ª Æª3±´Æ7ª3 ß±´ ©ø'¨ ¨± ø77ª33Ú fl¥3±Ù ©.ª' 7±8æ)'ªº ©)¨. ¨.ª

7±´'¨Œª3±´Æ7ª3 7±88ø'ºÙ ß±´ 7ø' ´3ª ¨.ª /ª¨1'ºª®ªºŒª3±´Æ7ª

7±88ø'º ¨± Æªøº ø¥¥ ±= ¨.ª Æª3±´Æ7ª3 ±= ø /)™ª' ¨ß%ªÚ

Õß#¨ø®
!ª¨$%ºª®ªºŒª)±´Æ-ª

¨ß/ª  1%ºª® 
2 ø)  4

–øÆø)ª¨ªÆ+

!"¥ªŒª!“´(

Ã.)3 %øÆø8ª¨ªÆ 3%ª7)=)ª3 ¨.ª Æª=ªÆª'7ª '´8æªÆ ±= ø' ±%ª'

Æª3±´Æ7ª =)¥ªÚ Ã.)3 ™ø¥´ª )3 Æª¨´Æ'ªº æß ¨.ª ±%ª'Œª3±´Æ7ª⁄)¥ª

ø'º 7Æªø¨ªŒª3±´Æ7ª⁄)¥ª 7±88ø'º3Ú

Æª*Ãß-ª Ã.)3 %øÆø8ª¨ªÆ 3%ª7)=)ª3 ¨.ª ¨ß%ª ±= Æª3±´Æ7ª ß±´ ©ø'¨ ¨±

ÆªøºÚ Õ%ª7)=ß Æª3±´Æ7ª ¨ß%ª3 ø3 =±´ÆÛ7.øÆø7¨ªÆ 3¨Æ)'/3 3´7.

ø3 N–$›ÃM ±Æ NÃ¤»ÃMÚ
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¨± ÆªøºÚ Ã.ª ™ø¥´ª ±= ¨.)3 %øÆø8ª¨ªÆ 8´3¨ æª )' ¨.ª Æø'/ª ±=

Ô ¨± ¨.ª ™ø¥´ª Æª¨´Æ'ªº æß ›±´'¨Œª3±´Æ7ª3 =±Æ Æª*Ãß-ªÚ

Æª*Ãß-ª Ã.)3 %øÆø8ª¨ªÆ ø¥¥±©3 ß±´ ¨± 7±'¨Æ±¥ ¨.ª ºø¨ø ¨ß%ª

ø%%¥)ªº ¨± ¨.ª Æª3±´Æ7ª ºø¨øÚ ⁄±Æ )'3¨ø'7ªÙ ß±´ 7ø' ´3ª ¨.)3
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3´æÛ3ª7¨)±' æª¥±© =±Æ 8±Æª )'=±Æ8ø¨)±'Ú

Getl ndexed Resource
The getIndexedResource command allows you to read the resources of
a given type by index rather than ID or name. The getIndexedResource
command indexes through all the resources of the type specified in the
entire resource file chain. If you want to index through the resources in
a single file, see the Get1IndexedResource command.

This command is useful if you do not know the names or IDs of
the resources you want to access. Also, when combined with the
countResources command, you can use the getIndexedResource
command to read all of the resources of a given type.

Syntax
g e t I n d e x e d R e s o u r c e  f i l e R e f N u m

t y p e  r e s T y p e  i n d e x  r e s l n d e x
[ a s  d a t a T y p e  ]

Parameters
fileRefNum

This parameter specifies the reference number of an open
resource file. This value is returned by the openResourceFile
and createResourceFile commands.

resType T h i s  parameter specifies the type of resource you want to
read. Specify resource types as four-character strings such
as "PICT" o r  "TEXT".

resIndex T h i s  parameter specifies the index of the resource you want
to read. The value of this parameter must be in the range of
1 to the value returned by CountResources for resType.

resType T h i s  parameter allows you to control the data type
applied to the resource data. For instance, you can use this
parameter to have your resource data treated as a string,
picture, number or any other type of information.

Result
The result of this command is a Resource class. See the Resource Class
sub-section below for more information.
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¤ÆÆ±Æ*
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Example
s e t  f i l e P a t h  t o

choose f i l e  w i t h  p r o m p t
" S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " r s r c "

s e t  r e s F i l e  t o  o p e n R e s o u r c e F i l e  f i l e P a t h  f o r  r e a d i n g
s e t  numRsrcs  t o  c o u n t R e s o u r c e s  r e s F i l e  o f  t y p e  " P I C T "
s e t  t h e P I C Ts  t o  { }
r e p e a t  w i t h  i  f r o m  1  t o  numRsrcs

s e t  t h e P I C Ts  t o  t h e P I C Ts  &
{ g e t I n d e x e d R e s o u r c e  r e s F i l e  o f  t y p e  " P I C T "  i n d e x

end r e p e a t
c l o s e R e s o u r c e F i l e  r e s F i l e

Outcome:

i }

t e l l  c u r r e n t  a p p l i c a t i o n
choose f i l e  w i t h  p r o m p t  " S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  "RSRC"

—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  M a n u a l : A p p l e S c r i p t
i c o n s . r s r c "

o p e n R e s o u r c e F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r
M a n u a l : A p p l e S c r i p t  i c o n s . r s r c "  f o r  r e a d i n g
—> 7 5 2 2

coun tResources  7 5 2 2  o f  t y p e  " P I C T "
—> 4 0

g e t I n d e x e d R e s o u r c e  7 5 2 2  o f  t y p e  " P I C T "  i n d e x  1
—> { c l a s s : r e s o u r c e ,  r e s T y p e : " P I C T " ,  r e s I D : 1 2 8 ,  r e s N a m e : " " ,  r e s D a t a : « d a t a
****OADC0000000000201102FF000000022000000000000022002C0098300E000004E0000004000000000800010008000000

g e t I n d e x e d R e s o u r c e  7 5 2 2  o f  t y p e  " P I C T "  i n d e x  4 0
—> { c l a s s : r e s o u r c e ,  r e s T y p e : " P I C T " ,  r e s l D : - 5 6 9 4 ,  r e s N a m e : " " ,  r e s D a t a : « d a t a
****018E0000000000100010001102FFOCOOF00000048000000100010000001000A00010990002F900000OFF>,
r e s P u r g e a b l e : t r u e ,  r e s P r e l o a d : f a l s e ,  r e s P r o t e c t e d : f a l s e ,  r e s L o c k e d : f a l s e ,
r e s S y s t e m H e a p : f a l s e }

c l o s e R e s o u r c e F i l e  7522
end t e l l

Errors
This command can return any of the errors which are returned by the
ResError() toolbox routine.
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GetIndexedResourceType
The getIndexedResourceType command allows you to obtain the type
codes of each of the different resource types stored in a chain of
resource files. If you want to access type codes in a single resource file,
see the get lIndexedResourceType command.

Syntax
g e t I n d e x e d R e s o u r c e T y p e  f i l e R e f N u m  i n d e x  t y p e l n d e x

Parameters
fileRefNum

This parameter specifies the reference number of an open
resource file. This value is returned by the openResourceFile
and createResourceFile.

typeIndex This parameter specifies the index of the resource type you
want to read. The value of this parameter must be in the
range of 1 through the value of countResourceTypes for the
resource file.

Result
The result of this command is a four-character string representing a
resource type code.

Example
The following example builds a list containing the type codes of all the
resources available to the script.

s e t  t y p e s L i s t  t o  { }
s e t  f i l e P a t h  t o

c h o o s e  f i l e  w i t h  p r o m p t
" S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " r s r c "

s e t  r e s F i l e  t o  o p e n R e s o u r c e F i l e  f i l e P a t h  f o r  r e a d i n g
r e p e a t  w i t h  i  f r o m  1  t o  c o u n t R e s o u r c e T y p e s  r e s F i l e

s e t  t y p e s L i s t  t o  t y p e s L i s t  &
{ g e t I n d e x e d R e s o u r c e T y p e  r e s F i l e  i n d e x

e n d  r e p e a t
c l o s e R e s o u r c e F i l e  r e s F i l e
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Outcome:
{ " c f r g " ,  " g m r a " ,  " h m a n " ,  " p f l p " ,  " f w s t " ,  " s f n t " ,  " N F N T " ,  "KCOD" ,  " I D L E " ,  " D K N D " ,
"LOCN", " P R E F " ,  " F L S H " ,  " T H S F " ,  ' s y s z " ,  " n r c t " ,  " m a c h " ,  " O P T S " ,  " D I C S " ,  " A C T V " ,
"BARY", " S A RY " ,  "PHON" ,  " S T X T " ,  " c r s r " ,  " .em 1 " ,  " c d e v " ,  "PROC" ,  "DCOD" ,  " d t n  " ,
" a u d t " ,  " m o v p " ,  " Q P r f " ,  " A P r f " ,  " a i l s " ,  " a t l k " ,  " i o p c " ,  " l t l k " ,  " A I N I " ,  " d r r " ,
" l m g r " ,  " p i c b " ,  " f m a p " ,  " R O v r " ,  "FOND" ,  " w e d g " ,  " p i X s " ,  " p m a p " ,  " r t t # " ,  " F M T R " ,
" p p c c " ,  " A D B S " ,  " c D E F " ,  " D RV R " ,  " D S AT " ,  " F K E Y " ,  " F R S V " ,  " I C O N " ,  " I N T L " ,  " K C A P " ,
" K C H " ,  "KMAP" ,  "KSWP" ,  " L D E F " ,  ' M A C S " ,  " M B D F " ,  " PA C K " ,  " PAT  " ,  " PAT # " ,  " P T C H " ,
"RECT", " R 0 v # " ,  " b o o t " ,  " b s t # " ,  " c a r d " ,  " c c t b " ,  " c l u t " ,  " c m t b " ,  " c t b  " ,  " d b e x " ,
"dcmp",  " d i m g " ,  " e n e t " ,  " f 1 d # " ,  " f i s t " ,  " g b l y " ,  " i n d l " ,  " i n p m " ,  " i t 1 0 " ,  " i t l l " ,
" i t 1 2 " ,  " i t 1 4 " ,  " i t l b " ,  " i t i c " ,  " i t l m " ,  " k c s # " ,  " k c s 4 " ,  " l o d r " ,  " l p c h " ,  " l s t r " ,
" rocky",  " m i t q " ,  " m n t r " ,  " p p a t " ,  " p p c i " ,  " p p t # " ,  " r o c " ,  " p s l t " ,  " p t b l " ,  " p t c h " ,
" r e s f " ,  " r g b  " ,  " s n d  " ,  " s n t h " ,  " v m  " ,  " w c t b " ,  " s c o d " ,  " l m e m " ,  " T W I T " ,  "MDRW",
"MPNT", "MACA" ,  " m s t # " ,  " m s t r " ,  " I N I T " ,  " D L O G " ,  " D I T L " ,  " x M A P " ,  " x R S C " ,  "WDEF" ,
" h f d r " ,  " h m n u " ,  " h d l g " ,  " s c s z " ,  " P a n e " ,  " p l t t " ,  " M D E F " ,  " d c t b " ,
"P ICT" ,  " T E X T " ,  " B N D L " ,  " a s D B " ,  " S t d P " ,  " c i c n " ,  " F R E F " ,  " a c u r " ,  " F O N T " ,  " C U R S " ,
"P ICT" ,  " S c P n " ,  " E s t r " ,  "MBAR" ,  " S I C N " ,  " S T R # " ,  " S T R  " ,  " W I N D " ,  "MENU" ,  " A L R T " ,
"CNTL", " S I Z E " ,  "CODE" ,  " D R E L " ,  " Z E R O " ,  " D ATA " ,  " T E S T " ,  " c k i d " ,  " v e r s " ,  " c + +  " ,
"dcmd",  " m x b c " ,  " m x b i " ,  " m x w t " ,  " m x b m " ,  " T M P L " ,  " i c s 4 " ,  " i c s 8 " ,  " i c s # " ,  " i c 1 4 " ,

" i c 1 8 " ,  " I C N # " }

ErrorsThis command can return any of the errors which are returned by the

ResError() toolbox routine.
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GeflndexedStringResource
The getIndexedStringResource command allows you to read the text
data stored in an "STR#" resource.

Each "STR#" resource contains a series of strings.
GetlndexedStringResource allows you to access any of the strings
stored in an "STR#" resource .

Syntax
g e t I n d e x e d S t r i n g R e s o u r c e  f i l e R e f N u m

[ i d  r e s l D  ]
[ n a m e  r e s N a m e  ]
i n d e x  s t r i n d e x

Parameters
fileRefNum

This parameter specifies the reference number of an open
resource file. This value is returned by the openResourceFile
and createResourceFile commands.

resiD T h i s  parameter specifies the ID of the "STR#" resource
you want to read. If you specify this parameter, you cannot
use the resName parameter.

resName T h i s  parameter specifies the Name of the "STR#"
resource you want to read. If you specify this parameter,
you cannot use the reslD parameter.

strIndex T h i s  parameter specifies the index of the string within the
"STR#" resource you want to read.

Result
The result of this command is a string.

Example
s e t  f i l e P a t h  t o

c h o o s e  f i l e  w i t h  p r o m p t
" S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " r s r c "

s e t  r e s F i l e  t o  o p e n R e s o u r c e F i l e  f i l e P a t h  f o r  r e a d i n g
s e t  s t r D a t a  t o  g e t I n d e x e d S t r i n g R e s o u r c e  i d  1 2 8  i n d e x  1
c l o s e R e s o u r c e F i l e  r e s F i l e
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Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

choose f i l e  w i t h  p r o m p t  " S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " r s r c "
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : r e s o u r c e  f i l e "

o p e n R e s o u r c e F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r
1 . 0 : r e s o u r c e  f i l e "  f o r  r e a d i n g
—> 5 8 3 0

g e t I n d e x e d S t r i n g R e s o u r c e  i d  1 2 8  i n d e x  1
—> " q u i t t i n g "

c l o s e R e s o u r c e F i l e  5 8 3 0
end t e l l

Errors
This command can return any of the errors which are returned by the
ResError() toolbox routine.
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GetResource
The getResource command allows you to read a resource. GetResource
searches through a chain of resource files to locate your resource. See
the getlResource command if you want to search through a single
resource file.

Syntax
g e t R e s o u r c e  f i l e R e f N u m  t y p e  r e s T y p e

[ i d  r e s l D  ]
[ n a m e  r e s N a m e  ]
[ a s  r e s T y p e  ]

Parameters
fileRefNum

This parameter specifies the reference number of an
open resource file. This value is returned by the
openResourceFile, and createResourceFile commands.

resType T h i s  parameter specifies the type of resource you want to
read. Specify resource types as four-character strings such
as "PICT" o r  "TEXT".

resiD T h i s  parameter specifies the ID of the resource you want to
read. If you specify this parameter, you cannot use the
resName parameter.

resName T h i s  parameter specifies the Name of the resource you want
to read. If you specify this parameter, you cannot use the
reslD parameter.

resType T h i s  parameter allows you to control the data type
applied to the resource data. For instance, you can use this
parameter to have your resource data treated as a string,
picture, number or any other type of information.

Result
The result of this command is a Resource class. See the Resource Class
sub-section below for more information.
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Example
This script returns the hexadecimal version of the PICT.

s e t  f i l e P a t h  t o
choose f i l e  w i t h  p r o m p t

" S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " r s r c "
s e t  r e s F i l e  t o  o p e n R e s o u r c e F i l e  f i l e P a t h  f o r  r e a d i n g
s e t  s t r D a t a  t o  g e t R e s o u r c e  o f  t y p e  " P I C T "  i d  1 2 8
c l o s e R e s o u r c e F i l e  r e s F i l e

Outcome:

T t e l l  c u r r e n t  a p p l i c a t i o n
choose f i l e  w i t h  p r o m p t  " S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " r s r c "

—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . O : r e s o u r c e  f i l e "
o p e n R e s o u r c e F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r

1 . O : r e s o u r c e  f i l e "  f o r  r e a d i n g
—> 6 5 8 2

ge tResou rce  o f  t y p e  " P I C T "  i d  1 2 8
—> { c l a s s : r e s o u r c e ,  r e s T y p e : " P I C T " ,  r e s I D : 1 2 8 ,  r e s N a m e : " " ,  r e s D a t a : « d a t a
****0D2A0152000D027101rmiww0FFF015200001E1300027100000000001E001FFFF0001000V1000E027101DE00080031000H027101D7
• • •
0038001BFFFF000000000031015201121.01D700C0F60011F40001FE900061FFFB3000000CD000101FEE00010FF8F50002C70000M›,
r e s P u r g e a b l e : f a l s e ,  r e s P r e l o a d : f a l s e ,  r e s P r o t e c t e d : f a l s e ,  r e s L o c k e d : f a l s e ,
r e s S y s t e m H e a p : f a l s e }

c l o s e R e s o u r c e F i l e  6582
end t e l l

Errors
This command can return any of the errors which are returned by the
ResError() toolbox routine.
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GetStringResource
The getStringResource command allows you to read the text data
stored in an "STR "  resource.

Syntax
g e t S t r i n g R e s o u r c e  f i l e R e f N u m

[ i d  r e s l D  ]
[ n a m e  r e s N a m e

Parameters
fileRefNum

This parameter specifies the reference number of an
open resource file. This value is returned by the
openResourceFile, createResourceFile, and getCurResFile
commands.

resiD T h i s  parameter specifies the ID of the "STR" resource you
want to read. If you specify this parameter, you cannot use
the resName parameter.

resName T h i s  parameter specifies the Name of the "STR" resource
you want to read. If you specify this parameter, you cannot
use the reslD parameter.

Result
The result of this command is a string.

Example
s e t  f i l e P a t h  t o

c h o o s e  f i l e  w i t h  p r o m p t
" S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " r s r c "

s e t  r e s F i l e  t o  o p e n R e s o u r c e F i l e  f i l e P a t h  f o r  r e a d i n g
s e t  s t r D a t a  t o  g e t S t r i n g R e s o u r c e  i d  1 2 8
c l o s e R e s o u r c e F i l e  r e s F i l e
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Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

choose f i l e  w i t h  p r o m p t  " S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " r s r c "
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . O : r e s o u r c e  f i l e "

o p e n R e s o u r c e F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r
1 . O : r e s o u r c e  f i l e "  f o r  r e a d i n g
—> 7 1 4 6

g e t S t r i n g R e s o u r c e  i d  1 2 8
—> " S c r i p t  A p p l i c a t i o n

c l o s e R e s o u r c e F i l e  7 1 4 6
end t e l l

Errors
This command can return any of the errors which are returned by the
ResError() toolbox routine.
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OpenResourceFile
The openResourceFile command opens a resource file (or the resource
fork of any other type of file) for reading, updating, or writing. This
command, when used with the other commands provided by the
Resource IO addition, allows you to manipulate resources within scripts.

Syntax
o p e n R e s o u r c e F i l e  f i l e

[ f o r  r e a d i n g l u p d a t e l w r i t i n g  ]

Parameters
file T h i s  parameter is an alias to the file which is to be opened.

Result
The result is a resource file reference number. You must provide this
number to all other commands you issue when processing the resource
file.

Example
s e t  f i l e P a t h  t o

c h o o s e  f i l e  w i t h  p r o m p t
" S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " r s r c "

s e t  r e s F i l e  t o  o p e n R e s o u r c e F i l e  f i l e P a t h  f o r  r e a d i n g
c l o s e R e s o u r c e F i l e  r e s F i l e

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  f i l e  w i t h  p r o m p t  " S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " r s r c "
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : r e s o u r c e  f i l e "

o p e n R e s o u r c e F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : r e s o u r c e
f i l e "  f o r  r e a d i n g
—> 6 5 8 2

c l o s e R e s o u r c e F i l e  6 5 8 2
e n d  t e l l

NOTES: When the optional f o r  parameter is not specified, the file is opened
for update.
Be careful to ensure you close all the files you open. Due to the nature of
AppleScript additions, the openResourceFile command does not ensure the
file is closed when a script aborts without first closing the file with the
closeResourceFile command.

Errors
This command can return any of the errors which are returned by the
ResError() toolbox routine.
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RemoveResource
The removeResource command removes a resource from a resource
file.

Syntax
r e m o v e R e s o u r c e  f i l e R e f N u m  t y p e  r e s T y p e

[ i d  r e s l D  ]
[ n a m e  r e s N a m e

Parameters
fileRefNum

This parameter specifies the reference number of an open
resource file. This value is returned by the openResourceFile
and createResourceFile commands.

resType T h i s  parameter specifies the type of resource you want to
remove. Specify resource types as four-character strings
such as " P I C T "  o r  " T E X T " .

resiD T h i s  parameter specifies the ID of the resource you want to
remove. If you specify this parameter, you cannot use the
resName parameter.

resName T h i s  parameter specifies the Name of the resource you want
to remove. If you specify this parameter, you cannot use the
reslD parameter.

Result
None.

Example
s e t  f i l e P a t h  t o

c h o o s e  f i l e  w i t h  p r o m p t
" S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " r s r c "

s e t  r e s F i l e  t o  o p e n R e s o u r c e F i l e  f i l e P a t h
r e m o v e R e s o u r c e  r e s F i l e  o f  t y p e  " P I C T "  i d  1 2 8
c l o s e R e s o u r c e F i l e  r e s F i l e
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Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

choose f i l e  w i t h  p r o m p t  " S e l e c t  a  f i l e  t o  o p e n : "  o f  t y p e  " r s r c "
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . O : r e s o u r c e  f i l e "

o p e n R e s o u r c e F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r
1 . O : r e s o u r c e  f i l e "
—> 5 5 4 8

removeResource 5 5 4 8  o f  t y p e  " P I C T "  i d  1 2 8
c l o s e R e s o u r c e F i l e  5 5 4 8

end t e l l

Errors
This command can return any of the errors which are returned by the
ResError() toolbox routine.
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GetUniquel ResourcelD
Use the getUniquelResourcelD command to find a unique ID for a
given type of resource. The getUniquelResourcelD command ensures
that the value it returns is unique within a single resource file.

Syntax
g e t U n i q u e l R e s o u r c e l D  f i l e R e f N u m  t y p e  r e s T y p e

Parameters
fileRefNum This parameter specifies the reference number of an

open resource file. This value is returned by the
openResourceFile and createResourceFile commands.

resType T h i s  parameter is the type code of the resources you want
to count. Specify the type code as a four-character string,
such as: "PICT" or "TEXT" .

Result
The new unique resource ID.

Errors
The getUniquelResourcelD command can return any of the error
codes provided by the ResError() toolbox function.

Example
s e t  t h e F i l e  t o  c h o o s e  f i l e  o f  t y p e  " r s r c "
s e t  r e s F i l e  t o  o p e n R e s o u r c e F i l e  t h e F i l e  f o r  w r i t i n g
s e t  newRes lD  t o  0
r e p e a t  w h i l e  newRes lD  <  1 2 8

s e t  newRes lD  t o  g e t U n i q u e l R e s o u r c e l D  r e s F i l e  o f  t y p e  "TEST"
end r e p e a t
addResource r e s F i l e

o f  t y p e
"TEST" i d  newRes lD
d a t a  " Te s t i n g "

c l o s e R e s o u r c e F i l e  r e s F i l e

Outcome:

t e l l  c u r r e n t  a p p l i c a t i o n
choose f i l e  o f  t y p e  " r s r c "

—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . O : r e s o u r c e  f i l e "
o p e n R e s o u r c e F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r

1 . O : r e s o u r c e  f i l e "  f o r  w r i t i n g
—> 6 9 5 8

g e t U n i q u e l R e s o u r c e l D  6 9 5 8  o f  t y p e  "TEST"
—> 19718

addResource 6 9 5 8  o f  t y p e  " T E S T "  i d  19718  d a t a  " Te s t i n g "
c l o s e R e s o u r c e F i l e  6 9 5 8

end t e l l
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GetUniqueResourcel D
Use the getUniqueResourcelD command to find a unique ID for a
given type of resource. The getUniqueResourcelD command ensures
that the value it returns is unique within an entire chain of resource
files.

Syntax
g e t U n i q u e R e s o u r c e l D  f i l e R e f N u m  t y p e  r e s T y p e

Parameters
fileRefNum T h i s  parameter specifies the reference number of an

open resource file. This value is returned by the
openResourceFile and createResourceFile commands.

resType T h i s  parameter is the type code of the resources you
want to count. Specify the type code as a four-character
string, such as: " P I CT" or "TEXT".

Result
The new unique resource ID.

Errors
The uniqueResourcelD command can return any of the error codes
provided by the ResError() toolbox function.

Example
s e t  t h e F i l e  t o  c h o o s e  f i l e  o f  t y p e  " r s r c "
s e t  r e s F i l e  t o  o p e n R e s o u r c e F i l e  t h e F i l e  f o r  w r i t i n g
s e t  n e w R e s l D  t o  0
r e p e a t  w h i l e  n e w R e s l D  <  1 2 8

s e t  n e w R e s l D  t o  g e t U n i q u e R e s o u r c e l D  r e s F i l e  o f  t y p e  " T E S T "
e n d  r e p e a t
a d d R e s o u r c e  r e s F i l e

o f  t y p e
" T E S T "  i d  n e w R e s l D
d a t a  " T e s t i n g "

c l o s e R e s o u r c e F i l e  r e s F i l e

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

c h o o s e  f i l e  o f  t y p e  " r s r c "
—> a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r  1 . 0 : r e s o u r c e  f i l e "

o p e n R e s o u r c e F i l e  a l i a s  " H a r d  D i s k  2 3 4 : D e s k t o p  F o l d e r : S c r i p t  D e b u g g e r
1 . 0 : r e s o u r c e  f i l e "  f o r  w r i t i n g
—> 6 9 5 8

g e t U n i q u e R e s o u r c e l D  6 9 5 8  o f  t y p e  " T E S T "
—> 1 9 7 1 8

a d d R e s o u r c e  6 9 5 8  o f  t y p e  " T E S T "  i d  1 9 7 1 8  d a t a  " T e s t i n g "
c l o s e R e s o u r c e F i l e  6 9 5 8

e n d  t e l l
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Resource Class
The various GetResource commands of the Resource JO addition
return resource information in the form of a Resource class.

The resource class has the following properties:

resID T h i s  property corresponds to the resource's ID.

resName T h i s  property corresponds to the resource's Name.

resData T h i s  property contains a resource's data. The type of
this property is governed by the AS parameter of the
GetResource commands. If the AS parameter is not
specified, the GetResource commands use the data type
"anything".

resPurgeable
This Boolean property represents the purgeable bit of the
resource's status bits.

resPreload
This Boolean property represents the preload bit of the
resource's status bits.

resProtected
This Boolean property represents the protected bit of the
resource's status bits.

resLocked
This Boolean property represents the locked bit of the
resource's status bits.

resSystemHeap
This Boolean property represents the system heap bit of the
resource's status bits.
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Screens Addition
List Screens

The List Screens command obtains detailed information about each of
the Macintosh's display screens.

Syntax
l i s t  screens

Result
The result of the List Screens command is a list of records. Each record
describes a different display screen. The records contain the following
values:

main screen
This Boolean value indicates whether or not the screen is
the main screen. The main screen is the screen containing
the menu bar.

bit depth
This value represents the number of bits in the display
screen.

bounds T h i s  value is the screen's bounding rectangle.

Example
l i s t  s c r e e n s

Outcome:
—> { { c l a s s : s c r e e n  i n f o r m a t i o n ,  m a i n  s c r e e n : t r u e ,  b i t  d e p t h : 8 ,  b o u n d s : { 0 ,  0 ,  6 4 0 ,
8 7 0 } } ,  { c l a s s : s c r e e n  i n f o r m a t i o n ,  m a i n  s c r e e n : f a l s e ,  b i t  d e p t h : 8 ,  b o u n d s : { - 1 0 2 4 ,
0, 0 ,  7 6 8 } } }
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Shutdown Addition
The Shutdown addition allows your scripts to shutdown the
Macintosh.

Shutdown
The Shutdown command shuts down and optionally restarts your
Macintosh.

Syntax
shutdown

[ w i t h  r e s t a r t

Result
This command returns no result.

Example
s e t  r e s u l t  t o  d i s p l a y  d i a l o g

" A r e  y o u  s u r e  y o u  w a n t  t o  s h u t d o w n ? "
b u t t o n s  { " S h u t d o w n " ,  " R e s t a r t " ,  " C a n c e l " }  d e f a u l t  b u t t o n  " C a n c e l "

i f  b u t t o n  r e t u r n e d  o f  r e s u l t  =  " S h u t d o w n "  t h e n  s h u t d o w n
i f  b u t t o n  r e t u r n e d  o f  r e s u l t  =  " R e s t a r t "  t h e n  s h u t d o w n  w i t h  r e s t a r t

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

d i s p l a y  d i a l o g  " A r e  y o u  s u r e  y o u  w a n t  t o  s h u t d o w n ? "  b u t t o n s  { " S h u t d o w n " ,
" R e s t a r t " ,  " C a n c e l " }  d e f a u l t  b u t t o n  " C a n c e l "
—> U s e r  c a n c e l l e d .
e n d  t e l l
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Speech Addition
The Speech addition allows your scripts to use the services of Apple's
Speech Manager within your scripts. This section describes each of the
AppleScript commands provided in the Speech addition.

To use the Speech addition, you will need version 1.1.1 or later of
Apple's Speech Manager software.

Speak
The Speak command uses the Apple Macintosh Speech Manager to
speak text strings. Note that because of its dependency on the Speech
Manager, this command only operates on Macintoshes which have the
Speech Manager installed.

If you enter the Command-. while the speak command is speaking a
long text string, the command is aborted and a userCanceledErr is
returned.

Syntax
speak message

[ v o i c e  v o i c e
[ r a t e  r a t e  ]
[ p i t c h  p i t c h

Parameters
message T h i s  parameter is the text you want to have spoken.

voice T h i s  optional parameter allows you to specify the name of
the voice you want used when the message is spoken.

rate T h i s  optional parameter specifies the rate at which
your message is spoken. Express the rate as a number
representing words per minute.

pitch T h i s  optional parameter specifies the pitch at which your
message is spoken.

Result
None.

Example
s p e a k  " T h e  w i n d  b l o w s  m a i n l y  i n  t h e  p l a i n s "
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List Voices
The List Voices command obtains a list of the names of the voices
available. Note that because of its dependency on the Speech Manager,
this command only operates on Macintoshes which have the Speech
Manager installed.

Syntax
l i s t  vo i ces

Parameters
None.

Result
The result is a list of strings representing the names of all the Speech
Manager voices.

Example
l i s t  voices

Outcome:
—> { " Z a r v o x " ,  " W h i s p e r " ,  " T r i n o i d s " ,  " R a l p h " ,  " P r i n c e s s " ,  " K a t h y " ,  " J u n i o r " ,  " G o o d
N e w s " ,  " B a d  N e w s " ,  " F r e d " }

Get Voice
The Get Voice command returns detailed information about a
particular Speech Manager voice. Note that because of its dependency
on the Speech Manager, this command only operates on Macintoshes
which have the Speech Manager installed.

Syntax
get v o i c e  v o i c e

Parameters
voice T h i s  parameter specifies the name of the voice you want

information about.

Result
The result of the Get Voice command is a record containing the
following values:
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voice name

comment

gender

voice version
This integer value represents the voice's version number.

This string is the voice's name.

This string further describes the voice.

This integer value defines the gender of the voice- 1  =
neuter, 2 = male and 3 = female.

age T h i s  integer value represents the approximate age of the
voice.

voice script

language

Example

This integer corresponds with the voice's script code.

This integer value is the voice's language code.

g e t  v o i c e  ( f i r s t  i t e m  o f  ( l i s t  v o i c e s ) )

Outcome:
t e l l  c u r r e n t  a p p l i c a t i o n

l i s t  v o i c e s
—> { " Z a r v o x " ,  " W h i s p e r " ,  " T r i n o i d s " ,  " R a l p h " ,  " P r i n c e s s " ,  " K a t h y " ,  " J u n i o r " ,  " G o o d
News", " B a d  News" ,  " F r e d " }

g e t  v o i c e  " Z a r v o x "
—> { c l a s s : v o i c e  i n f o r m a t i o n ,  v o i c e  v e r s i o n : 2 5 9 ,  v o i c e  n a m e : " Z a r v o x " ,  c o m m e n t : " T h a t
l o o k s  l i k e  a  p e a c e f u l  p l a n e t . " ,  g e n d e r : 0 ,  a g e : 1 ,  v o i c e  s c r i p t : 0 ,  l a n g u a g e : 0 ,
r e g i o n : 0 }
end t e l l
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D
Scheduler

Scheduler is a utility that lets you schedule the launch of
applications and the opening of documents in response to a
wide variety of events. For example, you can create an event in
Scheduler that can open a spreadsheet regularly each week. It is
fully scriptable and recordable so you can write scripts using
AppleScript or any other OSA language to automate common
activities. Scheduler's recordability allows you to create scripts
by recording your actions; this makes it easy to learn how to
script Scheduler.

Because of its flexibility, Scheduler has applications in Network
Management, Telecommunications, Business Systems and
many other areas where actions within your application need
to be performed on a regular basis. Since it is scriptable, you
can program your Macintosh to perform tasks involving a
number of applications.
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Scheduler Components
When you ran the Script Debugger Installer, it installed the Scheduler
components if you chose the Easy Install option or if you selected
Scheduler in the Custom Install. If you look in your Control Panels
folder, you will find the Scheduler Setup control panel file. You will
also find the Scheduler extension file in your Extensions folder.

NOTE: The Scheduler extension is a fat binary so it will work with both
68K and Power Macintoshes.
To use Scheduler effectively, your Macintosh computer must be
running system software version 7.0 or later with at least two
megabytes of memory. Four megabytes is the recommended amount
of RAM for Scheduler.

The following sections in this appendix show you how to create an
event in Scheduler. You can refer to Chapter 3 to see how Scheduler's
recordability works. You can find out more about the events and classes
that Scheduler supports by referring to its dictionary.

Scheduling An Application or Document Event
Scheduler makes it very easy to schedule the launch of applications and
documents. This example shows you how to use Scheduler to open the
Read Me First file on the Script Debugger Install disk whenever the disk
is inserted into your Macintosh's disk drive.

1. Double-click the Scheduler Setup control panel.
The Scheduler Setup file is located in the Control Panels folder within
your System Folder.

C i l
• J

Scheduler Setup
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2. Click Add (Figure D-1).

 S c h e d u l e r  Setup

1   Documents and Applications to Open: Preferences...
-u-

-7,
Add... )  (  ...:>: £.

ID: -

E l  L

Figure D-1
The Scheduler Setup
window

Click the Add button
to schedule a
document or application

Figure D-2
Scheduler
file selection
dialog box

When you click Add, Scheduler Setup presents a file selection dialog
box (Figure D-2).

CD Script Debugger Install

E l  Read Me First
46, Script Debugger Installer

CD Script Debu...

( E j e c t

( Desktop

Cancel

( O p e n

Use this dialog box to locate the application or document you want to
schedule. For this example, select the Read Me First file and click the
Open button.
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Once you have selected a file, the Scheduler Setup window will look
like the one in Figure D-3.

El S c h e d u l e r  Setup

(   Documents and Applications to Open: Preferences...

Script Debugger Install Read Me Fi rs t ' i t

-P-

I A d d . . .  -  Change...  )  D e l e t e

Launch: P e r i o d i c a l l y  Throughout The Day . .  I  I D :  4

Every : C a  17:1 Z  Enabled

Between: 1 : 1 3  133 AM a n d  n a  ® P M  E l  Launch In
Foreground

On: Z  Sundays Z  Mondays Z  Tuesdays

Z  Wednesdays Z  Thursdays Z  Fridays

Z  Saturdays

Next launch on Thursday,  May 4 , 1 9 9 5  at 5 :00  AM

Figure D-3
The Read Me First
file selected

Figure D-4
Scheduler Setup's
Launch menu
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3. Select a scheduling type.
By default, Scheduler Setup schedules your document to execute
"Periodically Throughout The Day". In this example, choose "When
Volumes Are Mounted" from the Launch pop-up menu (Figure D-4).

When Volumes A re  Mounted
When Volumes A re  Dismounted
When A Volume's Free Space Limit  Is Exceeded

When A Folder Changes
When Files Within A Folder Exceed A L imi t
When A Folder's Size Limit  Is Exceeded
When A File Changes

Launch: •  Periodical ly
Once Daily
Once Weekly
Once Monthly
Once Yearly
Once

When Power Adapter Is Plugged In
When Power Adapter Is Unplugged
When Woken U.

Once you have selected a scheduling option, the bottom portion of the
Scheduler Setup window changes to display scheduling parameters
(Figure D-5).
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Figure D-5
Scheduler with
the scheduling
parameters set

Fi S c h e d u l e r  Setup

Documents and A p p l i c a t i o n s  t o  Open:  P r e f e r e n c e s . . .

Script  Debugger Install :Read Me F i r s t -u-

.n.

Add... )  (  Change...  )  (  D e l e t e

Launch: W h e n  Volumes A re  Mounted ,  I  I D :  4

Volume: A n y  Volume . .  I  Z  Enabled

Noi Launch In
Foreground

Figure D-6
The Volume
pop-up menu

4. Set scheduling parameters.
Once you have selected the type of scheduling you want, you can
provide additional information governing when your document or
application is opened. In this example, choose the Script Debugger
Installer disk which contains Read Me First.

Choose Script Debugger Install from the Volume pop-up menu
(Figure D-6).

Volun-p?: •  Any  Volume

other
Deg
Graphics
Hard Disk 234
Mail Enclosures
MacOS
Script Debugger-
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5. Close Scheduler Setup.
You have finished scheduling the Read Me First document. The
Scheduler Setup window should look something like Figure D-7.

El S c h e d u l e r  Setup

(   Documents and Applications to Open: Preferences...
Script Debugger Install Read Me First `u-

-n-

Add... C h a n g e . . .  D e l e t e

Launch: W h e n  Volumes Are Mounted ,  i  I D :  4

Volume: S c r i p t  Debugger Install ,  1 E l  Enabled
nel Launch In
' ' '  Foreground

Figure D-7
The completed
Scheduler
window
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All scheduling changes made with Scheduler Setup take effect
immediately after the Scheduler Setup window is closed.

6. Dismount the Script Debugger Install disk by dragging it to the Trash.
7. Re-insert the Scheduler Install disk into your Macintosh.
When you insert the Script Debugger Install diskette, Scheduler opens
the Read Me First file.
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Scheduler Features

ID S c h e d u l e r  Setup

Documents and Applications to Open: P r e f e r e n c e s . . .
1 r

47.

Add... (  '

Launch: W h e n  Volumes Are Mounted •  I I D :  -

E  i: f: 300..1
n  L hilt; it :•:

Scheduler is a powerful and flexible tool for scheduling the opening of
documents and applications. This section describes all of the advanced
Scheduler features.

Adding, Setting and Deleting Scheduled Events
The Scheduler Setup control panel is your interface to Scheduler.
Scheduler Setup allows you to add, change and delete scheduled
documents and applications (Figure D-8).

Figure D-8
The Scheduler Setup
window

Add Click the Add button to add a new document or application
to the list of scheduled documents and applications.

When you click the Add button, a file selection dialog box
appears so that you can choose the application or document
to be launched.

Change C l i c k  the Change button to change the application or
document being scheduled.

The Change button is active only when a scheduled
document or application is selected.

Scheduler 2 1 3
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Delete C l i c k  the Delete button to remove a document or
application from the list of scheduled documents and
applications.

The Delete button is active only when a document or
application is selected.

Launch U s e  the Launch pop-up menu to choose the type of
scheduling for your document or application.

The Launch pop-up menu is active only when a document
or application is selected (Figure D-9).

Figure D-9
Scheduler Setup's
Launch menu

When Volumes A re  Mounted
When Volumes A re  Dismounted
When A Volume's Free Space Limit  Is Exceeded

When A Folder Changes
When Files Within A Folder Exceed A L imi t
When A Folder's Size Limit  Is Exceeded
When A File Changes

Periodically Throughout The Day
Once Daily
Once Weekly
Once Monthly
Once Yearly
Once

When Power Adapter Is Plugged In
When Power Adapter Is Unplugged
When Woken Up

Date and Time-Based Scheduling
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Volume-based
options

Folder and
file-based
options

Date and
time-based
options

Power Book
specific
options

Scheduler provides a series of options for launching applications
and documents at a specific time in the future. Using these options,
you can configure your Macintosh to perform repetitive operations
periodically throughout the day, week, month or year. You can also
schedule applications and documents to launch at a specific date and
time in the future.

The following sub-sections describe each of Scheduler's time-based
options in detail.
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Scheduling Events Periodically Throughout the Day
This scheduling option allows you to have your application or
document opened at regular intervals throughout the day.

Select this option by choosing "Periodically Throughout The Day"
from the Launch pop-up menu (Figure D-16).

I ]  S c h e d u l e r  Setup

Documents and A p p l i c a t i o n s  t o  Open:  P r e f e r e n c e s . . .

Script  Debugger Install :Read Me F i r s t -u-

Add... )  (  Change...  )  (  D e l e t e

Launch: P e r i o d i c a l l y  Throughout The Day ,  I  I D :  4

Every : 1 : / /  r i i  Z  Enabled

Between: c o  133 AM a n d  M I  M I  PM N o i  Launch In
' ' ' '  Foreground

On: Z  Sundays Z  Mondays Z  Tuesdays

E I  Wednesdays Z  Thursdays Z  Fridays

Z S a t u r d a y s

Next launch on Thursday , May 4 , 1 9 9 5  at 8 :00  AM

Figure D-10
The"Periodically
Throughout The Day"
settings

The "Periodically Throughout The Day" scheduling option provides
the following parameters:

Every: T h i s  parameter defines the interval, in hours and minutes,
between launches. To change this value, click on the hours
or minutes field with the mouse. Then use the up/down
arrow that appears, to adjust the value.

Every : MCC'

Scheduler 2 1 5
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Between: T h i s  parameter specifies the period of the day when
scheduling occurs.

El S c h e d u l e r  Setup
-

Preferences...Documents and A p p l i c a t i o n s  t o  Open:
Script Debugger Instal l  Read Me Fi rs t -u-

•fl-

Add... )  C h a n g e . . .  [  D e l e t e

Launch: O n c e  Daily ,  I  I D :  4

E l  Enabled

At:  i n  m i  Noon r o  Launch In
i l  Foreground

On: z  Sundays z  Mondays z  Tuesdays

[E] Wednesdays E l  Thursdays [ E ]  Fridays

z  Saturdays

Next launch on Thursday, May 4 , 1 9 9 5  at 12 :00  PM

As with the Every parameter, to change either the start or
ending time, click on the hours or minutes field with the
mouse. Then use the up/down arrow that appears to adjust
the value.

On:

Between : g :  00 AM 0  a n d

Starting time

05:00 PM

Ending time

This parameter specifies the days of the week when you
want scheduling to occur. To prevent scheduling on a
particular day, simply uncheck that day's checkbox.

Scheduling Daily Events
This scheduling option causes your documents and applications to
open once daily.

Select this option by choosing "Once Daily" from the Launch pop-up
menu (Figure D-11).

Figure D-11
The "Once Daily"
settings
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The "Once Daily" scheduling option provides the following
parameters:

IJ S Scheduler Setup

[   Documents and Applications to Open: Preferences...

Script Debugger Instal l  Read Me Fi rs t i r

4-1-

Add... [  Change...  D e l e t e

Launch: O n c e  Weekly •  I  I D :  4

On: W e d n e s d a y  v  I  E l  Enabled

At : B g  ®  Noon r i p . 1  Launch In
i=2"" Foreground

Next launch on Wednesday, May 1 0 , 1 9 9 5  at 12 :00  PM

At: This parameter defines the time of the day, in hours
and minutes, when the document or application is to be
opened.

To change this value, click on the hours or minutes field
with the mouse. Then use the up/down arrow that appears,
to adjust the value.

At : I N N  Noon 0

On: T h i s  parameter specifies the days of the week when you
want your application or document to open.

Scheduling Weekly Events
This scheduling option allows you to have your application or
document opened once each week.

Select this option by choosing "Once Weekly" from the Launch pop-up
menu (Figure D-12).

Figure D-12
The "Once Weekly"
settings

Scheduler 2 1 7
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The "Once Weekly" scheduling option provides the following
parameters:

 S

[   Documents and Applications to Open: Preferences...

Script Debugger Instal l  Read Me Fi rs t 11-

n .

Add... [  Change...  [  D e l e t e

Launch: O n c e  Monthly •  I  I D :  4

On the: 3 1  s t  v  ` o f  the month C E I  Enabled

At : B g  ®  Noon r i p . 1  Launch In
i=2"" Foreground

[E] Execute on the last day o f  short months

Next launch on Wednesday , May 3 1 ,  1995 at 12 :00  PM

On: T h i s  parameter specifies the day of the week when you
want your application or document to open.

At This parameter defines the time of the day, in hours
and minutes, when the document or application is to be
opened.

To change this value, click on the hours or minutes field
with the mouse. Then use the up/down arrow that appears,
to adjust the value.

At: N  Noon 0

Scheduling Monthly Events
This scheduling option allows you to have your application or
document opened once each month.

Select this option by choosing "Once Monthly" from the Launch
pop-up menu (Figure D-13).

Figure D-13
The "Once Monthly"
settings
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The "Once Monthly" scheduling option provides the following
parameters:

On the: T h i s  parameter specifies the day of the month when you
want your application or document to open.

At: This parameter defines the time of the day, in hours
and minutes, when the document or application is to be
opened.

To change this value, click on the hours or minutes field
with the mouse. Then use the up/down arrow that appears,
to adjust the value.

At : m i : N  Noon 0

Execute on the last day of short months:
This parameter describes what happens in months
with fewer days than the day you selected in the On The
parameter. When this parameter is checked, your document
or application is operated in the last day of the month.
When not checked, your document or application is not
opened in short months.

Scheduler 2 1 9
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Scheduling Yearly Events
This scheduling option allows you to have your application or
document opened once each year.

Select this option by choosing "Once Yearly" from the Launch pop-up
menu (Figure D-14).

I:1 S c h e d u l e r  Setup

Documents and A p p l i c a t i o n s  t o  Open:  P r e f e r e n c e s . . .

Script Debugger Install Read Me Fi rs t -u-

..n.

Add... ]  C h a n g e . . .  )  [  D e l e t e

Launch: O n c e  Yearly . .  I  I D :  4

On: J a n u a r y  V  11 3 1  s t  V  I  [ E ]  Enabled

At : m i  133 Noon E l  Launch In
' ' ' '  Foreground

Next launch on Wednesday, January 3 1 ,  1996 at 12130 PM

Figure D-14
The "Once Yearly"
settings

220 A p p e n d i x  D

The "Once Yearly" scheduling option provides the following
parameters:

On: T h i s  parameter lets you specify the month and day of the
year when your application or document is to be opened.

At This parameter defines the time of the day, in hours
and minutes, when the document or application is to be
opened.

To change this value, click on the hours or minutes field
with the mouse. Then use the up/down arrow that appears,
to adjust the value.

At : p i  • N  Noon 0
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Scheduling Events That Occur at a Specific Date and Time
This scheduling option allows you to have your application or
document opened on a specific day and time in the future.

Select this option by choosing "Once" from the Launch pop-up menu
(Figure D-15).

Fl S c h e d u l e r  Setup

(   Documents and Applications to Open: Preferences...

Script  Debugger Install :Read Me F i r s t -rr

.n.

Add... ,  Change...  D e l e t e

Launch: O n c e  ,  I  I D :  5

On: J a n u a r y  , ,  I  1  s t  ' . "  1 i i m  E  Enabled

At:  E s  0 3  Noon . r o .  Launch In
"L" Foreground

Next launch on Monday , January 1 ,  1996 at 12 :00  PM

Figure D-15
The "Once" settings

The "Once" scheduling option provides the following parameters:

On: T h i s  parameter lets you specify the month, day and year
when your application or document is to be opened.

At: This parameter defines the time of the day, in hours
and minutes, when the document or application is to be
opened.

To change this value, click on the hours or minutes field
with the mouse. Then use the up/down arrow that appears,
to adjust the value.

Scheduler 2 2 1
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File and Folder-Based Scheduling

El S c h e d u l e r  Setup

(   Documents and Applications to Open: Preferences...

Script Debugger Instal l  Read Me Fi rs t `u-

-n-

Add...  C h a n g e . . .  D e l e t e

Launch: W h e n  A Folder Changes ,  i  I D :  4

Folder: (  S e t  Folder... )  E l  Enabled1.c.--1

 M a c O S  : Sy stem Folder: Control Panels n e l  Launch In
"  Foreground

Scheduler provides a series of options for launching applications and
documents whenever a file or folder is changed. You can use these
options to configure your Macintosh to perform repetitive tasks when
files are placed in a folder or whenever a file is edited.

The following sub-sections describe each of Scheduler's file and folder
options in detail.

Scheduling Events When Folders Are Changed
This scheduling option allows you to have your application or
document opened whenever files are added to or removed from a
folder. Scheduler recognizes changed folders by periodically checking
their modification dates.

Select this option by choosing "When A Folder Changes" from the
Launch pop-up menu (Figure D-16).

Figure D-16
The "When A Folder
Changes" settings
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The "When A Folder Changes" scheduling option provides the
following parameter:

Folder: T h e  folder parameter allows you to select the folder which
triggers your application or document. Click the Set Folder
button to set or change the folder.
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Scheduling Events When the Number of Files In a Folder Reaches a Limit
This scheduling option allows you to have your application or
document opened whenever the number of files stored in a folder
rises above or falls below a limit.

El S c h e d u l e r  Setup
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Select this option by choosing "When Files Within A Folder Exceed A
Limit" from the Launch pop-up menu (Figure D-17).

Figure D-17
The "When Files Within A
Folder Exceed A Limit"
setting

The "When Files Within A Folder Exceed A Limit" scheduling option
provides the following parameter:

Folder: T h e  folder parameter allows you to select the folder which
triggers your application or document. Click the Set Folder
button to set or change the folder.

File Count:
This parameter allows you to define a limit for the number
of files stored in the folder. The pop-up menu lets you
choose the type of limit on free space, either Greater Than
or Less Than.

Once you have selected the type of limit, you can enter the
number of files into the text box. Use the Include Enclosed
Folders checkbox to indicate whether or not you want
Scheduler to include the files stored within enclosed folders
when it calculates the number of files stored in the folder.

Scheduler 2 2 3
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CAUTION: Use the Include Enclosed Folders feature with care. When this
feature is checked, Scheduler must scan through all the enclosed folders to
calculate the number of files. If you have a deep folder structure, Scheduler
requires extra time to calculate the number of files. The extra time taken
by Scheduler to perform this function may slow down other activities on
your Macintosh.

Scheduling Events When the Size of a Folder Reaches a Limit
This scheduling option allows you to have your application or
document opened whenever the size of a folder rises above or falls
below a limit.
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Select this option by choosing "When A Folder's Size Limit Is
Exceeded" from the Launch pop-up menu (Figure D-18).

Figure D-18
The "When A Folder's
Size Limit Is Exceeded"
settings
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The "When A Folder's Size Limit Is Exceeded" scheduling option
provides the following parameter:

Folder: T h e  folder parameter allows you to select the folder which
triggers your application or document. Click the Set Folder
button to set or change the folder.
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Folder Size:
This parameter allows you to define a limit for the size of
the folder. The pop-up menu lets you choose the type of
limit on free space, either Greater Than or Less Than.

l i  S c h e d u l e r  Setup

Documents and A p p l i c a t i o n s  t o  Open:  P r e f e r e n c e s . . .

Script  Debugger Install :Read Me F i r s t -LI'

,-11-,

Add... ]  C h a n g e . . .  D e l e t e

Launch: W h e n  A File Changes . . .  I  I D :  4

File: ( S e t  File... )  [ E ]  Enabledf:77..

11 0 2 Script Debugger Instal l :  Read Me F i rs t  N o l .  Launch In
' ' '  Foreground

Once you have selected the type of limit, you can enter the
size limit into the text box.

Use the Include Enclosed Folders checkbox to indicate
whether or not you want Scheduler to include the files
stored in enclosed folders when it calculates the size of the
folder.

CAUTION: Use the Include Enclosed Folders feature with care. When this feature
is checked, Scheduler must check every file in all the enclosed folders to
calculate the total size of the folder. I f  you have a deep folder structure
containing many files, Scheduler requires extra time to calculate the total
folder size. The extra time taken by Scheduler to perform this function
may slow down other activities on your Macintosh.

Scheduling Events When Files Are Changed
This scheduling option allows you to have your application or
document opened whenever a particular file is changed. Scheduler
recognizes changed files by periodically checking their modification
dates.

Select this option by choosing "When A File Changes" from the Launch
pop-up menu (Figure D-19).

Figure D-19
The "When A File
Changes" settings
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The "When A Folder Changes" scheduling option provides the
following parameter:

El S c h e d u l e r  Setup

(   Documents and Applications to Open: Preferences...

Script  Debugger Install :Read Me F i r s t v "

Add... ,  Change...  D e l e t e

Launch: W h e n  Volumes A re  Mounted ,  I  I D :  4

Volume: A n y  Volume ,  I  E  Enabled

pgi, Launch In
"L" Foreground

File: T h e  file parameter allows you to select the file which
triggers your application or document. Click the Set File
button to set or change the file.

Volume-Based Scheduling
Scheduler provides a series of options for launching applications and
documents whenever volumes are mounted and dismounted, or when
the free space available on a particular volume reaches a limit.

The following sub-sections describe each of Scheduler's volume-based
options in detail.

Scheduling Events When Volumes Are Mounted or Dismounted
This scheduling option allows you to have your application or
document opened whenever a volume is mounted or dismounted.

Select this option by choosing "When Volumes Are Mounted" or
"When Volumes Are Dismounted" from the Launch pop-up menu
(Figure D-20).

Figure D-20
The "When Volumes
Are Mounted"
settings
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The "When Volumes Are Mounted" and "When Volumes Are
Dismounted" scheduling options provide the following parameter:

Volume: T h i s  parameter lets you specify the name of the volume
which triggers the opening of your document or application
(Figure D-21).

Figure D-21
The Volume
pop-up menu

•  Any Volume

other
Der
Graphics
Hard Disk 234
Mail Enclosures
MacOS
Script Debugger Install

The Volume pop-up menu lists all mounted volumes
and contains an option titled Any Volume. Selecting Any
Volume causes your document or application to be
launched whenever any volume is mounted or dismounted,
depending on the option you have chosen in the Launch
pop-up menu.
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Scheduling Events When Free Space on a Volume Reaches a Limit
This scheduling option allows you to have your application or
document opened whenever the free space available on a volume
reaches a limit. You can use this option to launch applications or
documents when the space available on a volume drops below a certain
value or when the space available rises above a limit.

Select this option by choosing "When A Volume's Free Space Limit Is
Exceeded" from the Launch pop-up menu (Figure D-22).

El S c h e d u l e r  Setup

[   Documents and Applications to Open: Preferences...

Script Debugger Install Read Me Fi rs t i r

.1,..

[ A d d . . .  ,  Change...  )  [  D e l e t e

Launch: W h e n  A Volume's Free Space Limit  Is Exceed ...V I  I D :  4

Volume: A n y  Volume , "  1 0  Enabled

Free Space: L e s s  Than ' , '  1 1 0 0 0  K  Bytes r i q  Launch In
i " Foreground

Figure D-22
The "When A Volume's
Free Space Limit Is
Exceeded" settings
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The "When A Volume's Free Space Limit Is Exceeded" scheduling
option provides the following parameter:

Volume: T h i s  parameter lets you specify the name of the volume
which triggers the opening of your document or application
(Figure D-21).

The Volume pop-up menu lists all mounted volumes
and contains an option titled Any Volume. If you select
Any Volume, your document or application is launched
whenever any volume is mounted or dismounted,
depending on the option you have chosen in the Launch
pop-up menu.



Õ"#ªº´¥ªÆ ÓÓÁ

⁄Æªª Õ+ø"ªÊ

Ã$%& (øÆø+ª¨ªÆ ø¥¥±©& ß±´ ¨± ºª4%5ª ¨$ª 4Æªª &(ø6ª ¥%+%¨ 4±Æ

¨$ª ™±¥´+ªÚ Ã$ª (±(Û´( +ª5´ ¥ª¨& ß±´ 6$±±&ª ¨$ª ¨ß(ª ±4

¥%+%¨ ±5 4Æªª &(ø6ªÙ ª%¨$ªÆ ŸÆªø¨ªÆ Ã$ø5 ±Æ ‘ª&& Ã$ø5Ú

—56ª ß±´ $ø™ª &ª¥ª6¨ªº ¨$ª ¨ß(ª ±4 ¥%+%¨Ù ß±´ 6ø5 ª5¨ªÆ ¨$ª

ø+±´5¨ ±4 4Æªª &(ø6ª %5¨± ¨$ª ¨ª®¨ æ±®Ú

Õ"#ªº´¥()* ⁄ªø¨´Æª0 1±Æ –±©ªÆfi±±µ À0ªÆ0
Õ6$ªº´¥ªÆ (Æ±™%ºª& ø &ªÆ%ª& ±4 &6$ªº´¥%5A ±(¨%±5& ºª&%A5ªº &(ª6%4%6ø¥¥ß

4±Æ –±©ªÆfi±±µ ´&ªÆ&Ú Ã$ª&ª &6$ªº´¥%5A ±(¨%±5& ø¥¥±© –±©ªÆfi±±µ ´&ªÆ&

¨± (ªÆ4±Æ+ ±(ªÆø¨%±5& %5 Æª&(±5&ª ¨± ª™ª5¨& ©$%6$ 6ø5 ±5¥ß ±66´Æ ±5

æø¨¨ªÆßÛ(±©ªÆªº ”ø6%5¨±&$ª&Ú

“—Ã¤Ê Ã#ª/ª /"#ªº´¥012 ±+¨0±1/ øÆª ±1¥ß ø™ø0¥øæ¥ª ±1 –±©ªÆfi±±µ

"±<+´¨ªÆ/Ú Õ"#ªº´¥ªÆ Õª¨´+ º±ª/ 1±¨ ø¥¥±© ø""ª// ¨± ¨#ª/ª ±+¨0±1/ ±1

ºª/µ¨±+ "±<+´¨ªÆ /ß/¨ª</Ú

Õ"#ªº´¥()* ¤™ª)¨0 …#ª) ¨#ª –±©ªÆ flºø<¨ªÆ (0 –¥´**ªº () ±Æ À)<¥´**ªº
Ã$%& &6$ªº´¥%5A ±(¨%±5 6ø´&ª& ß±´Æ º±6´+ª5¨ ±Æ ø((¥%6ø¨%±5 ¨± æª

±(ª5ªº ±Æ ¥ø´56$ªº ©$ª5 ß±´ (¥´A ¨$ª (±©ªÆ øºø(¨ªÆ %5¨± ¨$ª

–±©ªÆfi±±µ ±Æ ©$ª5 ß±´ ´5(¥´A ¨$ª (±©ªÆ øºø(¨ªÆ ¯⁄02´Æª ‹ÛÓÌ˜Ú

⁄"#´Æª ‹ÛÓÌ

Ã&ª N…&ª+ –±©ªÆ
flºø3¨ªÆ 56 –¥´99ªº
5+M 6ª¨¨;+9

Õ"Æ$%¨ ‹ªæ´,,ªÆ -./¨ø¥¥ Œªøº ”ª ⁄$Æ/¨

Free Space:

J S c h e d u l e r  Setup

( D o c u m e n t s  and Applications to Open: Preferences... ,
Script Debugger Install Read Me First -u-

-1-1-

( A d d . . .    Change... )  .  De le te

Launch: W h e n  Power Adapter Is Plugged In , I  I D :  104

E l  Enabled
rpi Launch In
I l l  Foreground

This parameter allows you to define the free space limit for
the volume. The pop-up menu lets you choose the type of
limit on free space, either Greater Than or Less Than.

Once you have selected the type of limit, you can enter the
amount of free space into the text box.

Scheduling Features for PowerBook Users
Scheduler provides a series of scheduling options designed specifically
for PowerBook users. These scheduling options allow PowerBook users
to perform operations in response to events which can only occur on
battery-powered Macintoshes.

NOTE: These scheduling options are only available on PowerBook
computers. Scheduler Setup does not allow access to these options on
desktop computer systems.

Scheduling Events When the Power Adapter is Plugged in or Unplugged
This scheduling option causes your document or application to be
opened or launched when you plug the power adapter into the
PowerBook or when you unplug the power adapter (Figure D-23).

Figure D-23
The "When Power
Adapter Is Plugged
In" setting
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a p p l i c a t i o n s  w h i c h  u s e  t h e  s e r i a l  p o r t s  o r  m o d e m s .

Scheduling Events When the PowerBook Wakes Up
T h i s  s c h e d u l i n g  o p t i o n  c a u s e s  y o u r  d o c u m e n t  o r  a p p l i c a t i o n  t o  b e

o p e n e d  o r  l a u n c h e d  w h e n  y o u  w a k e  u p  y o u r  P o w e r B o o k  ( F i g u r e  D - 2 4 ) .

El S c h e d u l e r  Setup

Documents and A p p l i c a t i o n s  t o  Open:  P r e f e r e n c e s . . .
Script Debugger Install Read Me First =Li-

,rl,

Add... )  (  Change...  )  (  D e l e t e

Launch: W h e n  Woken Up ,  I  I D :  1 0 4

LE Enabled

r o  Launch In
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Figure D-24
The "When Woken Up"
settings
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Launching Applications in the Background

I:1 S c h e d u l e r  Setup

(   Documents and Applications to Open: Preferences...

Script  Debugger Install:Read Me F i r s t -1_,-

7 -

Add... )  (  Change...  (  D e l e t e

Launch: P e r i o d i c a l l y  Throughout The Day v  I  I D :  5

Every : 1 3 /  C O  E l  Enabled

Between: E n  n o  AM a n d  ® :  ® P M  r i o  Launch In —
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E l  Wednesdays E  Thursdays C Z  Fridays

E l  Saturdays

Next launch on Thursday, May 4 , 1 9 9 5  at 9 :00  AM

Figure D-25
The Launch in
Foreground checkbox

Scheduler allows you to select how your applications are launched and
how your documents are opened. Scheduler can open applications and
documents in the background or in the foreground.

When documents or applications are launched in the foreground, they
interrupt any work you might already be doing on your computer.
When documents and applications are opened in the background, your
work is not affected, except possibly for a brief slowdown of your
computer.

By default, Scheduler launches applications and opens documents in
the foreground. If you want to have your document or application
opened in the background, uncheck the Launch in Foreground
checkbox (Figure D-25).

Click here to have your
document or application
launched in the background
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Disabling Scheduled Events

ID S c h e d u l e r  Setup

(   Documents and Applications to Open: Preferences...

Script Debugger Install Read Me Fi rs t -u-

7 ,

Add... )  (  Change...  )  (  D e l e t e

Launch: P e r i o d i c a l l y  Throughout The Day . . . ,  I  I D :  5

Every : E n  ®  Z  Enabled —

Between : c o  c o  AM a n d  p a  c o  PM . m .  Launch In
i l  Foreground

On: Z  Sundays Z  Mondays Z  Tuesdays

z  Wednesdays z  Thursdays Z  Fridays

z  Saturdays

Next launch on Thursday,  May 4 , 1 9 9 5  at 9 :00  AM

Figure D-26
The Enabled checkbox

There may be times when you want to temporarily prevent one of your
applications or documents from being opened. You can do this easily
using the Enabled checkbox in the Scheduler Setup window. Normally,
this checkbox is checked, indicating that the document or application
will be opened. When it is unchecked, Scheduler ignores the document
or application (Figure D-26).
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disable this document
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Modifying Scheduler Preferences
Scheduler provides a series of preferences settings which allow you to
configure the way Scheduler operates.

To modify the Scheduler preferences, dick the Preferences button in
the Scheduler Setup window (Figure D-27).

Figure D-27
The Scheduler Setup
Preferences dialog

Preferences...

Startup Fictions: ❑  Check Mounted Volumes
Z  Check For Modified Files find Folders
[E] Check Date find Time

Logging: Z  Keep a Log File

Cancel OK

Check Mounted Volumes
This checkbox allows you to control how Scheduler
responds to mounted volumes during system start-up.

When checked, this setting causes Scheduler to check
mounted volumes. When not checked, Scheduler only
begins to watch for mounted volumes after system start-up.

Check For Modified Files And Folders
This checkbox allows you to control how Scheduler responds
to files and folders on file servers which have changed when
your Macintosh is not running. When checked, this setting
causes Scheduler to check for modified files and folders
which may have changed. When not checked, Scheduler
ignores changed files and folders and begins to watch for file
and folder changes following system start-up.

Check Date And Time
This checkbox allows you to control how Scheduler
responds when a scheduled application or document could
not be launched because your Macintosh was not operating.

When checked, this setting causes Scheduler to launch
documents (at start-up time) which would have been
launched if your Macintosh had been operating.

Scheduler 2 3 3
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Keep a Log File
This checkbox allows you to start or stop Scheduler logging.

When checked, this setting causes Scheduler to keep a
record of all events in the Scheduler Log file located in the
Preferences folder within your System Folder. When not
checked, no logging is performed.
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Script Debugger and Projector

Projector is an integrated collection of MPW tools and scripts
for managing source files. Projector regulates users' access to
files since they must check files in and out of the Projector
database. It also maintains revisions and comments to the
source files. If you have a large number of scripts and you use
Projector to manage them, Script Debugger can be used in
conjunction with it. Script Debugger indicates the Projector
state of the script with one of three icons in the script's header.
A script can be either checked out for modification, checked
out as read-only, or checked out as modifiable read-only.
NOTE: In this discussion, we do not explain how to check files in and out of
Projector. For that information, you should refer to the documentation
that came with your copy of Symantec C++, CodeWarrior, or MPW.
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.±Æ 7±º).)4ø¨)±'Ù ¨=ª 34Æ)%¨ =ªøºªÆ 4±'¨ø)'3 ø' øºº)¨)±'ø¥ )4±'Â )¨ )3 ø

%ª'4)¥ ºÆø©)'9 ø ¥)'ª ¯⁄#$´Æª ¤ÛÔ˜Ú

⁄"#´Æª ¤ÛÔ

Ã"ª –ª&'(¥ ('±&
(&º('ø¨ª. ¨"ª /(¥ª (.
0±º(/(øæ¥ª

fl.¨ªÆ ß±´ =ø™ª 7øºª 7±º).)4ø¨)±'3 ¨± ¨=ª 34Æ)%¨Ù ß±´ ©)¥¥ 4=ª4µ )¨ æø4µ

)'¨± –Æ±<ª4¨±ÆK3 ºø¨øæø3ªÚ

⁄"¥ª% ›(ª)µªº ø% ŒªøºÛ—3¥ß
-. ß±´Æ 34Æ)%¨ .)¥ª )3 7ø'ø9ªº æß –Æ±<ª4¨±Æ ø'º ß±´ =ø™ª 4=ª4µªº )¨

±´¨ ø3 ÆªøºÛ±'¥ßÙ ¨=ª –ª'4)¥ )4±' )' ¨=ª =ªøºªÆ =ø3 ø' » ¨=Æ±´9= )¨

¯⁄#$´Æª ¤ÛÓ˜Ú

⁄"#´Æª ¤ÛÓ

fl 'Æ±..ªº –ª&'(¥ ('±&
(&º('ø¨ª. ¨"ª /(¥ª (.
ÆªøºÛ±&¥ß

-' ¨=)3 4ø3ªÙ Õ4Æ)%¨ ‹ªæ´99ªÆ ¨Æªø¨3 ¨=ª .)¥ª ø3 ¨=±´9= )¨ ©ªÆª ¥±4µªºÚ

«±´ 4ø''±¨ 7øµª 4=ø'9ª3 ¨± ¨=ª 4±'¨ª'¨3 ±. ¨=ª .)¥ªÚ ⁄±Æ )'3¨ø'4ªÙ ¨=ª

Õø™ª 7ª'´ )3 º)3øæ¥ªº ¨± %Æª™ª'¨ ß±´ .Æ±7 ø44)ºª'¨ø¥¥ß 7øµ)'9 ø'ß

4=ø'9ª3 ¨± ¨=ª .)¥ªÚ

Files Checked out for Modification
If your script file is managed by Projector and you have checked it out
for modification, the script header contains an additional icon; it is a
pencil drawing a line (Figure E-1).

Figure E-1
The Pencil icon
indicates the file is
modifiable

Modifiable0

After you have made modifications to the script, you will check it back
into Projector's database.

Files Checked as Read-Only

Figure E-2
A crossed Pencil icon
indicates the file is
read-only
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If your script file is managed by Projector and you have checked it
out as read-only, the Pencil icon in the header has an X through it
(Figure E-2).

Read/Only  0 '

a  ID

In this case, Script Debugger treats the file as though it were locked.
You cannot make changes to the contents of the file. For instance, the
Save menu is disabled to prevent you from accidentally making any
changes to the file.
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If you decide to make changes to the file, you can change its state to
Modifiable Read-Only. A  button and menu item are provided for
these circumstances. You can click on the Pencil button in the script
header or select Modify read-only from the File menu (Figure E-3)
to make the Read-Only file modifiable.

Figure E-3
The Modify Read-Only
menu item

Figure E-4
Confirming a change to
modifiable read-only

Save m  s
Save Rs...
Save Rs Run-Only.. .
Revert to Saved

Modify Read-Only

Page Setup...
Print...
Print Diagram...

Clicking on the button or selecting the Modify Read-Only command
displays a dialog box to confirm that you want to change the state of
the file (Figure E-4).

"Debugging Tutorial -  Read/Only" is
checked out Read-Only. Do  you want  to
make the script modifiable?

OK

Modifiable read-only files are a feature of Projector which allow you to
make changes to otherwise read-only files without checking them out
of the Projector database. You do have to check the changes back into
Projector at a later time.
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Files Checked Out as Modifiable Read-Only
If the script file has been checked out as Modifiable Read-Only,
the Pencil icon in the script header has a dimmed X through it
(Figure E-5).

Figure E-5
A Pencil icon with a
dimmed cross indicates
it is Modifiable
Read-Only

In this case, you can make changes to the file, and then check them into
Projector's database when you are through.
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More Information about AppleScript

Some of the best information about AppleScript can be found
in AppleScript manuals, however, not everyone has them or
knows how they can be obtained. This section of the manual
provides pointers to Apple's manuals, other books about
AppleScript, and other sources of information.
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Apple's Scripting Guides
If you purchase the AppleScript Scripter's Kit (M173OLL/B, $139.00,
available from APDA or Apple) or the Developer's Kit (R0175Z/C,
$199.00, available from APDA), you receive several AppleScript books:
Getting Started, Scripting Language Guide, Scripting Additions, and
Building Interfaces. Some of these books are also available directly from
Addison-Wesley (the Getting Started and Building Interfaces manuals
can only be purchased with the two kits). These manuals can be
purchased separately:

AppleScript Language Guide, Addison-Wesley, 1993
(ISBN 0-201-40735-3). $29.95

AppleScript Additions Guide, Addison-Wesley, 1993
(ISBN 0-201-40736-1). $18.95

Apple also has a book which documents the standard suites of Apple
events. You can purchase a printed copy of the Apple Event Registry
from APDA, and you can find electronic versions on the Developer's
Kit CD and the develop 20 Bookmark CD.

Apple Event Registry: Standard Suites, Apple Computer, 1992. APDA,
R013OLL/A, $85.00

Apple's Finder Scripting Kit
Since AppleScript was first released, Apple has released the Scriptable
Finder. First made available in the Finder Scripting Kit (R0573Z/A,
$25.00, available from APDA), it includes the Finder software and a
manual. The Scriptable Finder was incorporated into System 7.5,
but the manual was not shipped with the System Software. It is
available separately: AppleScript Finder Guide, Addison-Wesley,
1994, (ISBN 0-201-40910-0). $19.95
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Third-Party Books
In addition to Apple's AppleScript Guides, there are currently four
third-party books:

Goodman, Danny. The Complete AppleScript Handbook. 2nd ed.
Random House, 1995 (ISBN 0-679-75806-2). $35.00

Michel, Steve. Scripting the Scriptable Finder. Heizer Software,
1995. $49.00

Schneider, Derrick. The Tao of AppleScript. 2nd ed., 1994
(ISBN 1-56830-115-4). $24.95

Trinko, Tom. Applied Mac Scripting. MIS:Press, 1995
(ISBN 1-55828-330-7). $34.95

Articles About AppleScript
The following is a list of articles about AppleScript published in the
quarterly Apple Technical Journal, develop . Each issue comes with a
bookmark CD which contains all of the develop magazines in electronic
form along with other documentation, system software components,
and utilities. Yearly subscriptions can be obtained for $30.00 from
Apple Computer by calling 800/877-5548 (or 815/734-1116 outside
the U.S.) or by sending e-mail to dev.subs@applelink.apple.com.

Anderson, Greg. "Scripting the Finder from Your Application,"
develop 20, December 1994, pp. 65-78.

Berdahl, Eric M. "Better Apple Event Coding Through Objects,"
develop 12, December 1992, pp. 58-83.

Clark, Richard. "Apple Event Objects and You," develop 10, May 1992,
pp. 8-32.

Smith, Paul G. "Programming for Flexibility: The Open Scripting
Architecture," develop 18, June 1994, pp. 26-40.

Smith, Paul G. "Implementing Inheritance in Scripts," develop 19,
September 1994, pp. 89-99.
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MacScripting Mailing List
If you have an electronic mail account, you may be interested in
the MacScripting mailing list. A mailing list is a group of people
interested in a particular topic whose e-mail addresses are kept in a
list maintained by a mailing list manager running on a workstation or
mainframe. The mailing list allows subscribers to ask questions and
exchange information.

NOTE: I f  your e-mail account is on a commercial service, you should be
warned that some services charge for messages that pass through a gate-
way to the Internet. Be sure to check with your service provider to see if
you are charged for individual mail messages to the Internet.

The MacScripting mailing list is devoted to the discussion of
AppleScript, Frontier, and other OSA scripting languages. You
can subscribe to the mailing list by addressing a message to
listserv@dartmouth.edu. The message should contain the line

sub m a c s c r p t  your  name

Replace the your name with your real name. You will be added to the
mailing list and sent information about changing your mail options
and unsubscribing.

Another informal source of information is the Frequently Asked
Questions file generated by the mailing list. The FAQ contains the most
commonly asked questions on the mailing list, and it exists to reduce
the amount of mail traffic. You can obtain a copy of the MacScripting
FAQ via anonymous ftp from gaea.kgs.ukans.edu if you have ftp access
to the Internet. You may also find it in the AppleScript sections and
forums on some of the commercial services.
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Get Network State 122
Get Process 154
Get Zone 118
getlIndexedResource 180
getlIndexedResourceType 182
getlResource 184
getIndexedResource 186
getIndexedResourceType 188
getIndexedStringResource 190
getResource 192
getStringResource 194
getUniquelResourcelD 199
getUniqueResourcelD 200
Intersection of 149
Lengthen File 137
List Network Names 120
List Processes 153
List Screens 202
List Zones 119
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moveFile 138
openFile 139
openResourceFile 196
positionFile 140
power 152
readLine 141
removeResource 197
renameFile 142
Set Default Folder 129
Shutdown 203
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Substitute Regular Expression
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tanh 152
Union of 150
upgrading from Script Tools 1.3.x
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writeLine 143
writeString 144

Scripting Pointers 107
Set Default Folder 129
Setting breakpoints 51
Shift-Command-G 30
Shift-Command-T 31

Shift-Option-Up arrow 22
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Show Startup

indicator 10
Save As option 37

Shutdown 203
signature 154
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SourceServer. See Projector
Speak 204
Speech Manager 204
Splash Screen indicator 10
Startup Action 70
Stationary pads 33
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templates 75
window location 34

stationeryAware 155
Status button 8
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Save As option 37

step 80
stop 80
Substitute Regular Expression 161
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Template Scripts

File Droplet 74
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menu 75
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Temporary breakpoints 52
Text scripts 33, 36
Text suite 102
Troubleshooting 83
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Undo command 23
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useTextEditServices 155

246 S c r i p t  Debugger User's Guide

V

Variables, examining 56

W

Window positions 34
writeLine 143
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